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1
Introduction

C H A P T E R

This chapter will get you started using Access Anaesthetics especially if you don't
have time to read the entire manual. It explains the main screens and how to get
context sensitive help. The Practice Management Guide provides useful instructions
for new graduates on day-to-day issues in setting up your practice.

1.1 What is Access Anaesthetics?

Access Anaesthetics is a practice management package for Australian anaesthetists.
It is designed with an emphasis on comprehensive features and ease of use. It is
written in the popular Microsoft Access relational database system and communicates
with other Office applications such as Word and Excel.

What does it do?

· Creates accounts to send to private patients, health funds or third parties
· Incorporates fee schedules for Medicare, ASA RVG and most health funds
· Manages Veterans' Affairs time-based methods of billing
· Records payment of accounts by cheque, credit card or EFT
· Prints receipts which include all item information for obtaining rebates
· Tracks overdue accounts and prints increasing levels of payment

encouragement messages
· Sends standard or custom letters
· Provides clinical activity statistics
· Provides financial analysis statistics
· Keeps records of anaesthetic procedures performed

Features

· Billing for MBS, RVG and free text formats
· Manages DVA, Workers Compensation and Third Party accounts
· Incorporates fee schedules for all the major health funds
· Allows the creation of a patient co-payment account for health fund no-gap

accounts
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· Handles GST fees and payments, and provides GST reporting functions
· Built-in letter writing functions with the ability to store unlimited form letters
· Incorporates easy discounting system
· Print lists of accounts or payments matching user-defined criteria
· Prints on any printer with standard A4 paper
· Prints bank deposit slips
· Intuitive Windows interface with lookup lists, buttons, handy data entry shortcuts

and many customisable options
· Easy browse and search functions in MBS and RVG books
· Handy To-Do list allows you to create messages for yourself
· Optionally saves 'read-only' copies (snapshots) of all accounts, receipts and

letters for reliable auditing
· Easy backup system to hard disk, floppy disk, zip disk or CD

· Supports multiple providers on one PC or a network of PCs

1.2 If you don't have time to read the manual...

Firstly, you probably don't have time to do your accounts either, so get your secretary
or spouse to manage the system for you.

Secondly, you can run the system without help, provided you understand why some
things happen in a particular way. If you get into trouble in a particular area, click the
Help button or press F1 for context sensitive help. We can't guarantee that your
accounts are going to be exactly as you expect, unless you have a good working
knowledge of what is in the help file or manual.

You should read the Getting started section  before doing anything else as this will
give you an overview of how the system works. Then read up on specific areas as you
need to. The Quick start instructions  will give you a 5 minute guide if you just want
to start creating accounts straight away.

If you're new to sending accounts for your anaesthetic services, you should also read
the Practice management guide . This will give you valuable information on the
everyday aspects of operating the business side of your anaesthetic practice.

You can customise the way that Access Anaesthetics works. Do this by modifying the
System Options . These affect how various events are handled, which details are
printed on your accounts, the management of lists of accounts and payments and so
on. You can start out with the default settings and experiment with them when you get
to know the system better. There are also a number of lookup tables which store lists
of items you will commonly use such as surgeon's names, hospitals you work from,
preferred messages on accounts and so on. Initially some of these will be empty and
you will need to add your own preferences. It's all described in the relevant sections in
the manual or on-line help.
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1.3 Quick start instructions

To get you started, this is a basic overview of how to create an account, print it, enter
payments, and print a bank deposit slip.

Enter your provider details

· From the Main Menu, click Edit system options.
· On the Provider details page, enter your name and billing address details.
· Click the Preview the account header button to see the layout.
· After you are happy with the format, click the Save and Close button.

Create an account

· From the Main Menu, click Create a new account.
· Starting with the Patient Addr page, enter the relevant information. Not all fields

are required.
· Move to the different pages from left to right, entering data as you go.
· Add items to the Items page. Select a health fund fee or My Own fee if you like.
· Check or adjust the fee on the Fee page. The account is now ready to send.

Print the account

· Press the Print now button on the lower toolbar to print the current account.
· The account date will be inserted and the status will be set to Awaiting payment.
· The Documents page will record when the account was printed. If the option is

installed, a snapshot of the account will be created.
· We recommend you always examine the printed account before sending it.
· The account will fit into a standard DL window face envelope for mailing.
· You can create multiple accounts then print them all at once from the List of

accounts screen.

When a payment arrives

· Click Find an existing account, and enter the account number or name.
· Click the Payments page and enter the details of the payment(s) in the lower

section, taking care to specify the Payment type correctly (as this will determine
whether the payment appears on the bank deposit slip).

· If the account is fully paid, the date will be entered in the Date account closed
field, effectively closing the account.

· If an amount is still owing, or if you wish to send a receipt, press the Print now
button to print a receipt or reminder.

To close an account

· On the Payments page, the existence of a Date account closed determines
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whether the account is closed or open. Enter a date here to close the account,
or remove the date to re-open the account.

· When a payment is entered which fully pays the fee, the current date will be
inserted automatically as the date closed.

· To write off an amount still owing, simply enter a date into the Date account
closed field. Or, more simply, select Part payment accepted from the Status
drop-down list.

Do the banking

When a standard payment is entered, the date received is recorded, but not the date
banked. Payments without a banking date will be printed on the next bank deposit slip.
When the bank deposit slip is printed (on a printer), the banking date will be stored
with each payment printed.

· Press the Print bank deposit slip button on the Main Menu or List of Payments
screen. Specify the banking date and press the Print or Preview button.

· Take the bank deposit slip (2 copies) to the bank with the payments. The bank
officer will stamp and return one copy and keep the other copy.

Note Some payments will not appear on the bank deposit slip (e-credit cards,
EFT, other).

1.4 Getting Started

.

1.4.1 Built-in help

There are 3 methods to view the on-line help in Access Anaesthetics:

· Choose Help from the Help
menu on any form

   

· Click the Help button on any form.
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In most cases, the Help is context sensitive, that is, it opens at the
topic which is relevant to the task you are currently performing.

· Press the F1 key when viewing a form.  Help is available by pressing the F1 key
even if the form does not have a specific help button or help menu.

Move or resize the Help window to best suit your needs by dragging the title bar to a
new location, or dragging the borders in or out when the mouse turns to a double
edged arrow. You can also click the maximise, restore or minimise buttons in the top
right corner of the Help screen.

The Help with PDAs file gives comprehensive assistance with configuring and using
the Palm or Pocket PC add ons to Access Anaesthetics, and the What's New file
explains what has changed in the program from one version to another. This file will
usually have the latest information.

Click the Technical support button to view information about the resources available.

1.4.2 Tips

 As well as the built-in help, Access Anaesthetics has a system of helpful Tips.
Open the Tips form by clicking the Tips button or menu option in the same way you
would open the Windows-style help. The Tips form is designed to give you hints, late
breaking news, new features, answers to curly questions etc.
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You can add your own tips
to remind you how to do
things by clicking the My
Own Tips tab on the Tips
form.

   

Each page of Access Anaesthetics has a separate form for your own personal tips
file, so use it to enter your own context-sensitive personal help. You can even use it to
leave notes for your secretary. As well as opening the relevant context-sensitive form
automatically, you can also select any of the tips forms from the drop down list on the
top of the form. This will allow you to jump to other tips topics or to go through the tips
systematically.

1.4.3 Videos

The installation CD contains a set
of training videos. These are
videos of the Access
Anaesthetics screen recorded
while particular activities are
being carried out and are
accompanied by a commentary.

Choose Videos from the Help
menu to display a list of the
videos available and a description
of what each demonstrates. The
installation CD must be inserted
in your computer to view the
videos.
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1.4.4 Tools

The Tools menu provides access to a
number of handy utilities, and some methods
to configure the more intricate functions of
Access Anaesthetics.

The To-Do List  is a handy utility where you
can enter a list of tasks you want to keep
track of. For example, you can note accounts
you need to review, surgeons you need to
contact, phone calls you need to make - even
a reminder of your spouse's birthday!

Calculator opens the Windows calculator.

   

Windows Explorer  opens this handy file management utility.

The Select Provider tool is only available with multi-provider systems. This, and the
other items will be discussed later.

1.4.5 The four main screens

There are 4 main screens in Access Anaesthetics dealing with patient data:

· The Main Menu . This provides a launching pad for all the functions of Access
Anaesthetics.

· The Account details  screen shows all the details of an anaesthetic service for
one patient on one occasion. This is where you add all details on the patient,
operation, surgical and anaesthetic items, set the fee, print the account, enter
payments, send a form letter and so on. Everything related to an occasion of
service.

· The List of accounts  screen show a list of accounts (patients) in a table
format. You can select which accounts to display according to various criteria.
This is where you look for overdue accounts, where you specify which accounts
to print if you want to print a batch of accounts at once, and where you get
practice activity reports.

· The Payments  screen shows a list of all the payments you have entered into
the system. From here you can print lists of payments matching certain criteria,
print bank deposit slips, and create various financial summary reports.

On the top right of the 4 main screens there are 4 buttons which will quickly jump to
the Account details, List of accounts, Payments and Main Menu screens. These will
maintain the link to a patient if required. For example, if you position the cursor in a
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particular row of the List of accounts and click the Account details button, the specified
patient in the list will be located in the details screen.

Tip From the Main Menu, click the Account details button to quickly go to the
last account in the database. This saves having to enter an account
number or name if you just want to quickly open the editing form.

1.4.6 What is an Account?

Each occasion of anaesthetic service is treated as one Account. Each account is
given a unique Account number to identify it. These start from 1001 and are
incremented by one for each account added. Where one patient has multiple
anaesthetic services, there is simply a new record for each occasion of service, and
each of these will have a unique account number. There are methods to simplify
locating all accounts for a given patient and these are described in the Copying from
another account  section.

Note There will be parts of the system which will not operate until you create at
least one account.

1.4.7 Enter provider details

Before you start adding accounts, enter your personal provider information into the
system by clicking the Edit System OPTIONS  button on the Main Menu. The
details you enter here will appear on all your printed documents. You will find more
information in the System Options  chapter.

1.5 Main Menu functions

The opening screen is referred to as
the Main Menu. Move the mouse
over the list of options to highlight
the one you want, then click to
activate it.

You can also jump to one of the
other 3 main forms by clicking the
buttons on the top right of the page.
These buttons appear on each of
the main forms and you can jump
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1.5.1 Select another provider

This will allow you to switch between different doctor's data files. It also allows you to
create, rename and delete data files. You can also access this feature by selecting
this option from the Tools menu on any of the main screens, or from the File
Management Menu .

Note This option is only available in multi-provider versions of Access
Anaesthetics.

1.5.2 Find an existing account

Click the Find an existing account button and enter an account number or a patient's
name. If there is only one matching patient in the data file, the Account details form
will open at the selected account.

You may enter a first name or surname or any part of either or both. If more than one
matching account is found, all will be shown in a dialog box and you can simply click
the one you want.

If you have a multiple provider version, enter a slash (/) after the name or account
number to search all the provider files at once.

More information on finding patients is given in the Finding accounts  section.

1.5.3 Create a new account

Click the Create a New Account  button to create a new account. You will be taken
to a blank Account details screen which has been assigned the next available account
number. If this is your first account, you will be prompted for the account number to
start with. The recommended starting number is 1001. Account numbers in the entire
database are limited to 32,000. One account equates to one occasion of anaesthetic
service. One patient can have several accounts, one for each occasion of service,
and each of these will have a unique account number.

1.5.4 Bank deposit slip

The Print a Bank Deposit Slip button allows you to print any newly entered and as yet
un-deposited payments in a format suitable for a bank deposit slip. Copies of deposit
slips printed on previous occasions can also be printed. Once a deposit slip is printed,
the date of printing is inserted into each payment as a record of the date banked. This
banking date can then be used for financial reporting.
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Specify the number of copies
required in the print dialog box
(default is 2).

If printed from the preview screen,
press the printer icon button on
the toolbar once for each copy
required.

   

Cheques, credit card payments, money orders and cash are listed in separate
categories on the banking slip. Within these groupings, payments can be sorted in
different ways according to what is selected in the Options form on the Banking
page . You can also customise whether or not to print the patient's name and
account number on the list.

Note Payments will remain in the unbanked payments list until they are printed
on a deposit slip, thus inserting the banking date into the payment record.
Thereafter they will not appear on the unbanked payments list. It is
recommended therefore that banking slips be printed at appropriate
times even if they are not used for depositing the payments at the bank.

1.5.5 Send a letter

Click the Send a Letter button to open the letter writing window. If you open the letter
window from the Main Menu, you can send a letter to any person (whether or not they
are stored in the database) and this will not be linked to any of the patients in the
system.

There is a separate Letter button on the Account details screen and this should be
used for sending letters to or about particular patients. Usually you would open the
letter window from within a patient's individual account since you would normally be
sending a letter to a patient, or to a doctor or fund about a patient. See the Sending
letters  section for more details.

1.5.6 File management menu

The File Management Menu  provides access to functions such as backing up
data, adding a password, selecting an Items file and various housekeeping activities.

Note We strongly recommend you do regular backups of your data file, and
that you keep at least one copy outside your office.
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1.5.7 Edit options

The Options form  allows you to modify your provider information, modify item
details such as the MBS and RVG unit values, specify account format options and
other personal preferences. The Options button is also available on the bottom of the
Account details and List of accounts screens for easy access while working on
accounts. The Options should be thought of as dynamic preferences which can be
changed at any time, rather than items which are set once and then forgotten.

1.5.8 Run an application

Click the Run an application
button to display a list of
applications you can run
from within Access
Anaesthetics.

Double click an application
to launch it, or double click
the <Edit Lookup List> to
add your own selection of
applications.

   

1.5.9 Getting help and tips

Open the built-in Help  by clicking the Help button on any form, by choosing Help
from the Help menu or by pressing the F1 key when viewing a form. The Tips form
is opened by clicking the Tips button or menu option in the same way you would open
the Windows-style Help. The Tips form is designed to give you hints, late breaking
news, new features, answers to curly questions etc, and to record your own notes.

1.5.10 Quit

The Quit button will close Access Anaesthetics and return you to Windows. It is the
only way to exit the system. Clicking the close button (x) on the top right of the screen
will not close the system.

Always quit Access Anaesthetics before turning the computer off. Otherwise you could
lose data, or even cause corruption of your data file.
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1.6 Practice management guide

Sooner or later, whether you are a staff specialist, VMO or entirely in private practice,
you will need to send accounts to your patients. This guide will help you get started
managing the financial aspects of your anaesthetic business.

Who should do the billing?

The simplest option is to do it yourself. Other options are to have a family member,
friend or secretary do it, to use a billing service, share a secretary with another
anaesthetist, or use the services of your anaesthetic group. A busy anaesthetist may
only need 1-2 half days of secretarial work per week, less for staff specialists and
part-time workers. It is advisable to initially perform the billing yourself so that you can
fully understand and advise others on using whichever system you have chosen. It is
important to train the secretary and check his/her work until you have confidence in
them. Even if your anaesthetic group provides billing services, you should familiarise
yourself with how the secretaries prepare and manage your accounts since these will
reflect your own professionalism.

Using a billing service

There are now several companies which provide billing services to anaesthetists.
Some people use these exclusively for their entire practice, while others use them for
short periods while just starting out or to cover other temporary requirements. Usually
a billing service will send the account, collect and bank payments, follow up overdue
accounts, answer enquiries and provide regular reports. They may charge a fee per
account or a percentage of the fees invoiced.

Choose a computer system

A dedicated computer is essential for your anaesthetic practice, not only for
accounting, but for all kinds of educational and communication activities. Most
computers bought today will have adequate features to manage your affairs, so
choose on the basis of value for money and reliability of backup services. Essentials
include a modem for Internet access and a backup device such as a zip drive or CD
writer. Many people are now choosing a broadband cable or ADSL Internet
connection for speed and convenience. Desktop computers offer more features for
the price, while notebook computers offer portability and can perform most tasks
equally well. Handheld computers (Palm & Pocket PC) cannot yet replace desktop or
notebook systems.

Billing without dedicated computer software

It is possible to manage accounts without dedicated computer software using only the
MBS book, the RVG book, and a computer with basic word processing software.

Using Microsoft Word, for example, you could create simple templates for your
accounts and receipts. Create a new document based upon the template for each
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new patient and enter the relevant information into the document. You could automate
this further by creating a mail-merge document and entering the patient, item and fee
details into a table which is then merged with the account or receipt template.

This method is really only an option if you do a very small number of private cases
since it becomes too unwieldy with many accounts.

Using specialised anaesthetic software

Anaesthetic billing is quite complicated and generic accounting software such as
MYOB or Quicken is unlikely to satisfy. There are several dedicated software
packages for anaesthetists in the marketplace. Access Anaesthetics provides all the
functions required to streamline your billing, receipting, banking and reminder systems
to keep a comprehensive record of your business activity. This will increase your
practice efficiency and provide a professional look to your correspondence.

Types of accounts

Medicare. The MBS 'schedule fee' has been the fundamental fee for accounts for
many years because this is the total amount that the patient will be rebated from
Medicare and their health fund in most circumstances. Prior to November 2001, the
rebates for anaesthesia were set with reference to the activity of the surgeon, not the
anaesthetist. The RVG was subsequently incorporated into the MBS system to
provide an anaesthesia-based fee system.

The RVG system specifies a basic unit value for standard operative procedures
according to the difficulty of the case. A number of time units are added according to
the time the procedure took. Additional 'modifier' units are added according to the
degree of difficulty, out of hours work and so on. The total number of units is
multiplied by a dollar value per unit.

The schedule fee is determined using the unit value applicable at the time. In Nov
2001 this was $17.15.  MBS rebates (both pre and post Nov 2001) lag well behind
what is considered appropriate remuneration for anaesthetic services. Consequently,
it has been usual to add a percentage to the schedule fee, or since Nov 2001, to bill at
a specific unit value which may be substantially higher than the MBS rebate level.

Health Fund Schedules. Legislation now allows health funds to rebate patients for
amounts above the MBS fee. An anaesthetist may elect to provide services at a
private hospital for which (s)he bills the health fund or hospital directly rather than the
patient. The funds agree to pay a fixed fee to the anaesthetist which provides the
patient with a 'no-gap' service. Each fund publishes a schedule of fees which are
usually around 40% higher than the MBS fee.

Funds may also allow a 'known-gap' service where the fund will pay a fee above the
MBS fee, but where the patient also makes a co-payment. Such accounts may be
sent to the patient or, one to the patient and one to the fund.

It is usually required that the doctor register with each fund that they wish to use. The
doctor still has the option, for any account, to use or not use the health fund product.
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Using these methods may add significantly to the paperwork involved in sending
accounts, but may speed up the receipt of payments. Each fund has its own
requirements, which may or may not include written 'informed financial consent'.

For the doctor, the main advantages of using the health fund schedules are that the
payments are made quickly, usually directly into the doctor's bank account, and that
there is no need to follow up patients for delays in payment.

Health fund rebate methods are still controversial and you are advised to consult your
colleagues or the ASA for the latest guidelines.

ASA RVG. Over many years, the Australian Society of Anaesthetists lobbied the
government to incorporate its RVG (Relative Value Guide) into the MBS schedule and
this was finally introduced in Nov 2001. Prior to that time, many anaesthetists used the
ASA's RVG schedule to determine their fees even though it was not recognised by the
Health Insurance Commission. It was considered a more appropriate system of
determining fees. The ASA's RVG schedule has its own item numbers which are
different to the MBS item numbers. Not all items match between the two systems and
the ASA schedule has a number of additional modifier items.

The ASA's RVG schedule can be used to bill patients. However, where the patient is
eligible for a rebate from Medicare, the account should show the item numbers used
in the MBS schedule. Medicare assessors will only pay rebates for items they can
identify and problems at this stage mean lower rebates for patients and more follow
up work for you or your secretary.

Third Party and Workers' Compensation. Where an operation is performed in relation
to a motor vehicle or occupational accident, the account is usually sent to an
insurance company or solicitor rather than the patient. In NSW, most third party and
workers' compensation insurers prefer to receive anaesthetic accounts generated
using the ASA's RVG schedule, rather than the Medicare schedule. They will then
provide payment for fees up to the maximum unit value recommended by the AMA. It
is advisable to obtain relevant insurance company or solicitor details during the
preoperative consultation. Some states have different arrangements. For example,
the Victorian and Queensland Workcover authorities have a separate schedule of
fees or time based payments.

Department of Veterans' Affairs. When sending patient accounts to the DVA,
anaesthetists may elect to be paid according to the MBS or according to the time-
based schedule developed by the DVA. In the former case, standard MBS accounts
should be generated. For time-based accounts, you need to provide the specific times
for the anaesthetic procedure and details of any additional procedures performed. You
will be remunerated according to a standard formula with a rate for the first 30
minutes, then for each 5 minutes thereafter. The DVA have their own set of 6 item
numbers for time-based accounts, and these should be used on accounts instead of
the MBS anaesthesia item numbers.

Determining what to charge

In setting your fees, consider practice costs, what you're worth, your experience, the
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difficulty of the procedure and the patient type (emergency, overseas patient, ability of
patient to pay, pensioner etc). Practice costs may include rent, wages, medical
defence premiums, computer hardware and software, postage, continuing education,
the cost of living in different cities and anticipated delays in payment. If using the
RVG, you may settle on a specific unit value or, for MBS accounts, a specific
percentage above the schedule fee.

Inform your patients about your fees

Because of the low level of MBS rebates, many of your private patients will be
expected to pay a gap especially if you use RVG billing. You should discuss your
estimated fees with your patients prior to surgery explaining the reasons for and likely
amount of the gap. Patients may legitimately complain about large gap payments if
not informed previously. The ASA has developed an 'Informed financial consent'
brochure which may be helpful in your discussions with patients. Or you may wish to
provide the patient with a written estimate or quote. This can be personalised for each
patient, or a standard quotation could be produced for procedures you perform
commonly. It may also be useful to inform your surgeon of your estimated fees.

Other useful brochures are also available from the ASA including 'Anaesthesia and
you', 'Epidural anaesthesia and you' and 'Pain relief'.

GST

GST does not generally apply to private anaesthetic procedures, third party, workers
compensation or Veterans' Affairs accounts. Nor does it apply to any procedure where
an MBS number applies. It does, however, apply to anaesthetics given for elective
cosmetic surgery and to some other procedures. It also applies to sessional payments
from hospitals to VMOs. Consult the ASA for the latest details.

Discounts

Some anaesthetists find that offering a small discount to patients helps to improve the
practice cash flow and reduce the need to follow up overdue accounts. Generally
discounts are offered to patients for timely payment of accounts and if the payment is
not received within a specified period, the patient is liable to pay the undiscounted fee.
This seems to work particularly well where the period the discount is available is short
enough to require that the patient pay the fee directly, rather than to apply and wait for
Medicare and fund rebates.

Very large discounts are inappropriate as it may appear that the un-discounted fee
has been artificially inflated.

Important note on fees

Each anaesthetist must set his/her fees individually after considering all factors which
are relevant to his/her own practice. The ACCC takes a dim view of making
agreements with those who would be considered your competitors. Note also that the
ASA does not recommend specific fees; its advice regarding the RVG constitutes a
standard method of comparing the relative value of different anaesthetic services.
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What to put on the account

Essential items include your full name, provider number, qualifications,
correspondence address, telephone number for enquiries, patient's name/address,
date of each anaesthetic service, description of service, total fee, surgeon, date the
account was sent and a unique account number. Additional items may include any of
the following; your company name and ABN or ACN, MBS or RVG item numbers,
times/duration of procedure, hospital, claim number for Veterans' Affairs or insurance
claim, patient's date of birth, date of injury, discount offered, GST if applicable,
message regarding the derivation of the fee, message regarding the overdue status of
the account and payment instructions.

Private health fund billing may require additional paperwork and this is different for
each fund. Some require that account details be recorded on their own stationery;
others require a summary form (batch header) to be included with a group of
accounts. The details will be included with a provider's pack when you register with
each fund.

When to send accounts and reminders

Accounts should be sent as soon as practical after an anaesthetic service. You may
wish to give consideration to individual patient circumstances such as a prolonged
hospital stay. For major surgery you may wish to wait until after a patient has returned
home while for minor procedures, sending an account the same day may be
appropriate. This delay will depend on each individual anaesthetist or on the
preferences of a group.

Where payments are not received within a specified time a reminder should be sent
which includes a copy of the original account. Again, the delay before reminders are
sent should be determined by the individual anaesthetist. Additional reminders with
appropriate messages may be sent thereafter at specified intervals. Discounts may be
helpful in encouraging prompt payment of accounts.

In some cases it may be beneficial to telephone patients to enquire about non-
payment of accounts. You may prefer a spouse or secretary to do this rather than do it
yourself. The emphasis should be on assisting the patient to pay the account, rather
than making demands.

In considering the time within which to offer discounts, send reminders and make
telephone calls, it is worth noting that Medicare estimates the following times for
processing accounts: 18 days for unpaid accounts presented to Medicare for payment
to the provider, and 10 days for paid accounts presented to Medicare for
reimbursement to the patient.

For accounts where payment is not forthcoming after reasonable efforts, it may be
wise to use a collection agency. Generally they will send 2 or 3 letters to a debtor with
increasing levels of 'encouragement' to pay. Some charge a percent of fees recovered
while others charge a fixed cost per account. Consult your colleagues to decide which
agency to use or look up the Yellow pages under 'Debt collection services'.
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Receiving payments and handling enquiries

Most payments are made by cheque received through the mail and only few
anaesthetists (usually those belonging to groups) can accept cash payments at their
rooms. Since most consultations occur at hospitals, anaesthetists rarely require
rooms. A post office box may be all that is required.

Apply to your bank for a merchant facility so that you can accept credit card payments
from your patients by mail or phone. This is easy to set up even for a single
anaesthetist. It is convenient for patients and can be very useful when telephoning late
payers since payments can be taken immediately by phone. These days everyone has
a credit card.

Health funds usually pay their no-gap accounts directly into the doctor's specified bank
account and send a statement with the details.

Some consideration needs to be given to how to provide a phone answering service
during business hours. It's a good idea to set up a second line into your house with a
separate number and an appropriate answering machine message. If required, calls
can be diverted to a mobile phone or to an instant messaging facility.

It is not uncommon for patients to experience difficulties in their dealings with
Medicare and health funds and it is a good idea to create standard letters for
managing recurring problems. A set of standard letters to deal with patient enquiries
regarding fees may also be helpful.

Use a logbook

Start up a physical logbook to record all your private cases. There is no substitute for
a simple paper record of all the anaesthetics you have ever given, especially if your
practice has any electronic problems in the future. A paper record gives you a reliable
time-referenced gold standard of the work you have done. Some examples of
logbooks are:

An annual diary. Use one such as a Collins A4 sized diary with one day per page. For
each anaesthetic you give, place a patient label on the page and write down the
details of the procedure. You may find that the page sizes are insufficient for some
days and too big for others. You can instead ignore the days and just stick the labels
and details in a chronological sequence. Then label the books in the same way you
would label an old cheque book, e.g. Jan-Mar 1999. If you do this you won't need a
diary as such but the A4 ones are a handy size.

A card system. Buy some 5 x 3 or 6 x 4 inch blank index cards from a newsagent or
stationer and keep a bundle with you when you are working. Put a patient sticker on
each one and record the procedure details, one anaesthetic to a card. If you want to
be really organised, print a template onto the card with blanks and boxes to prompt
you for relevant information.

A loose leaf folder. For the ultimate in record-keeping, use your word processor to
print a template onto an A4 page containing detailed prompts for information to enter,
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and ample space for waxing lyrical about the procedure. Keep your pages in a set of
ring binders. This may be a bit excessive for your average anaesthetist.

Always keep the diary or cards with you when you are working so you can use the
quiet times to enter the details of your anaesthetics. Create a new entry every time
you give an anaesthetic, or if appropriate, when you see the patient during a pre-
anaesthetic consultation.

What about entering data directly into a computer without the paper record?

There is a certain amount of duplication involved in completing a paper record and
then entering it into a computer. If you like, take a notebook or pocket computer with
you to work and enter the data directly. This will eliminate the duplication, do away
with the paper record and save you some time later. However, there are a few
disadvantages to this system as follows:

· You won't have the advantage of a reliable gold standard paper record which is
immune to electronic problems.

· You need a portable computer.
· You must take your computer to work and avoid losing it.
· You may not have time to do the data entry.
· Doing the data entry may distract you from your anaesthetic duties.
· Privacy of your accounts may be compromised.
· It may be unwise to be seen dealing with accounts while involved in clinical

activities.

Handheld computers

Palm and Pocket PC devices are being used more commonly in the operating theatre
environment. This evolving technology offers much to the anaesthetist. As well as
being able to enter details for private accounts, these can be used for clinical
logbooks, a diary, address book, journal reference manager, drug information index,
infusion calculator and many other uses.

What to put in the logbook or cards

· The patient address sticker. If you can't find one, transcribe the patient name
and address from the notes and also the date of birth.

· The date of the anaesthetic – don't omit it, especially if using a card system.
· The surgeon, operation and hospital and their relevant contact numbers.
· The MBS item numbers for the procedures.
· Whether or not a pre-anaesthetic consultation was done.
· Details of pressure monitoring, transfusion or any other extras.
· The start and stop times for the anaesthetic and any RVG modifying factors

such as patient age, emergency status, and whether it was done out of hours.
· Contact details including home, work and mobile numbers. These may be

invaluable for following up unpaid accounts.
· Patient's insurance status and health fund details including membership number.
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· For Veterans' Affairs patients – the DVA number.
· For Worker's compensation or third party patients – the insurance company,

employer and/or solicitor and any relevant claim number.
· Any relevant clinical notes.
· Details of the account type and fee to be charged e.g. SF, RVG@30.
· Details of any discussion of fees including any estimated gap.

Enter the procedure details into Access Anaesthetics

Whenever it is convenient, enter the relevant data from your logbook or cards into
Access Anaesthetics. Or, 'Hotsync' your Palm or Pocket PC to transfer the accounts
directly. When a new account is created, it will automatically be assigned a unique
Account Number. You should record this number in your logbook or on each card for
easy reference.

If you have a secretary

If you have a spouse or secretary doing this job for you, simply hand them the logbook
or completed cards or, if your secretary works elsewhere, post or fax the cards. (A
logbook is not the best option in this case.) You could even use a post office box as
an intermediate point between your secretary and you; you pick up your mail and
leave your cards while your secretary collects your cards (and cheques for banking)
from the same box. You don't even have to see each other!

Manage printing, receipting, banking and sending reminders

After an appropriate time has elapsed from the anaesthetic procedure, print the
accounts which are Ready to send. When payments arrive record the details in the
computer. At the end of a computing session, print receipts for any accounts which
need them, print any new accounts which are Ready to send and print any reminders
which are due for outstanding accounts. Prior to your next trip to the bank, print a
bank deposit slip for the payments received since the last deposit.

Letterheads

The letterhead formats built in to Access Anaesthetics can be customised sufficiently
for most people and look professional. If you want to design your own, go ahead, and
have it printed by a professional printer. You may, for example, like to print in colour,
add a logo or create a particular look. Then put the letterhead paper in your printer
and print your accounts and letters onto it (you can turn off the built-in letterhead in the
system Options). Be sure that your own letterhead doesn't conflict with the page
locations that Access Anaesthetics uses to print data.

Postage and design issues

The printed account and letters produced by Access Anaesthetics were designed so
the address details would appear in the appropriate position for a standard DL window
envelope. Buy a batch of these and a roll of stamps and you're ready to mail your
accounts. With this system, you don't need to hand write addresses or print sticky
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labels.

To personalise your correspondence, have the local instant printer print a batch of
envelopes with your name and return address or have some small address labels
made up which you can stick onto your envelopes. The latter are very inexpensive
and look fairly professional. A more fiddly option is to print your details onto the
envelopes using your word processor. But be careful with window envelopes in laser
printers. The heat generated may damage the plastic window or even the printer.

Rent a post office box for your business correspondence. Small ones are only about
$40 per year.

Further information

We recommend you visit our website at www.healthbase.com.au. As well as
information on Access Anaesthetics software, you will find links to professional
societies, journals, health funds, government bodies, computing issues and many
other useful anaesthesia resources.

Disclaimer: This beginner's guide was produced as a service to participants of the NSW ASA "Going into
Practice" seminar on October 12, 2002. The opinions expressed here are those of HealthBase Pty Ltd and
do not necessarily reflect the opinions of the ASA or any other organisation.
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2
Accounts - General

C H A P T E R

The Account Details screen contains all the information for an individual account. The
data is divided up on a number of tabbed pages to make entering and locating the
data easy. This is where all data entry is performed, where the fee is determined and
where all payments are recorded. This chapter describes how to enter the patient and
operation details. Subsequent chapters look at entering items, fees and payments.

2.1 Main window functions

This section provides information on those functions of the Account details form which
are activated by buttons located around the outside of the grey tabbed area.
Subsequent sections in this chapter provide details on individual pages of the Account
details form.

The top of the Account details form

The bottom of the Account details form

Navigation

Scroll from one account (patient) to the next using the buttons at the bottom left. This
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will scroll through the group of accounts currently selected, usually the 'open'
accounts. It is possible to have a group of just one account, or a group of many
hundreds depending on what you have chosen from the Select menu .

Each account has a number of pages of data which can be opened by clicking on the
labelled tabs. Additionally, the keyboard shortcuts <CTRL> <LEFT ARROW> and
<CTRL> <RIGHT ARROW> will move the focus to the previous and next pages of the
same account. Note that these shortcuts move the focus to different pages of the
same account.

Additional keyboard shortcuts will open specific pages. The key combination is
<CTRL> plus a number from 1 to 9, with 0 to substitute for 10. This opens to the
respective page number starting at 1 on the left, through 2, 3 … 9 with 0 as page 10.
For example, CTRL 5 takes you to the Fee page.

Jump to the List of accounts , List of Payments  or Main Menu  using the
buttons on the top right of the screen. If appropriate, the account you have jumped
from will be located in the list.

Sending letters

Click Letter to send a form letter to this patient or to a third party payee. Or you can
use this function to write an individual letter to the patient or to a third party about the
patient. If you wish to send a letter to someone who is not a patient or third party
payee, click the Letter button on the Main Menu. Letters written from the Main Menu
will not be associated with any particular account.

Deleting an account

Click DELETE account to delete the current patient from the database. This function
will delete all traces of the patient from the system including all financial details and all
snapshot files if they exist. It is expected that you would NOT do this very often and
that it would usually only be used to correct incorrectly-entered accounts. Once an
account is deleted, it CANNOT be recovered unless you restore an earlier backup
data file.

Changing system options

Click the Options button to open the Options form and modify your provider
information, item details such as the MBS and RVG item unit values, specify account
format options and other setup variables.

When you change an Option, it is changed for the entire system, not just the current
account. This button is also available on the Main Menu and the List of Accounts
forms, and on the Tools menu.

Options can be changed and reset at any time. For example you may wish to print an
account without showing the built-in letterhead even though you might usually show
this on your accounts. Simply change the option, print the account, then change the
option back again. It is very simple when you get used to what options are where.

33
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Adjusting font size

The font of the Account details screen is initially set to MS Sans Serif point size 8. As
computers have developed and higher resolution screens have become more
common, the entire window size may need to be adjusted. We are currently working
on a method to do this. In the meantime, click Tools > Resize fonts to switch between
8 point and 10 point font sizes. This will provide some relief to users with screen
resolutions which render the Access Anaesthetics window quite small.

It is also possible to format the List of Accounts  and List of Payments  for better
readability, and to adjust the size  of the Access Anaesthetics window.

2.1.1 Creating a new account

Click the New button to create a new Account. An Account Number will be inserted
which is one greater than the highest account number in the database. If it is the first
account, the recommended starting account number will be 1001. You can adjust this
if you like keeping in mind that the highest account number that Access Anaesthetics
can assign is 32,000. (You can later restart account numbering at a higher number
from the Options form - Provider page .) After clicking the new button (either from
this page or from the Main Menu) the New button will be renamed to Cancel. Clicking
Cancel will cancel the new account. After a surname is entered into the account, the
account is automatically saved and the Cancel button will revert to New. Thereafter if
you wish to cancel an account, press the Delete button. It is not necessary to
manually save any data in Access Anaesthetics; all data saving is done automatically.

Use this form to enter all the data associated with one occasion of anaesthetic
service. Start with the Patient Addr page, then move on to each page in turn, entering
data on the Pt Data, Operation, Items and Fee pages. Normally this is all you would
need to enter to create an account. Then press the Print now button on the bottom of
the page and you have created your first account. You can set additional options on
the Format page, but this is not required.

When you receive payment for the account, go to the Payments page for this patient
and enter the details there. The Status page will show you the current and previous
status of the account, the Documents page will show you exactly what paperwork has
been sent to the patient and the Notes page is for you to record any details you wish
to enter about the patient or account status.

Account number prefix

A prefix can be added to account numbers on printed accounts. This is especially
useful for multi-provider systems where otherwise, it may be difficult to identify which
provider a particular account number relates to. Three characters are allowed;
normally this would be the providers initials. The prefix is only displayed on printed
accounts. It has no other significance in Access Anaesthetics and cannot be used for
searching. Set this up on the Provider details page  of the System Options.

134 152

176

163

163



Chapter 2.  Accounts - General

32 Access Anaesthetics Practice Management System

2.1.2 Finding accounts

Search for a patient by clicking the Find button and entering an account number or
part of a patient's name. A Find button is also located on the Main Menu and the List
of Accounts screens. If found, you will be taken to the Account Details screen for that
account.

If more than one matching account is found, a dialog box will appear with all matching
accounts. Click on a patient's name to jump to their account. The dialog box also
shows the patient's operation date, account date and payment status to assist in
locating the required account.

The matching patients can be sorted by clicking the title of each column. The dialog
box will show all matching patients in the database whether or not they are included in
the current selection (e.g. Open accounts).

Can't find a patient?

If the patient or account number cannot be found in the current selection (e.g. Open
accounts) you will be given a message and asked whether you wish to search through
all the accounts in the database. If you click OK, the selection criteria will be reset to
show all accounts and the account will be found. (This may also happen if you jump
from the Payments form to either the Account details or List of accounts forms. This is
because the system tries to locate the account from which you jumped.)

Multiple provider data file searching

With multi-provider versions it is possible to optionally search all data files at once. To
do this, enter a slash (/) after the name or account number you are searching for. So,
instead of entering Jones, enter Jones/ (or 1234/). If more than one account is found,
the dialog box allows you to go to the selected account by switching data files. If the
slash is omitted, only the currently open provider file is searched.

Recent accounts



2.1.2  Main window functions > Finding accounts

Copyright © 2003 HealthBase Pty Ltd 33

Three drop-down lists on the bottom of the screen
provide quick access to recently viewed, printed and
closed accounts. The most recent account will be at the
top of the list. Scroll down to view the rest of the
accounts. Jump to an account by clicking on it in the list.
Double click on the field without opening it to jump to
the most recent account.

   

2.1.3 Account selection

When you first open the Account details form (or the List of accounts), only Open
accounts are shown. That is, new accounts which have not yet been sent or existing
accounts which have not yet been paid. Accounts are either Open or Closed
according to whether they have a Date account closed specified on their Payments
page .

To view a different set of accounts (other than
Open accounts), choose an option from the
Select menu. This might be Closed accounts to
show all paid or all lost-cause accounts,
Overdue to show accounts unpaid after more
than a specified time, and so on. You can also
specify Advanced selection criteria  to be
used to view a very specific group of accounts.

The grey button on the top right of the screen
just under Main Menu shows which group of
accounts is currently being viewed and how
many of them there are.

Clicking the button will show you the SQL
(structured query language) query used to
select the records and gives you the option of
resetting the current criteria to show all the
accounts in the entire database.

   

If you would prefer the system to show all accounts, rather than just Open accounts
when it first starts, you may specify this on the Miscellaneous page  of the Options
form.

Note The accounts selected in this screen will also be selected in the List of
accounts screen. In this way, you can select a group of accounts, go to
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the List of accounts screen and view them in a tabular format.

2.1.4 Entering dates

Date formats

Entering dates is a personal thing and no two people will agree on the best format. In
Access Anaesthetics, you can generally use the method you are familiar with.
However, whatever way you enter a date, it will always be displayed in the format
DD/MMM/YYYY, for example, 03/Apr/2002.

Dates can be typed directly into date fields. The fields have no input mask. In other
words, the dot (.), hyphen (-) or slash (/) that you would normally insert does not
appear automatically. This is because people have different habits with entering
dates, and we have not imposed our own preference. The simplest way to enter a
separator is to use the space bar. So if you enter 9 7 2003, the date will appear as
9/Jul/2003.

The purpose of using the 3 character month format is to avoid problems where some
computers still have a US date format. This can lead to people entering 7/4/2003 and
finding that the date appears as 04/Jul/2003 instead of 07/Apr/2003. The
DD/MMM/YYYY format is unambiguous.

Additional date entry features include the following:

· Enter one digit instead of 2 for days or months less than 10, i.e. enter 2 instead
of 02.

· Enter characters for the month if you find it easier, e.g. Apr.
· Enter 2 digits instead of 4 for the year and the display format will alert you if the

year is in the wrong century. Normally, numbers of 29 or less are assumed to be
in the 21st century, e.g. 29 -> 2029, while numbers above 29 are interpreted as
20th century dates, e.g. 30 -> 1930.

· If the date is in the current year, you don't have to enter the year at all, e.g. enter
3/2 and the date is interpreted as 3/Feb/2003.

· You can use the space bar instead of the slash, so entering 3 4 0 will be
interpreted as 3/Apr/2000. Avoid using a full-stop as a date separator.

System date format

If you occasionally see the date in the US format, you may have your computer's short
date format set to the US standard. To change this, modify the date settings in the
Windows Control Panel. To do this, click Start > Settings > Control Panel > Regional
Settings > Date, and change the short date format to dd/mm/yyyy. The exact steps
may vary with different Windows versions.

To assist in clarifying the date formats, the current date is shown on the bottom right
of the Access Anaesthetics Main Menu in a long format (e.g. Wednesday February
12, 2003). Alongside this is shown the corresponding Windows Short Date format
(.e.g. 2/12/03) so that if necessary, you can check that the format for entering dates is
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what you expect.

Date shortcuts

· Increment the date by one day by pressing the + or - keys on the keyboard while the
field is highlighted. (Where the '+' character is on the same keyboard key as the '='
character, the shift key is NOT required.)

· Press the t key to enter today's date.
· Other shortcuts are available for the operation date and time as described in the

Operation  section.

Using the calendar to enter dates

Most of the date fields can also be
entered by using the calendar function.
This is activated either by clicking the
calendar button immediately to the right
of the field (e.g. date of birth) or by
double clicking on the date field (e.g.
individual item dates). Select a year,
month and day with the mouse and click
the Apply button to insert the chosen
date into the field. If there is already a
date in the field, the calendar will open at
this date, otherwise the current date will
appear as the default.

   

2.1.5 Printing accounts

The Print now button opens a dialog
box allowing you to either preview or
print the current account.

When you print an account for the first
time, it's Account date is set to what
you specify in the dialog box and the
printed document is called an Account.

For future reference, the Account date
is shown on the Status page.

   

When you print the account again, for example when printing a receipt or reminder,
the original account date will not be altered and the printed document will be
designated an Account, Receipt or Reminder depending upon the current status of the
account. A dialog box will be shown allowing you to modify the account designation
(receipt, reminder etc) and any additional message which is to be inserted onto the
account related to it being paid or overdue.

45
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If the Receipt tag has been checked (see the Payments page ), the account will be
deemed a receipt. If the receipt tag is not checked and an amount is still owing, it will
be deemed a reminder and the Number of reminders field will be incremented by 1.
As stated above, default messages are attached to the accounts when reprinted.
These, and the account designation can be modified at the time of printing.

Changes to the status of the account or to the number of reminders are only stored in
the database if the account is actually printed on the printer, not if the account is
simply previewed without being printed.

Tag for printing

Tick the Tag for printing checkbox if you want to print this account later in a batch
process from the List of accounts screen .

2.1.6 Data check

Click the data check button
on the bottom of the form to
run a set of tests on the
current account to check for
missing or inappropriate
data. If any errors are found
a message will be shown.

Errors are divided into high-
and low-priority, depending
upon how much of a
problem they are.

   

You can specify whether to have the data check performed automatically when you
press the Print now button by checking the appropriate box on the Automatic functions
page  of the Options form. If set on, when you press the Print now button the data
check is performed. If any high-priority errors are found, a message will be displayed
and you will have the option of cancelling the printout or ignoring the error to continue
printing. You will not be notified of any low-priority errors in the automatic data check
unless high-priority errors also exist. This check is not performed if you print an
account or batch of accounts from the List of accounts .
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When a new account is created, the account status is initially set to Further
information required. After you have entered items into the Items page, the data check
is done automatically. If no high-priority errors are found, the status is automatically
set to Ready to send or Too early to send (depending upon the operation date, today's
date and the operation-account delay specified on the Automatic functions page of the
system Options). The full data check is only done on accounts which have not yet
been printed. Consequently, if an Account date exists, an automatic check does not
occur, and a manual check does not examine all potential errors.

As new features are added to Access Anaesthetics, we try to keep the data check up
to date. However, the data check will not find all problems and should be considered a
guide for finding major problems only.

2.1.7 Status

The current payment status for each account is shown at the top of the screen just
under the Account details menu option. This is set automatically according to various
criteria. For example, when an account is first printed, the status is set to Awaiting
payment. If it is not paid within a specified period (as set in the Options form on the
Automatic functions page ), it is changed to Overdue.

Normally it would not be
necessary for the user to
manually change the status.
However, it is possible to do this
by selecting a new status phrase
from the drop down list. You
may also enter your own custom
phrase by selecting Enter my
own from the list and typing any
phrase you wish. If you do this,
you will need to manually keep
track of the account since built-
in functions operate according to
which of the listed phrases is
stored.

Whenever the status is
changed, a new entry is added
to the status log showing the
date and time the status was
changed. This is shown on the
account's Status page .
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2.2 Patient address

This page stores the patient's name, address and contact details and allows you to
check if the patient already exists in the database. You will not be able to move from
this page until a surname is entered, or until the account is cancelled.

If the account is to be sent to someone other than the patient, a duplicate set of
contact details can be entered using a lookup list for third party addresses .

Data entry

Enter data by clicking the mouse into a field and typing on the keyboard. Press the
ENTER or TAB key to move to the next field. Depending upon the characteristics of
the field, the ENTER key may cause the cursor to jump to the next line in the same
field rather than to the next field. This happens in the Contact numbers field, for
example, so that additional numbers can be listed below each other. Consequently, it
is usually better to use the TAB key to move from one field to the next.

Move to the next data entry page by clicking the labelled tab at the top of the page.
You may also use the <Ctrl> <Left Arrow>, <Ctrl> <Right Arrow> or <Ctrl> <tab
number> shortcuts as described above .

Automatic name and address formatting

Access Anaesthetics automatically capitalises name and address fields by default. For
example, 'dr j smith' is set to 'Dr J Smith' when you exit the relevant field. This

40
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removes the need to use the Shift key during data entry. In the address fields, po box
and gpo box are capitalised to PO Box and GPO Box respectively.

If you normally type the surname in all capital letters, you can force this to occur by
ticking the relevant box in the Automatic functions page  of the Options form. This
avoids having to keep the Caps Lock key on.

It is also possible to turn off the automatic capitalization in the Options form. This can
be useful if you need to enter a lower case character into the surname such as van
Dieman. After entering the surname, reset the capitalization checkbox or the autocaps
function will not work for the rest of your accounts.

If you have automatic capitalization turned off, you can operate it on an individual
basis by double clicking on a field to convert all first letters to upper case. In any case,
double clicking on the surname field will toggle between first letter caps and all caps.

Country property names. These are commonly written within inverted commas, for
example, "Kalamos". To do this, type the text without inverted commas and add a
single inverted comma at the end, e.g. Kalamos'. When you exit the field, this will
wrap the text in inverted commas resulting in "Kalamos".

2.2.1 Postcodes

Access Anaesthetics contains a list of about 18,000 Australian postcodes. Because a
lookup list containing so many records would function very slowly, special procedures
have been implemented. Below are several ways of entering postcodes into your
accounts.

· Enter the suburb and the matching state and postcode will appear automatically.
This is the most efficient option.

· Enter 2 or more characters of the suburb, then press the F4 key to open the
suburb lookup list beginning with the characters you have entered. Enter
additional characters or select a suburb from the list.

· Enter the postcode and the matching suburb and state will appear automatically.

Which postcode is selected

Since there may be more than one suburb with the same postcode, when entering a
suburb or postcode, the one which is inserted may not be the one you want. The
lookup list shows the items which match the suburb and postcode entered. If the
suburb and postcode fields are blank, the lookup list will be empty. For example, if the
postcode 2031 is entered, the lookup list will contain Clovelly NSW 2031, Clovelly
West NSW 2031, Randwick NSW 2031 and St Pauls NSW 2031.
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If 2134 is entered, the lookup
list will contain the following:

    

If an incorrect entry is made, simply select the correct entry from the list. Where there
are several postcodes for the same suburb, the system will select the last one in the
list, to avoid selecting the newer PO box postcodes such as 1805.

You can specify the first state to be used for postcode searching so that, in the above
example, entering Burwood would select the Victorian postcode rather than the NSW
one. Do this on the Miscellaneous page  of the Options form.

Additionally, you can specify a default postcode to be inserted into new accounts. This
is mainly for users in country towns where most patients are from the same postcode
area. The postcode is inserted automatically after the surname is entered or changed,
but only if there is not already an existing postcode or suburb.

If you wish to view the entire list of postcodes, click the
'A' (All) button next to the lookup list to show the entire
list of suburbs and postcodes in the list box.     

If there is a state the State field, this function will show all suburbs in that state,
otherwise all suburbs in the country will be shown. Click the button again (now labelled
M for Matching) to show postcodes matching the postcode currently on the account.

It is also possible to edit the entire list of postcodes by clicking the pencil button. This
will allow you to add a new suburb and postcode or edit an existing one. We don't
normally recommend this procedure however, since the list is stored in the MBS/RVG
items file and will be overwritten the next time you install an items file update. See
Using Access datasheets  for how to edit the data in the lookup table.

Note In accordance with the recommendations of Australia Post, suburbs are
usually shown in upper case characters.

2.2.2 Third party address

Normally you would send the account to the patient at their own address. Alternatively,
you can enter details for another person who will receive the bill on behalf of the
patient. This may be a parent, a health fund, a third party insurance company, the
Health Insurance Commission (DVA patients), 'The Estate of …', and so on.

On the right side of the Patient Addr page,
click this button to reveal the additional
address fields below.
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Type in the address details manually, use the copy buttons, or choose a stored
address from the drop down list. The usual name, address and postcode shortcuts
are available.

If the third party address
contains an entry in the
Surname or Address
fields, the third party
address will be printed on
the account, and the
patient's name and
address will be printed
next to the Patient label,
as show here.

   

After entering or modifying an address, you can save the address in the list of
addresses by clicking the Click here to save … button. The new address will then be
available in the lookup list to enter into any other account. The entire list of stored
addresses can also be edited further by clicking the pencil button on the right of the
address code (or by selecting Edit Lookup Tables from the Tools menu). This will
open the following window.
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When sending an account to a health fund, the Fund Fee To Use field allows you to
specify that a particular health fund fee schedule should be used to determine the fee.
This avoids having to select a health fund from the list on the Items page.

The Batch header tab is use for printing a cover page for a group of accounts. This is
described  in the List of Accounts section.

Note If you don't use a window envelope to mail your accounts, there is no
need to use the third party address. For example, if you are sending a
batch of accounts to a health fund in an already addressed bulk
envelope, you might as well leave the third party address blank. In this
case, there is no advantage in entering the health fund address.

2.2.3 Copying from another account

Access Anaesthetics is designed so that one anaesthetic service is described on one
account and each new anaesthetic service requires creation of a new account, even if
the patient has already been entered into your system on a previous occasion. If you
regularly anaesthetise the same patient, you can copy their details from a previous
account by selecting from the list on the bottom of the Patient Addr page.

129
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The list shows all accounts where the first name and surname match those entered
into the current account. For example, if you create a new account and enter the
name Mr Bill Smith, the lookup list will show all accounts for anyone called Bill Smith.
If you can't find the appropriate patient, delete 'Bill' from the first name field and the list
will show all patients with the surname Smith. Maybe then you will find an account for
a Mr William Smith, who is the correct patient. You can do the same with the first
name. That is, enter Bill into the first name field, leave the surname blank, and the list
will show all people whose first name is Bill.

To assist in finding the correct patient, highlighting a row in the list displays that
account's address, surgeon, operation and status in the status bar at the bottom of the
page. When you find the appropriate patient, click the Copy from button and the
address details will be inserted into the current account. This will also insert the third
party address if it exists in the source account.

Note that the list may contain patients with identical names who are not the same
person. Also, if the spelling of a name has been changed (e.g. Lesley vs Leslie) or an
alias used (e.g. Bill vs William) you may fail to locate a patient who has in fact
appeared on a previous account. The separate Find button may help to locate a
patient with a slightly different name, as it will find all patients whose name contains a
specified set of characters. For example, entering Lesl into the Find dialog box, will
find patients called Lesley or Leslie.

Once an account has been printed, this copying function is disabled to safeguard
against inadvertent or accidental modifications of name and address data.
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2.3 Patient data

The Pt Data page records additional information on the patient, his fund membership
numbers and so on. All the entries on this page are optional, although some will be
required for specific account types.

It is possible to record data on this page without having it appear on the account by
unticking the checkbox next to the relevant item. Defaults for these checkboxes can
be set up in the system Options on the Account Format page .

Gender

This field is simply for your own record. It is usually completed automatically
depending on what you specify in the Title field on the Patient Addr page .

Date of birth and age

If you enter the date of birth, the patient's age is calculated automatically when you
enter the operation date (on the next page). If either is blank, the age will also be left
blank. In this case, you can enter a specific age into the Age field (you might do this if
the date of birth is unknown). If you do enter a specific age, and you later enter a date
of birth, the specific age you entered will be replaced with the age calculated from the
date of birth and operation date.

Patient ID numbers
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The Medical record number, Medicare number, Veterans' Affairs number, and an
insurance Claim number may be entered in the appropriate fields, and will appear on
the account if checked.

Private health fund details

Details of private health fund membership may be entered. A lookup list is provided to
streamline entering health fund information but the field is not restricted to this and
any data such as membership number or cover type may be entered. The data
recorded in this field does not have any effect on the fee selected and, in particular,
will not specify that a particular health fund's fee should be used. The lookup list may
be customised by selecting <EDIT LOOKUP LIST> from the list itself.

Other patient information

This field can be used to enter any patient-related information for which there is no
other appropriate field. The details will be printed on the account just below the
hospital name. Use this field to record items such as injury date. Since the field is not
labelled, you need to say what it is, e.g. Injury date: 10/02/2001.

2.4 Operation details

The surgeon, hospital, procedure and date/time details about the operation are shown
together on the Operation page.
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2.4.1 The surgeon, hospital and operation fields

The Surgeon, Hospital and Operation fields can be completed using a number of
different methods which use customisable lookup tables. All three use similar
functions which will not be separately described. Each field contains the following
components ...

There are several methods of entering data.

· Type the entire name details directly into the field. For example, type Dr Zachary
Smith.

· Click the drop down arrow to the right of the field and select from the list.
· If you know the abbreviation for the surgeon, hospital or operation, type it in and

press Enter. For example, enter zac to enter Dr Zachary Smith. Once you know
an item exists in the lookup table, this is the quickest data entry method.

If you enter a name which is
not stored in the database,
you will be prompted as to
whether you wish to add it to
the appropriate lookup table.
If you enter a name of 5
characters or less, the
system will assume that you
have typed an abbreviation
code. Otherwise, it assumes
the data to be a new
surgeon, hospital or
operation and opens the
appropriate form to allow you
to customise the details. To
add a new item to the lookup
table, type in a new
abbreviation and then enter
the data requested.

   

It is possible that if you are often entering new surgeons or operations that you will
only use occasionally, you may not wish to add them to your list. If this is so, the
tendency for the editing form to pop up may get a bit annoying. You can turn this
feature off if you like by unchecking the appropriate box on the Automatic functions
page  of the system Options form. Even if switched off, the following editing
functions will still be usable.
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 Click the edit button on the right of the surgeon, operation or hospital field to
view the data currently stored in the lookup table (or double click on the field). If the
surgeon, operation or hospital does not already exist in the lookup table, you will be
able to edit and store the new entry.

A separate button on the surgeon editing form allows you to open the entire list of
surgeons (or hospitals or operations). While lookup tables make data entry easy, this
is only so if they are customised to your own practice. Add, edit and delete records in
all the lookup tables to suit the cases you regularly perform. See the section on Using
Access datasheets  for assistance on editing data in the lookup tables.

In most cases the labels Surgeon, Hospital and Operation will be appropriate and
these will initially be the default labels for new accounts. However, for a colonoscopy,
it may be more appropriate to refer to the surgeon as the Gastroenterologist. If the
account  is for a specialist consultation, a more appropriate label may be Cardiologist
or even Referred by. If this is the case, select the appropriate label from the drop-
down list on the left of the field.

Drop-down lists allow you
to change the descriptive
label for the surgeon,
hospital and operation
fields.

For any individual surgeon,
hospital or operation, a
specific designation may
be stored. So Dr Smith
may be a Psychiatrist, St
Elsewhere's may be a
Clinic and ECT treatment
may be a Procedure.

    

To edit the list of surgeon, hospital or operation labels, select the <Edit Lookup Table>
option at the bottom of the list. This will open the lookup table editing form.

The ability to modify the surgeon, hospital and operation labels allows these fields to
be used for any type of data. If you do this however, be aware that the data will always
be stored in the Surgeon, Operation and Hospital fields, and will be displayed as such
in lists and summary reports.

Additional details stored

You can optionally store the surgeon's and/or hospital's provider number. If you wish
this to be printed on the patient's account, click the relevant check box in the lookup
form before pressing OK. If you add the surgeon or hospital to the account by entering
his abbreviation or by selecting from the list, the provider number is automatically
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inserted if the check box is ticked.

You may also optionally store the surgeon's or hospital's contact details in the lookup
table to make it easy for you or your secretary to contact them regarding queries
about the account.

Why have an Operation field?

Even though the account will eventually have a detailed list of descriptive items, the
operation field is included here to provide a general title of the procedure that was
performed. This will assist in recognising the overall procedure and will be helpful if
the patient cannot understand the detailed list of items.

Hiding items from the account

If you don't wish to use the surgeon, hospital or operation fields on the account, simply
leave them blank.

2.4.2 Operation date and time

The operation date and
times should be entered for
all accounts. The times are
essential to calculate fees
using the RVG or DVA
system. If you prefer, you
can avoid showing the date
and times on the account by
clearing the associated
checkbox.

   

The operation date will be used as the default date of service when entering individual
items. Times should be entered in 24 hour format. When you enter an operation date,
if the date of birth was previously entered, the patient's age will be calculated
automatically.

If the operation date is changed from a previous date, you will be asked whether to
also update all the item dates to the new operation date (if items already exist in the
account). If a pre-anaesthetic consultation exists with a different date to the other
items, the difference in dates will be applied to the new date. That is, if the operation
date is changed from Jan 10 to Jan 20 and there was a pre-anaesthetic consult done
on Jan 9, the latter will be changed to Jan 19 and the other items to Jan 20. You will
be alerted to this change when it happens.

Referral date

The optional Referral date will appear on the right hand side of the account above the
operation date and time details. If the Show times ... checkbox is cleared, the referral
date will still appear on the account. If you don't want the referral date to appear, leave
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it blank.

Date and time shortcuts

The following shortcuts are available when entering the operation date and times. A
View shortcuts button is provided on the Operation screen for quick reference. In
addition, a button is provided to guide the user as to whether the times entered would
be eligible for the after hours emergency modifier.

Date field Time fields

t Inserts today's date.
p Inserts operation date

from previous patient.
+ Increments the date by

one day.

- Returns the date to the
previous day.

p Inserts the stop time from the previous patient
into the start time. This is intended to be used
when one procedure starts at the end of the
previous one.

+ Adds 5 minutes. If the stop time is blank, the +
key will insert the start time into the stop time
field to allow for rapid incrementing of the stop
time without directly entering any numbers.

- Subtracts 5 minutes.

2.4.3 Copying from another account

Two buttons are provided on the top of the Operation page to copy details from a
previous operation. This function is designed to streamline the data entry process for
standard anaesthetic procedures. The function is only available before the account is
sent, that is, while it's Account date is still blank. This is to prevent inadvertent
overwriting of existing data.

The Quick Copy function

Click the Quick copy button on the top of the Operation page to perform this function.
This will copy the surgeon, hospital, operation and operation date from the previous
account. These fields will be copied, irrespective of which checkboxes are ticked in
the Options form (see below). No item or fee details will be copied.

The Detailed Copy function

Click the larger button to open the following copying window.
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The first account displayed is that with the account number immediately before the
current one. This allows easy entry of multiple accounts when several similar
procedures are done in a list. Simply click the Copy button and go back to the account
to check to see whether any minor alterations are necessary.

If you want to copy details from an account other than the previously-entered account,
select another account from the list in the Previous patient field. These are displayed
in reverse order of their account numbers. If you wish you may reorder the list
according to the patient's surname, the operation performed or the account type by
clicking the small Name, Oper or Type buttons. The latter function enables you to find
a particular type of operation easily.

You can also specify a particular account number to copy from by entering it into the
appropriate field.

What will be copied?

The function will copy the operation, all the MBS, RVG and/or DVA items, account and
fee type, actual fee and discount details. It will insert an RVG time item and age
modifier if appropriate and will also automatically perform a check for multiple items.
The final fee will not necessarily be the same as the account copied from if it is a time-
based fee.

The surgeon, hospital and operation date will also be copied if these are specified in
the system Options as fields which should be copied. Go to the Automatic functions
page  in the Options form to set these preferences.

RVG modifiers are not copied. This is to avoid inadvertently putting modifiers on
accounts which should not have them.
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Note on copying the operation date

You should set this function to copy the operation date when you are entering a list of
procedures which were all done on the same day e.g. a list of colonoscopies. If you
normally use the copy function to copy a procedure which was probably done on
another day e.g. Mitral valve replacement, set the function to not copy the date, and
just insert the date manually after you have copied the rest of the details.

If you have set the copy operation function so that the operation date is also copied,
all the item dates are also copied and no message about the dates is given. If you do
not copy the operation date, any operation date already entered into the current
patient's account is copied to the items. If no operation date exists in the current
account, all item dates will be blank. They can then all be easily updated at once by
entering an operation date. Messages are only given if the operation date itself is
directly changed.

Important note on modified items and values

Since the MBS and RVG schedules are regularly updated, the item descriptions and
their unit values and fees in particular will change over time. If you copy the details
from a patient whose account was created with a certain version of the MBS or RVG
books or when the item value was different to the current one, the details will not
necessarily be correct according to the current book version and item value. To
ensure accuracy with the current MBS or RVG version, go to each item in the account
which has been copied from another patient, and click the Update item from book
button. This will find the up-to-date details from the relevant book and correct the fee
to be in line with the current unit value. This is only necessary if you believe the copied
account was created using a previous version of the items book or the health fund
fees table.

Hint! You may like to create a few fictitious accounts with standard operation
details. These could then be called up any time you wanted to insert the
details of standard operations. You will locate them more easily if you
name them carefully, for example, set their surname to 'A1-Standard
Caesar' or 'A2-Long Radical Prostate' and they will appear at the top of
the list when you sort by Name. This may be easier than looking down
the list of operations and choosing one you think has the correct details.
(BUT, remember not to send the fictitious patients any reminders! And
consider their implications in any summary reports you may create.)
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3
Accounts - Entering Items

C H A P T E R

The item details screen is used to enter all procedural information and is the most
complex part of the system. There are three tabs to identify the separate sections.

·The blue MBS section is used for all Medicare type accounts, including the new
RVG items, and for health fund accounts. Most accounts will use this section.

·The green ASA RVG section uses the ASA's RVG schedule and is used mainly
for third party (TP), worker's compensation (WC) or overseas patient accounts. It
uses item numbers such as CA010 or CG850.

·The purple DVA section is used for the Veterans' Affairs time-based system of
billing. It is not used for billing the DVA using the standard MBS methods.

Many of the data entry features of the MBS section are common to the RVG and DVA
sections. The common features will be included in the MBS section while the
differences will be discussed separately in the RVG and DVA sections.
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3.1 MBS items (blue)

Items are added one to each row until all required items have been added. The
bottom row is always blank; this is where new items are added.

3.1.1 How to add items

This section will describe how to add items using the blue MBS screen. Entering items
into the other sections is essentially the same, as described in the ASA RVG  or
DVA  sections. It is possible to add items to more than one section. However,
depending upon the type of fee you select, only one list of items (either MBS, RVG or
DVA) will be shown on the account.

There are 3 methods to add items to the account:

· Type a known item number into the anaesthetic item column and press enter.
The details will be inserted from the relevant book. This is the quickest method if
you know the numbers.

· Open the MBS or RVG book  by clicking the appropriate button and click the
Add button when you have located the correct item. This is ideal if you need to
search for a particular item.

· Select an item from the Quick Items  or Modifiers  list. You can store
commonly used items in the Quick Items list.

In each case, the item number is inserted, with the matching unit value, procedure
description and MBS schedule fee. The item date and description can be further
edited, but the unit value and fee cannot. When you add the first Anaesthesia for ...
item, a time item will be inserted automatically, and if appropriate, an age modifier will
also be entered. See the RVG anaesthesia  section for more details.
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Note Only MBS items should be inserted into the MBS or DVA sections and
only ASA RVG items should be inserted into the RVG section.

Item dates

The default item date is the operation date which is entered on the Operation
page . If you need to, adjust the date manually or use the popup calendar by double
clicking on the date field. Click the + or - buttons in the Date column heading to
increment the selected date by a day or use the + and - keys on the keyboard for the
same effect when the cursor is in the date field. If the operation date is modified, all
the item dates will also be modified, after an appropriate warning is given.

The surgical item column

Prior to the incorporation of the RVG schedule into the MBS schedule (Nov 2001), it
was necessary to include surgical item numbers and their associated anaesthetic
value. The S.Item column still exists for backward compatibility but has been disabled
when using MBS books of November 2001 or later.

3.1.2 Procedure description

The description of each item can be edited directly on the screen. It is wise to edit the
descriptions to simplify them as some of the default MBS descriptions are rather
wordy. Any such modifications will appear only on the current account and the next
time that item is entered into a new account, the original default description will be
inserted. Custom descriptions for each item can easily be set up in the MBS or RVG
book  so that your own specific description will appear when an item number is
entered.

Adding item 'Subitems'

It is possible to set up multiple descriptions for a single item number and these can be
selected using a subitem code. These are described in the MBS/RVG book
section. Add subitems directly to the account by entering the item number and
subitem code into the item number column.

For example, if you have a subitem called CVP for item 22012 (Blood pressure
monitoring - central venous), enter 22012CVP into the item number field. The
appropriate details will be inserted into the account. If you enter 22012 without the
CVP code, the default MBS description (or your default custom description for item
22012) would be added instead.

Note that although you enter the item number and subitem code (22012CVP), only the
item number itself (22012) is stored in the database and printed on the account.

Update item from book

The button Update item from book will re-insert the unit, description and fee details for
that item as currently stored in the MBS or RVG book. If you have stored a custom
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description, this will be inserted rather than the book's own description. If the item was
originally added using a subitem, the subitem code will not be added and only the
details from the original parent item will be inserted. If the version of the items book
currently in use is different to that which was in use when the item was originally
inserted, the unit values, description and fee may be different.

3.1.3 Multiple anaesthetic procedures

Using the RVG system, each account can only include one Anaesthesia for ... item
which will attract a rebate. Consequently, any other Anaesthesia for … items which
you add to the account will have their fee automatically reset to zero. The anaesthesia
item with the highest unit value will be used for the fee determination. This differs from
the pre-RVG system where the second item was discounted to 20% and subsequent
items to 10% of their original value. This multiple anaesthesia rule is performed
automatically and the account items will appear as follows.

There is no prolonged anaesthesia rule as there was with the previous rebate system
(pre Nov 2001) since the RVG method of time-based items manages this intrinsically.

3.1.4 Adding time items

The appropriate RVG time item is added automatically to any account which uses
RVG billing when the first RVG item is added. This assumes that the date and times
for the operation have been entered on the Operation page. If the operation times are
modified, the time item is updated automatically. The time item will not be added to
the account if there are no RVG type anaesthesia items on the account which attract a
time component. See the RVG anaesthesia  section for more details.

It is possible to add a time item to an account by entering a specific item number in
the range 23010 to 24136. This is not necessary however, and could result in
accidentally adding multiple or incorrect items to the account. There is a button
labelled Update time item which may be used to manually insert/update the time item.
The button is unlikely to be needed, but is provided in case the item is not updated
correctly when the date or time information is modified. This will also remove any
multiple or incorrect time items.

Perfusion Item

If a perfusion item (22060, CV060, A006, A007) is entered onto the account, the time
item is automatically shown as Perfusion time instead of Anaesthesia time for MBS,
RVG and DVA account types. If a perfusion item is added after the time item is
inserted, Perfusion time is not inserted automatically, and you should click the Update
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time item button to update the description appropriately. This feature was inserted
since HIC staff sometimes mistakenly believed that both perfusion and anaesthesia
services were being claimed on one account.

3.1.5 Adding modifiers

Enter modifiers by choosing from the drop down Modifiers list located on the items
page. We recommend that you do not enter modifiers by typing the item numbers
directly into the A.Item column or by adding them from the MBS book. This is because
some need to be specifically checked for duplications, or require specific fees to be
calculated.

The age modifier is usually added to the account automatically where appropriate. It
may also be added or removed if the date of birth or operation date is changed.
However, in some cases this may not happen and it can also be added manually from
the Modifiers list if required.

After hours emergency modifier

Add the 50% modifier by selecting it from the Modifiers list on the items page. The fee
attached to the item will be calculated as 50% of the total of the fees which are
currently on the account. If your account includes this modifier, the fee will be updated
appropriately whenever the procedure times are changed or items are added to or
deleted from the items list. (Note: The 50% calculation only applies to items which
form part of an RVG anaesthesia service  and will not apply to pre- or post-
operative consultations.)

Note This modifier can only be used for after hours emergency procedures,
not for elective procedures performed after hours. In contrast, the
standard M2 emergency modifier can be used for emergencies at any
time.

There is a button on the Operation page which will assess whether or not
the times specified are eligible for the after hours emergency modifier.
This modifier is not added automatically to the system because the
requirement for the procedure be of an emergency nature can only be
manually specified.
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3.1.6 What is an RVG Anaesthesia Service?

The ASA's Relative Value Guide was incorporated into the Medicare schedule in the
November 2001 edition. With this came a new set of rules for adding items to
accounts. In particular, each account requires:

· an Anaesthesia for ... item such as 'Anaesthesia for hip replacement'
· a time item
· optional modifiers such as the age or physical status modifiers

Additional procedures such as a preanaesthetic consultation or intravascular
monitoring may be added to the account, although these do not technically form part
of the RVG anaesthesia service.

The details of exactly what needs to appear on the account are described in detail
elsewhere, such as in the documents produced by the ASA and the Health Insurance
Commission.

Enter an Anaesthesia for … item

Each account for an anaesthetic service must have at least one basic item in the
range 20100 to 21997. To enter these items on your accounts, use the standard
methods for entering any MBS item. That is, type in an item number (into the A.Item
field), choose an item from the MBS book, or select one of the options from the Quick
Items list (you may need to set this up with the new RVG items).

Add any other Anaesthesia for … items which are relevant. The fee for all but one of
these will be automatically reset to zero since only the anaesthesia item with the
highest unit value will be used for the fee determination. This differs from the pre-RVG
MBS system where the second item was discounted to 20% and subsequent items to
10% of their original value.

Item descriptions

The Health Insurance Commission (HIC) recommends that you abbreviate the item
description that you put on your account so that only a brief one line phrase is shown.
This can be done by creating your own description  in the MBS book, or by editing
the description directly on the account's Items page. If you require more than one
description for a single item number, create a Subitem code  in the MBS book.

The time item

You must enter the start and stop times of each anaesthetic service. Although the
actual times are only required to appear on the account if you are claiming an after
hours loading, Access Anaesthetics calculates the anaesthetic time and number of
units from the start and stop times. If you don't know the times, enter estimated times
which evaluate to the time you spent on the procedure.

When you enter the first Anaesthesia for.. item on the account, the time item is
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entered automatically. If you have not already entered the start and stop times, go
back and enter these and a time item will be entered. If you subsequently change the
start or stop times, the time item will be updated to reflect the change.

It is possible to create an account without a time item. This would happen if you
perform procedures which do not form part of an RVG anaesthesia service. However,
an account for an RVG anaesthesia service must have both an anaesthesia item and
a time item, otherwise Medicare will reject the claim.

Because anaesthesia rebates are now calculated using actual, as opposed to
estimated times, the prolonged anaesthesia rule no longer applies. The button which
operates this function still remains in the system for backward compatibility. However,
it will only perform the calculation correctly if a pre-November 2001 items file is
attached to the system.

Entering modifiers

Modifiers can only be added to accounts which include an RVG anaesthesia service
since they 'modify' the RVG anaesthesia service. The following notes should be
considered.

· The age modifier (25015) is for patients aged less than 12 months, or 70 years
or greater.

· The emergency modifier (25020) can be used for either in-hours or out-of-hours
procedures.

· The after hours emergency modifiers (25025, 25030, 25050) can only be used
for after hours emergency procedures.

· The emergency modifier and the after hours emergency modifiers cannot both
be used on one account.

· The modifiers for prone position, morbid obesity and 3rd trimester of pregnancy
exist only in the ASA's RVG schedule and cannot be used on MBS type
accounts.

What constitutes After hours?

The after hours period is time spent before 8am, after 8pm and at any time on
weekends or public holidays. For an account to attract the 50% after hours modifier, at
least half of the time for the procedure must be in the after hours period. Also, the
procedure must be an emergency. Elective after hours procedures do not attract the
modifier.

After entering the start and stop times on the account, click the
eligibility button to assess whether or not the times are eligible
for the after hours emergency modifier.     

This modifier is not added automatically to the system because the requirement for
the procedure be of an emergency nature can only be manually specified.

Note The definition of after-hours is different in the ASA RVG - 6pm to 8am.
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Anaesthetic 'Extras'

The MBS schedule has always, and still contains a set of items for monitoring,
transfusions, cannulations and similar anaesthetic extras. These are mostly in the
group T1 - Miscellaneous Therapeutic Procedures with item numbers between 13020
and 14224. Similar items have been included in the new RVG listing (20000-30000)
which duplicate the original items. The latter items should be used only when
performed in association with the administration of anaesthesia. This means, only in
conjunction with an RVG type anaesthetic service. This would apply to most standard
anaesthetic procedures. If a procedure is performed not in association with an RVG
anaesthetic service, the original item numbers in group T1 should be used for the
anaesthetic extras.

Ordering items on the account

The Health Insurance Commission has published their preferences for the order in
which items should appear on RVG type accounts. Generally speaking, Access
Anaesthetics follows this pattern if you use the Auto Order function. Under some
circumstances, the order will be slightly different to the HIC recommendations, but the
differences are usually cosmetic only, for example, the order of modifiers may be
different. The main principle is that all the items related to one instance of an RVG
anaesthesia service are listed together on the account.

If you would like the Auto Order function to operate automatically when items are
entered, you can set this up in the system Options. Go to the Automatic Functions
page and tick the checkbox which sets the auto order function to be done after the
prolonged anaesthesia rule. Although the latter rule no longer applies, this check box
needs to be ticked.

3.1.7 The old MBS system

This worked by having all items defined by a surgical item number. There were no
separate items for anaesthesia. Instead, each surgical procedure had a separate
anaesthetic unit value which determined the fee for the anaesthetic service. Each
anaesthetic unit had a rebateable value. The anaesthetic fee was therefore tied to the
surgical procedure and would be determined not by what the anaesthetist did, but by
what the surgeon did. Both surgical and anaesthetic item numbers were required on
accounts.

Access Anaesthetics operated under this system until it was superseded by the
incorporation of the RVG into the Medicare schedule in November 2001. However, the
system remains backward compatible, and can be forced to run using the earlier
methods by attaching a pre-November 2001 items file. Do this from the File
Management Menu . The surgical item column still exists on the Items page, but it
is disabled unless a pre-RVG items file is attached.

The old Multiple Anaesthetic rule deemed that a second surgical procedure was
discounted to 20% of its original fee, and the third and subsequent procedures were
discounted to 10%. In the new system, the second and later anaesthetic procedures
are discounted to 0%, since the time-based system compensates for additional work.
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Also, because anaesthesia rebates are now calculated using actual, as opposed to
estimated times, the prolonged anaesthesia rule no longer applies. The button which
operates this function still remains in the system to allow backward compatibility.
However, it will only perform the calculation correctly if a pre-November 2001 items
file is attached to the system.

3.1.8 Derived fees

There are only a few items of interest to anaesthetists which use a derived fee. These
include the after hours epidural and the anaesthesia assistance items.

Anaesthesia assistance items

These (25200 & 25205) are considered by the HIC to be derived fees. This appears to
be an oversight since, in fact, there is no difference between the anaesthesia
assistance items and any other Anaesthesia for ... items. All have a base unit value,
and are used in conjunction with time and modifier units. However, there have been
instances when the HIC has rejected claims where the assistance items have been
shown on accounts in the normal way. The health funds also treat these as derived
fees, often assigning a percent of MBS method to their calculation, rather than
specifying a base fee. To clarify this point, the following are the two methods of
displaying the anaesthesia assistance item on accounts.

Standard method:

Derived fee method:

To display the derived fee, first add all relevant RVG items to the account, the base
item, time item and any modifiers. Select a health fund or My Own fee if you wish.
Then click the Derived fee button below the item list. Once the derived fee is created,
it cannot be reversed except by deleting the derived fee item and re-entering the
original base, time and modifier items.

When the RVG was first incorporated into the MBS schedule, there were some other
items which were also treated as derived. In particular, item 22060 (whole body
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perfusion) was not rebated appropriately unless shown as a derived fee. The HIC has
now modified this item to behave in the same way as standard Anaesthesia for ...
items.

Epidural Anaesthesia

The items for epidural anaesthesia which extends beyond one hour of attendance are
treated as derived fees. For example, an epidural which requires attendance of 90
minutes is paid as item 18216 (first 60 min, $153.95), plus 2 times item 18219 (2 x 15
min, 2 x $15.45). Rather than showing these as 3 separate items, Access
Anaesthetics calculates the appropriate total fee from the start and stop times entered
into the account and displays these as a single item 18219. To use this method,
simply enter item 18219 onto the account. You should not also include item 18216 on
the account and, in fact, it will be removed from the account if it exists. The same
process should be used for the after hours epidural items 18226 and 18227. Only one
of the following items should appear on any account.

Note These examples use fees from the November 2002 MBS fee schedule.

3.1.9 The quick item list

Just above the first item on the Items page is a dropdown list labelled Quick items.
This is a streamlined method of inserting items onto the account without having to
open the MBS or RVG book and without having to remember the item number.
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Simply click the down arrow to open the list, then click the item you want to add to the
account. The Quick Item List is intended to be used for common procedures such as
blood transfusions, pressure monitoring, line insertions and other anaesthetic extras.
However, any other procedure may be added to the list.

There are 3 methods of adding items to the Quick list:

· Click the Save to quick list button when the cursor is in the row
for the item you wish to save to the list. You will be asked to
enter a brief name to identify the item e.g. Long premed, CVP
insertion.

   

· While using the MBS or RVG book, locate the item you wish to add to the Quick
list and press the Add to quick list button. As above, you will be asked to supply
a brief name for the item.

· You can manually edit the entire list of quick items by selecting <EDIT LOOKUP
LIST> from the list itself. This will open the following form.

This lookup table allows you to edit Quick Items and Quick Notes. There are separate
lists for the MBS, RVG and DVA tabs of the Items page. Click the appropriate
combination of Display and Item Type buttons to show the various lists. The
QuickName is what identifies the item in the dropdown list. The ItemNumber is the
actual item number from the MBS or RVG book. This can include a subitem number
as well.

Although you can add items to the quick list using this form, in practice it will be easier
to add items using either of the other 2 methods. This method is best used for making
minor adjustments such as adding subitem codes or deleting items you no longer
require in the list.
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Note The Save to quick list button on the Items page will not save subitem
codes since they are removed after the item is inserted. To save subitem
codes, add the item from the MBS or RVG book, or edit the item number
directly using the table method above.

3.1.10 Free text and the quick note list

The rows on the Items page can be used to enter free text as well as specific items.
You may for example:

· type your own procedure descriptions into any row
· insert blank rows to separate particular items
· enter comments such as Separate attendance, above or below a particular item
· enter any comments you wish to give to MBS or DVA staff or to the patient

regarding the account

For free text entry, under some circumstances it may be best to switch off the
automatic item entry. That is the function which inserts the item description and fee
when you enter the item number. You can turn this on or off in the Automatic functions
page of the Options form. This can be done dynamically, that is, turn it off, make your
changes to the account, then turn it back on again.

Note The total MBS schedule fee for the account is calculated by adding the
individual item fees. These fees cannot be individually modified except as
specified here . Therefore, entering items as free text may result in an
inaccurate total MBS schedule fee.

The Quick Notes list allows quick entry of notes in the same way as the Quick Items
list . Select a note from the list to insert it into the account. The list is editable in the
same way as the quick items list by selecting <EDIT LOOKUP LIST> from the list
itself. Add notes to the list by clicking the Save to quick list button on the bottom left. If
the cursor is in a row containing an item number, the item will be saved to the Quick
item list. If it has no item number, it will be saved to the Quick notes list.

The Auto Order function  will place all items without a date at the bottom of the list,
including quick notes. You may need to adjust the ordering codes to suit.

3.1.11 Ordering of items

Items added to the Items page are automatically ordered in a built-in sequence.
Similar rules are used for ordering the MBS, ASA RVG and DVA item lists. All items
on one date will be listed prior to any items on a later date. Items with no date will be
placed at the bottom. Within each date, items are ordered as follows:

1. Preanaesthetic consultation
2. Anaesthesia for... items or Whole body perfusion item, in descending order of

unit value
3. Time item
4. Physical status modifiers
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5. Other modifier items in ascending order of item number (except after hours
emergency)

6. Any additional items such as pressure monitoring and line insertions, in
ascending order of item number

7. After hours emergency modifier

The ordering function inserts a number into the leftmost ordering column labelled #.
You can customise the order by changing the numbers in the ordering column. Simply
type in a new number and the list will be reordered. Click the title of this column (#) to
remove all the order codes to start afresh. You should add all the items to the account
before adjusting the ordering codes since adding a new item later will activate the
AutoOrder function and reset the items to the default order.

If you wish, automatic ordering can be turned off in the Options form (Automatic
functions  page). If you do this, you can still activate the automatic ordering function
for a particular account by clicking the Auto order button on the Items page.

3.1.12 Grouping identical items

This function was designed mainly for the pre-RVG era where it was necessary to
include surgical items on anaesthetic accounts. For some procedures many instances
of a single surgical item were performed, for example, an item for repair to a finger
where 2 fingers were repaired. In extensive cases there may have been 10 or more
identical procedures performed. These all needed to be added to the account as
separate items so that the multiple/prolonged anaesthetic rule could calculate the
appropriate fee. The standard printed account would end up being very long and
repetitive for such an operation.

The alternative was to change the formatting of the item list when it was printed. To do
this, the checkbox labelled Don't show duplicated items … on the patient's Format
page  was ticked. This groups the identical items on the printed account so that
each item is only listed once, and a note is added indicating that the item was
performed x number of times.

When using the grouped identical items format, the ordering of the items is
maintained provided that all identical items are given the same ordering code. If for
example you have one premed item, 5 finger correction items, 3 toe correction items
and 1 blood transfusion item, the order codes should be 1,2,2,2,2,2,3,3,3,4. If the
order codes are entered as 1,2,3,4,5,6,7,8,9,10 they will all be treated as separate
items and will not be grouped. It may simply require a bit of trial and error, previewing
the account and making changes until the account is formatted according to your
preference.

Note Because the grouping function requires a separate reporting format to
the standard account, the grouping option is not available when printing
in batch mode from the List of Accounts screen. Even if the grouping
option is ticked on the account's Format page, printing the account from
the List of Accounts screen will ignore the grouping request and print
each of the multiple items individually. You must print the account
separately from the Account Details screen to implement the grouping
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function.

3.1.13 Copying items

In some cases, particularly in the pre-RVG era, it is necessary to insert several
instances of the one item on an account. To do this quickly, there is a hidden function
activated by double clicking on the anaesthetic item number. This will ask for the
number of duplicates required and then insert them onto the items page.

3.1.14 The (hidden) item editing window

In most cases, the only part of an individual item which you need to edit is the
description, since the item number, unit value and fee are all fixed as specified within
the MBS or RVG book. That said, it is possible to edit all the item details for the rare
instance where the unit value or fee of an item needs to be edited directly. For
example, when using the RVG item CU999 for an unlisted procedure, a specific unit
value and fee can be inserted.

There is no button to activate this function; rather it is
opened by double clicking on the Fee column for any
existing item. This will open a popup window which displays
all the data stored for an individual item. Click the Edit
button in the window to enable editing.

    

The editing window provides basic functions only, and caution is advised since there
are no data verification or calculation procedures built into this window. Modifying data
in this window will not affect the data stored in the MBS or RVG schedule books.
Editing data here only affects the current item on the current account.
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3.2 The ASA RVG schedule (green)

Use this green section of the Items page when you want to generate your account
based upon the ASA's RVG schedule. Here you would insert item numbers such as
those shown below. In 2003, the main use of this RVG schedule is for sending
accounts to Workers Compensation or Third Party insurers, since these groups will
recognize the original RVG schedule. Prior to Nov 2001, this schedule was also used
by a lot of anaesthetists as their standard method of billing, since the RVG had not yet
been incorporated into the MBS schedule.

Add items to this page in the same way as you would for the MBS page . That is,
enter an item number into the A.Item column, select an item from the Quick Items
list, or open the RVG book  and add items directly from there. When you first add
an Anaesthesia for ... item, a time item will also be inserted. Note that there are no
individually-specified time items in the RVG schedule and that the item shown on the
account is descriptive only.
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An age modifier may be added automatically if appropriate. This will only happen if
there is a time-attracting item on the account.

Like the time item, the RVG modifiers do not actually exist as items in the RVG
schedule. Consequently they cannot be added from the RVG book. Instead, like the
MBS page, add modifiers from the drop-down Modifiers list just to the right of the
Quick Items list. The ASA RVG has a number of modifiers which are not recognised
by the MBS schedule, but all modifiers can be added in the same way.

The fee calculations for the RVG section are performed differently to those for the
MBS. Since all items in the schedule have a unit value (in the MBS, some have a
dollar value), the fee is calculated by adding up the total number of units and
multiplying by your chosen unit value. The individual item fees shown on this page are
calculated as such because the RVG unit value for this example account has been set
at $30. The rate for this account is set on the Fee page , and you can set the
default for all new accounts on the Unit and Time Values page  of the Options form.

The total fee is calculated by multiplying the total units by the unit value, not by adding
up the individual item fees. For example, the RVG time item is not used in calculating
the fee; its use is purely for displaying the details on the account. More details on
using the ASA's RVG schedule are given in the Accounts - Fees  chapter.

For details on the other functions on this page see the relevant sections describing the
MBS schedule methods.

Create RVG items from MBS items

Click this button to create a list of RVG items based upon the
MBS items entered on the blue MBS page. This function
works by using a list of links between RVG items and MBS
items. The links are built into the system as described in the
section on the MBS book .    

This process was designed for the pre - Nov 2001 era when there were no built-in
links between the two schedules and the individual anaesthetist had to generate his
own list of links. Use this linking process with caution. Because the two schedules
don't match exactly, it is important that you check the RVG items added to the
account, since they may not always convert in exactly the way you expect.

The MBS to RVG conversion does not support the use of Subitems. If you have an
MBS item which was inserted as a subitem, when converted, the RVG equivalent of
the parent MBS item number will be inserted. This is because the subitems are used
only when entering the data, but are not stored in the individual accounts.

When the Create RVG from MBS button is pressed, the system looks to see whether
each MBS item has an associated RVG item number. If it does, that RVG item is
inserted into the account. If it doesn't, you are asked to enter an RVG item number to
associate with the MBS item number. This item is then added to the account and the
association is saved so that the next time that particular MBS item is used, the system
will automatically insert the associated RVG item. However, since the links are stored
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in the MBS items file, those which you have specifically added will be lost when
upgrading to a new version of the MBS book.

Fee calculation note in the Quick Note list

While on the RVG items page, select Fee calculation in
the Quick Note list to insert a description of how the total
fee was calculated. This will be updated whenever the fee
is changed. This is just a descriptive item and does not
affect the way the fee is calculated.

    

The fee note for the
above example
looks like this.    

3.3 The DVA schedule (purple)

Anaesthetists may elect to be remunerated by the Department of Veterans' Affairs
(DVA) using either the MBS method or the DVA Time-based method. If using the MBS
method, items should be added to the blue MBS page of the Items screen, in the
same way as any other account. If using the time-based method, items should be
added using the purple DVA section as described here.

Standard DVA Item Numbers

The DVA has a set of item numbers for their time-based procedures as follows:

A001 Anaesthesia for surgery (time based)

A002 Anaesthesia for surgery (time based) - emergency

A004 Assisting anaesthetists (time based)

A005 Assisting anaesthetists (time based) - emergency

A006 Perfusion (time based)

A007 Perfusion (time based) - emergency
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One of these items should be used on all time-based accounts in place of the relevant
MBS/RVG item number. This simplifies creating DVA accounts since only one of
these items need be added to the account, instead of searching for the appropriate
Anaesthesia for … item in the MBS book. To use these items:

· Items A001 (anaesthesia), A004 (assistance), and A006 (perfusion) have been
added to the Quick item list on the DVA page. One of these should be used for
each DVA account. Add these from the Quick item list, or type the item into the
A.Item column as usual (a01 will be recognized as A001 etc). The emergency
items (A002, A005, A007) can't be added directly - see point 4 below.

· The calculated time for the procedure will be inserted automatically into the
A001, A004 or A006 procedure description.

· The time-based fee will be inserted as the fee for the above item. The fee is
actually calculated when the operation times are entered and are independent of
the process of adding the A001 item to the account (the item is for descriptive
purposes only). The calculation factors can be adjusted in the Unit and Time
values  section of the Options form.

· If required, the 25% and 50% loadings should be selected from the Emerg list
box. If selected, an appropriate description will be added to the A001, A004 or
A006 item, the item number will be changed to the emergency item number
(A002, A005, A007) and the fee will be adjusted to take the loading into account.

· The checkboxes previously used for the after hours loadings have been disabled
on the items page since the loadings are now selected from the list. They are left
visible however, for backward compatibility if used on previous accounts.

· There is no modifiers list for DVA accounts since these are not recognized by
the DVA time-based system.

Using Other Items

Additional items from the MBS book may be added to the DVA page in the same way
as they are added to the MBS page. These include preanaesthetic consultations and
extras such as intravascular monitoring. If using the after hours loadings, note that
these only apply to the time-based component of the fee, not to the other items.

Note also that the DVA time-based system does not support RVG-type billing. In
particular, RVG modifiers are invalid on time-based accounts. In Access Anaesthetics,
if items are added to the account which are not supported by the DVA i.e. 20000-
22000 (Anaesthesia for …), 22060 (perfusion) and 23000-25205 (Modifiers), they will
be allowed to appear, but their fees will be set to zero.

The image above shows a standard list of DVA time-based items using the after hours
loading. Note that the checkboxes on the top right of the screen are disabled; they
exist for backward compatibility only.
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Create DVA items from MBS Items

Click the Create from MBS - DVA button to create a list of
DVA items from existing MBS items. This function is useful if
you want to first create a set of MBS items (and hence
determine the MBS schedule fee), and you can then easily
use these to create a set of DVA time-based items.     

When using this function, if the 50% after hours modifier is used on the MBS list, the
25% after hours loading will be added to the DVA list. The 50% public holiday loading
can be added later if required. It is advisable to check the converted items to make
sure they are appropriate for your account.

3.4 Other schedules

.

3.4.1 Health fund fee schedules

Health fund no-gap fee schedules may be used wherever an account is made up of
MBS type items.

To use a health fund schedule:

1. Enter a list of MBS items on the Items page
as usual.

2. Select a health fund from the yellow drop-
down list on the Items page. The default for
new accounts is 'None'. The system will
search the relevant fund table and insert the
fee for each item alongside the standard MBS
fee. The fund fee is shown in a yellow box.
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3. Finally, go to the Fee page and select the Health Fund No-Gaps fee as
described in the Accounts - Fees  chapter. Depending on how you created
the account, this may have been selected automatically. If you wish to set a
patient co-payment when using a health fund fee, see the notes in the Health
Fund Fee  section.

Notes

· Once a fund fee is chosen from the drop-down list, any additional items added to
the account (by entering an item number or selecting from the MBS book) will
also be allocated the appropriate fund fee.

· You can return to the Items page at any time and choose an alternative fund or
choose None to revert to the MBS schedule fee.

· When sending an account to a third party (e.g. a health fund), the fund fee will
be inserted automatically if the third party address used on the Pt Addr page
has a specific fund name specified.

· Only a subset of MBS schedule items are included in the funds table (about 700
out of about 4500). The items included should cover all those likely to be used
by anaesthetists. In the event that an item number you wish to use does not
exist in the table, contact us so it can be added to a future version.

You can edit the list of health fund fees by clicking the edit button next to the health
fund drop down box. See the Health Fund Schedules  section for more details.

Hint Delete the funds you don't need to make the list box easier to use.

3.4.2 My Own fees

You may prefer to set your own fee for specific items rather
than use the MBS schedule fee, the health fund fees, or
the ASA RVG or DVA fees. To do this, click the My Own
Fee button on the Items page.     

This will open the dialog box shown below. There are a number of functions in this
dialog box. The main one is Apply this dollar value for each unit. Enter an amount into
the field and click the Go button. This will multiply the unit value for the item by the
amount specified and insert it into a new blue box on the item list as shown below.

You can set a default unit value in the Options form on the Unit and time values
page .

Time-based fees are described in the next section .
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The blue fees column is the My
Own Fee column. Amounts in
these fields can be directly edited
by clicking into them and typing
your preferred fee.

The fee for the top item
(preanaesthetic consultation)
shown here is zero. This is
because this item (17603) does
not have a unit value and therefore
a $ per unit calculation cannot be
performed.    

You should type your own specific fee into this field. Defaults for these 'non-unit' fees
can be specified in the MBS book .

After completing your own list of fees on the items page, go to the Fee page and click
the My Own Fee option to designate this as the fee to appear on the account.

Note When the MyOwnFee button is clicked on the items page, it will obtain its
value per unit first from any existing items in the items list, or if there are
none, from the MBS/RVG rate in the Options form, or if this is blank, from
the rate for one time unit from the MBS book.
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3.4.3 Custom time-based fees

The Department of Veterans' Affairs uses a system of time-based fees  to
remunerate anaesthetists. This allows for a set dollar value per hour for time spent
administering anaesthetics and this is independent of the Medicare or other fee
schedules. The Victorian Workcover Authority also offers a time-based system (as
well as a fee schedule system). Instead of using a specific process for the VicWC
method, Access Anaesthetics has a customisable system which will allow the creation
of any number of different time-based systems using different rates and time periods.

The Time-Based Schemes configuration form  can be opened from the Tools
menu  or from the My Own Fee dialog box . This will allow you to create and
customise your own time-based schedules. A scheme for the VicWC Time-engaged
method has already been set up.

Using a time-based scheme on your account

1. On the MBS tab of the
Items page, click the My
Own Fee button.

2. Select the preferred time-
based scheme from the
list labelled Insert time-
based item for.

   

This will perform the fee calculation and insert the appropriate item details onto the
account with the calculated fee inserted into the My Own Fee column.

3. Lastly, select the My Own Fee on the Fee page.

Note If the start or stop times of the procedure are changed, the time-based
item should be removed from the list and re-inserted, so that the fee is
recalculated. (The account does not keep track of how the fee was first
calculated and has to do it again from scratch.)
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4
Accounts - Fees & Format

C H A P T E R

After you have entered one or more items onto your account, the Fee page calculates
a number of fees based upon the information you have entered. You can then select a
fee from the options given, modify the fee, and optionally add a discount and GST.
The Account Type is determined from the fee you choose, and this in turn determines
the format of the account. Further customisation is then possible on the Format page.

4.1 Setting the fee

We recommended that you always start your account by inserting MBS items so that
a Medicare schedule fee can be calculated and approximate patient rebates
determined.

When items are added to or removed from the list of items on an account, the MBS
schedule fee, DVA fee and RVG item calculations are updated to reflect the change.
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The actual fee charged

Select one of the 6 radio buttons  to specify the fee you wish to charge (more
information below). If required, set a discount and GST. The large red-on-yellow Total
fee charged field on the bottom right is the fee which will appear on the account. The
expected MBS and standard private health fund rebates will be shown on the screen
(not the printed account) underneath the fee (for account types where patient rebates
are anticipated).

The default fee

The fee which is initially selected is most often the MBS schedule fee. The Account
type is determined by the fee selected according to the following scheme:

SF MBS schedule fee

SF+ above schedule fee

HCF Example health fund account type. The account
type is given the name of the health fund.

MyOwn My Own fee

RVG RVG using user-defined rate

TP RVG using TP rate

WC RVG using WC rate

DVA DVA time-based fee

If the fee selected is not the one you wish to charge, select your preferred fee after
making any adjustments as described in the individual fee type sections below.

In the following situations, the default fee will not be the MBS schedule fee:

· When a health fund fee is selected on the Items page, if the account is currently
deemed an SF account, the fee will automatically be changed to the health fund
fee. If the fund fee is turned off on the Items page when this is the fee on the
account, the account fee will revert to the MBS schedule fee (SF).

· When the MyOwnFee button is clicked on the Items page, if the account is
currently deemed an SF account, the fee will automatically be changed to the
MyOwn fee. If MyOwn fee is turned off on the Items page when this is the fee on
the account, the account fee will revert to the MBS SF.

· When the first item is added to the RVG or DVA tab on the Items page, if there
are no other items on the account, the fee is set automatically to the RVG or
DVA fee.  (TP or WC can then be selected on the Fee page if required.)
Removing all items from the RVG or DVA page when the fee is set to one of
these will cause the fee to revert to SF.

Notes

· The above items procedures will only set the account fee if it is currently set to
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the SF. If the fee has previously been set to anything other than the SF, the fee
will not be changed, and this can be done manually on the Fee page if
required.

· The account type is shown on the Items page for reference while manipulating
items, and a message is shown if the account type is changed automatically.

· When the Items page is opened, it automatically opens on the tab appropriate
to the fee type.

· Generally speaking, total fees are rounded to the nearest 5 cents.

4.1.1 MBS methods

MBS schedule fee

To select the Medicare Schedule fee as the fee to charge the patient, click the grey
button containing the schedule fee amount or check the associated radio button. The
grey button will turn blue, the associated radio button will be set and the schedule fee
will be inserted into the Fee charged field on the bottom right of the screen.

Above the schedule fee

Add a fixed percentage or dollar amount to the schedule fee by entering an
appropriate number in the % or $ boxes in the Sched Fee plus row. The percent box
has a convenient drop down list to select percentages in 5% increments, although you
can type any number directly into the box. When you specify one addition type (% or
$) the other will be calculated.

Alternatively enter a total fee into the Basic fee charged box and the percent and
dollar amounts above the schedule fee will be calculated automatically.
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Changes to fees when item details are modified

When items are added to or removed from the list of items for a particular account,
the MBS schedule fee, DVA fee and RVG item calculations are updated to reflect the
change. When an additional amount above the schedule fee has previously been
added to the account, the amount to be added remains the same and the percent is
recalculated, not vice versa. For example, suppose the schedule fee was $120 and
$30 (25%) was added to the account for a total of $150. If an item was added to the
account making the schedule fee up to $150, the total would be recalculated as $180
($150+$30), not as $187.50 ($150 + 25% of $150). The revised percent would be
recalculated as 20% (30/150). If you prefer to maintain the percent rather than the
amount, simply reset the percent to 25%. The same principles apply to the discount
calculation functions.

4.1.2 Health fund fees

If you have selected one of the health fund schedules on the Items page, the total fee
for this schedule is shown on the Fee page, along with the fund name, next to the
label Health fund 'no-gaps' fee. Click this fee or its radio button to select it as the
account fee.

This is an amount which is normally billed directly to a health fund. You can also set a
separate co-payment amount to charge the patient as described in the next section.

When you select a fee for a particular health fund, the account type will be given the
health fund code name. In this example the account type will be AXA_NSW.
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4.1.3 Fund co-payments

To send a separate account to a patient for whom you have already sent an account
to a health fund, enter the co-payment amount into the field just below the health fund
fee. Then, print the co-payment using the small print button next to the co-payment
amount. The standard print button on the bottom of the Account Details screen will
print the account for the health fund, while the Co-payment print button will print the
co-payment account for the patient. The co-payment account is the same as the
standard account, except that a customised message is shown in place of the items
list. The wording on the co-payment account can be modified on the Co-payments
page of the Options form.

The co-payment amount is added to the basic fee for the account, and together these
form the total fee. In the Total fee charged field, the total amount due for the entire
account is shown, with the breakdown between fund and co-payment shown below.
Summary features of the system use this total fee in calculations.

The co-payment is added after any discounts or GST are calculated. Consequently,
discounts and GST can be applied only to the fund component, not to the co-payment.

Using Co-payments with My Own Fee

If you wish to determine your total fee using a specific RVG unit value, you would
normally use the My Own Fee option described below. If you wish to break this
amount down to a fund fee and a patient co-payment, proceed as follows:

1. Create My Own Fee and select a health fund fee on the Items page.
2. Select the health fund fee on the Fee page.
3. Click the small button directly below the co-payment field on the Fee page,

and the difference between My Own Fee and the fund fee will be inserted as
the co-payment amount.
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4.1.4 My Own fee

Specify individual fees on
the Items page using the
My Own Fees methods.

Then click the MyOwn Fee
field on the Fee page or its
associated radio button to
specify this as the Total Fee
Charged.

   

The account type will be deemed MyOwn
unless you have specified a particular
account type on the Items page. Here the
custom type Overseas has been entered.

          

This is the standard method of charging above the schedule fee where you do not
want to use the health fund or ASA RVG schedules.

4.1.5 ASA RVG methods

To use the ASA RVG method of setting the fee, you must first enter some appropriate
items on the green ASA RVG tab on the Items page. The summary details of the
resultant fee are shown on the fee page, and you can adjust the total fee by adjusting
the dollar value per RVG unit. Unlike the MBS RVG system, the ASA RVG system is
entirely based on units, so the total fee is always the product of the number of units
and the unit value.

You can specify default unit values in the Options form (Unit and time values page )
for RVG, TP or WC account types. Select one of the 3 radio buttons to use that unit
value in the calculation. If you are using the RVG type and wish to use a different unit
value, select the RVG unit value from the drop down list or type a number directly into
the Rate per unit field.

The total RVG value will be shown. Click the total to set it as the fee to be charged or
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click the radio button. It will turn green and will appear in the Total Fee charged field.
The difference between the MBS schedule fee and the RVG fee will be shown (MBS-
RVG gap). Note that this should be equivalent to the patient gap if the RVG fee is set
as the fee to be charged.

Note that for TP and WC accounts, you should choose the appropriate TP or WC
value. It is not sufficient to choose an RVG value which happens to be the same as
the TP or WC value since the account will be designated an RVG account rather than
a TP or WC account. This has implications for the format of the account, particularly
for whether MBS or RVG items are shown.

4.1.6 DVA time-based method

For MBS-based billing for Veterans' affairs patients, simply use the standard MBS
item and fee setting procedures.

For time-based billing, the fee will be calculated automatically and shown on the
bottom of the Fee page. Click the appropriate total amount button to set this as the
fee to be charged. It will turn purple and will appear in the Total Fee charged field.

Note DVA hourly rates can be specified in the system Options form on the
Item and time values page .

4.1.7 Discounts

The discount function is intended to be used to offer an incentive to the patient for
early payment. To offer a discount, specify a dollar amount or percent on the Fee
page, and this amount will be subtracted from the Basic fee charged. If you prefer,
enter the total discounted fee into the rightmost box on the same row, and the
discount percent and dollar amounts will be calculated automatically. The Total fee
charged will be adjusted accordingly (taking GST into account if necessary). Both the
discounted and non-discounted fees will be shown on the account along with the
explanatory message.

You may directly edit the explanatory message by clicking into the field. This will
modify the message for the current account only. The default message can be
modified on the Discounts page  of the Options form.
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For the discount to appear on the
account, the Apply/Remove checkbox
must be ticked. This feature means you
can remove the discount from a printed
account when appropriate, but still keep
a record that a discount was offered. If
you wish to remove the discount
information entirely, set the discount
percent to zero.

   

Automatic discount expiry function

When you apply a discount, an expiry date is inserted. The default number of days
until the expiry date can be set in the Options form, and the date can be adjusted for
each individual account. Then, each time the Access Anaesthetics is started, it
removes the discounts for any open account where the discount expiry date has
passed. It does this by simply unchecking the Apply/Remove box. The details of the
discount are retained and a note as to when it was removed is inserted into the
explanatory message field.
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If you change the expiry date, it should also be automatically changed in the
explanatory message if it exists there. An update button is also provided to assist in
changing the date manually if required.

Notes

· It it possible to have the automatic discount expiry function ignore accounts
which are part paid. This is specified in the Options form.

· If you do not want the discount to expire automatically, remove the expiry date.
Again, this can be customised in the Options form.

· When entering a payment for an account where the discount has expired, you
are given the option of reinstating the discount.

· On the Select menu , you can select accounts according to their discount
status.

4.1.8 GST

To add GST to an
account, tick the
Apply GST checkbox
on the Fee page after
having completed any
other item and fee
setting procedures.    

An amount equivalent to 10% of the Basic fee charged will be added, and the result
will be displayed as the Total fee charged. If a discount has been applied, the GST will
be calculated on the discounted fee.

There is no facility to add GST to individual items displayed on the account. If you
need to add GST to only part of the account fee, calculate the amount manually and
type it directly into the white box in the GST section on the Fee page.

The words TAX INVOICE will be shown on any account where GST has been
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charged. You can optionally show the words GST FREE on accounts which do not
have a GST component. Specify this in the Options form on the Miscellaneous
page .

Note Since most anaesthetists will never need to charge GST for their
services, the GST functions are initially disabled. They can be turned on
in the Options form.

4.2 Account format

Most of the settings on the Format page are inserted by default when the fee is
selected and do not normally need to be modified. The default settings are specified
on the Account format page  of the Options form. Additional customisation here on
the Format page will change the setting for the current account only, while changing
the settings in the Options form will change it for all accounts.

Account type

When you set the fee on the Fee page, the matching Account type is set
automatically. When a fund fee is specified for an account, the Account type is set to
the name of the fund. If My Own fee is chosen, the account type will be set either to
MyOwn, or to the custom account type you have specified on the Items page.

The Account type determines the default formatting options. If you change the
Account type manually, you will change the formatting options, but the fee chosen will
not be altered. We do not recommend that you do this, since if you later adjust the
fee, the account type will revert back to it's default setting without warning. The same
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goes for any individual changes you make to the formatting. You will find that if you go
back to the fee page and reselect the fee, the formatting will revert to the default for
that fee type. Consequently, we recommend that you leave the formatting changes
until you have completed any other modifications, and are ready to print the account.

4.2.1 Which items appear on the account

MBS vs RVG items? (Here, RVG items refer to the ASA
schedule of item numbers such as CA002.)

You can specify whether you want to print either the MBS or RVG items on the
account by ticking the appropriate checkbox. Only MBS or RVG items may be printed,
but not both. This is set according to the defaults for the type of fee you have chosen
although you may modify it independently here.

MBS items are shown by default for all account types except WC and TP. These
accounts show the RVG item numbers since the insurers normally pay accounts
according to this schedule. For RVG type accounts sent to private patients, it may be
preferable to show MBS items, since the patient requires these to obtain the
appropriate rebates from Medicare and the health funds. You can have this happen
automatically by ticking a checkbox in the Options form (Account format page ).

If you tick the appropriate box, a brief list of MBS items will be shown in addition to the
full list of RVG items, and vice versa. This assumes that both sets of items have been
entered into the account on the Items page .

DVA accounts show whatever items are on the DVA page. These may be specific
DVA time-based items or standard MBS items.

Which fields are printed on the account?

The settings for the various items to put on the account are taken from the Format
page  on the Options form. They may be adjusted here, or next to the actual data
fields themselves. There are a few exceptions.

· The operation date and start/stop times are shown on DVA, WC and TP
accounts irrespective of the default Options.

· The date of birth is shown on DVA accounts irrespective of the default Options.

Itemised fees

The default is to show itemised fees for all account types except SF+, where the total
fee will not equal the sum of the itemised fees.

Duplicated items

This function was designed for the pre-RVG schedule where an account may have
listed a large number of similar surgical items (e.g. 10 foot correction items). When
the checkbox is ticked, the account lists the duplicated items only once with the
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number of duplicates specified below the item. When unchecked, all identical items
are listed individually. This function requires that identical items are assigned identical
order codes. See the Items section (grouping)  for more details.

Note The layout of the fields on printed accounts is built into the system and
cannot be altered.

4.2.2 Account messages

Account messages

A message is printed on the bottom or each account with information about how the
fee was derived. The message text is determined by the Account Type, so that an SF
account will get the SF message and an HCF account will get the HCF message. The
messages are inserted automatically when the fee is set (or if the account type is later
modified on the Format page).

The message for an individual account can be modified by typing directly in the
Message field, or by selecting an alternative message from the drop down list. Note
that if you modify the message and later change the fee or account type, the default
message for that account type will be reinserted in place of your modified message.

Editing the messages list

You should review and modify the default messages for each account type to ensure
they are appropriate for your own practice. To do this, click the pencil button to the
right of the message field to open the editing window.

The following issues should be noted:
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· Standard messages are those which are printed below the items list on the
account and which are shown in the list box on the Format page. An additional
set of messages (related to payment issues such as overdue messages) are
printed below the standard message on receipts and reminders. See the Printing
reminders  section for details of these repeat messages.

· The MessageCode field identifies which message is inserted automatically into
the account. For Std messages this code is either MO, SF, SF+, RVG, WC, TP
or DVA, corresponding to these account types.

· For health fund accounts, the default message is that identified by the code
HFund. If you prefer to display a particular message for a particular health fund,
create a new message and give it the code which is the equivalent of the health
fund name. For example, to use a specific message for the AHSA_NSW fund,
create the message and give it the message code AHSA_NSW. Then whenever
you specify the AHSA_NSW fee type, the AHSA_NSW message will be
inserted. If you use a health fund fee for which there is no matching message
code, the message coded HFund will be inserted. No specific fund fee
messages have been created; it is up to the individual user to do this.

· When a My Own Fee is selected on the fee page, the message shown on the
account will be that listed under the code MyOwn in the messages list. You can
also create additional messages for custom account types. For example, if you
create a message with the code VicWCTime, this will be shown when the
account type is VicWCTime. If no message code matches the account type, the
default message for MyOwn will be shown.

· For Medicare only accounts, it is standard practice to charge the full MBS
schedule fee but to note that the Medicare rebate will be accepted as full
payment. In this case, select the SF fee on the Fee page, then select the MO
account type on the Format page and the MO message will be inserted.

· Any additional message you create yourself, with or without specific codes, can
be inserted into an account manually by selecting it from the drop down list.

4.2.3 Payment instructions

The payment instructions which appear on the bottom of printed accounts are defined
in the Options form . These are intended for individual patients since, generally
speaking, health funds and other institutions follow their own payment methods.
Consequently, by default, payment instructions do not appear on DVA, Third party or
Worker's Compensation accounts, health fund accounts or on patient co-payment
accounts .

If you want to show specific payment instructions for the co-payment account, these
should be entered into the co-payment message in the Options form. You can also
switch the payment instructions on or off for any individual account using the
checkbox on the Format page. However, they will not appear on accounts where the
fee has been paid in full, irrespective of the setting on the Format page.

Credit card and BPay details will appear whenever payment instructions are shown if
specified in the Options form.
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4.2.4 Provider designation

The provider designation may be
modified for individual accounts by
changing it on the Format page.
Changing it here only changes it for the
current account, while changing it in the
Options form (Provider page )
changes the default for all new
accounts.

   

In practice, you should set the designation in the Options form to that which you use
most of the time e.g. ANAESTHETIST. Then when you have an account where you
are wearing a different hat, e.g. CARDIAC ANAESTHETIST or PAEDIATRIC
ANAESTHETIST, you can select this for the individual account. This will not change
the default for new accounts and the next new account you create will have the default
designation as specified in the Options form.

163



5. .     >  

Copyright © 2003 HealthBase Pty Ltd 89

5
Accounts - Payments & Status

C H A P T E R

All payments are added to the Payments page of the Account details screen. These
include standard and batch payments, GST, discounted payments, fund payments
and patient co-payments. When payments are entered, the status of the account
changes and this can be followed on the Status page, Documents page and Notes
page.

5.1 Payments

All payments are added to the Payments page of the Account details screen.
Payments are entered into the lower section and the total amounts charged, received
and owing are shown at the top.
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5.1.1 Standard payments

Each standard payment is added to a separate row of the payments table. Add each
new payment to the bottom row of the table. (The ADD button simply positions the
cursor in the bottom row.) A receipt number is allocated automatically and the current
date is inserted by default as the receipt date. You can change the date if you need to.

Choose a payment type from
the drop-down list (cheque is
the default). This is an
important step since this
determines whether the
payment appears on a bank
deposit slip and whether a
banking date is inserted.

   

Enter details of the drawer, bank, branch and amount considering the data entry
issues discussed below.

If you select one of the payment types which are shown on the banking slip, the Date
banked should be left blank since it is set automatically when the payments are
printed on a banking slip. If you select E-Credit Card, EFT or Other, today's date will
be inserted as the date deposited (this can be edited). Do this for each payment.

Data entry considerations and the banking date

All fields (Payment type, Drawer, Bank and Branch) will accept free text typed into
them. Additionally, the following lookup tables will assist with commonly used entries.

The Drawer field is attached to an editable lookup table
which contains the drawer, bank and branch. Select a
drawer from the list or type in an abbreviation to have
the drawer, bank and branch inserted automatically.
Edit the entire list to add, edit and delete items in the
list, or to define abbreviations.

   

The Bank and Branch fields also have similar lookup tables to insert these details
separately. These do not support abbreviations. The bank and branch lookup tables
are self-updating. That is, if an unlisted item is type in, it is added to the list
automatically.

For cash transactions, simply select Cash as the payment type and enter the amount.

There are two types of credit card payment types, Credit card and E-Credit card. The
Credit card type is for use with a manual system where a physical credit card slip is
completed and included as an item deposited with other cheques to the bank. The E-
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Credit card is used where the transaction is processed electronically and does not
require a manual handover of paperwork to the bank. In this case, the banking date is
entered automatically when the payment is entered, and the transaction will not
appear on a banking slip.

If you specify either Credit card option as the payment type, enter the card type in the
drawer field. We recommend that you do not record card numbers in case the data
should fall into the wrong hands.

The EFT (electronic funds transfer) payment type is intended for use where payments
are credited directly to the doctor's bank account. This may happen, for example, with
payments from health funds where a payment advice slip is received from the fund
listing the date and amount of transactions which have already been credited to the
account. The additional types Direct Deposit and Eftpos may be more appropriate in
some circumstances, and these obey the same rules as the EFT type.

When a drawer is entered into a payment which is designated EFT, the cursor jumps
to the Amount field without entering any details into the Bank and Branch fields. This
occurs because normally an EFT payment is not associated with a particular bank or
branch. These can be entered if required by clicking into the relevant fields.

Any payment of type Other, or any payment of a type other than Cheque, Credit card,
Cash or Money Order will not appear on a bank deposit slip. However, if you wish to
force a payment to appear on a bank deposit slip, add the suffix -BD to the payment
type. For example, payments of type EFT would not normally appear on a deposit slip.
If you edit the EFT to read EFT-BD, that payment will appear on a deposit slip. This
allows any payment to be included on a deposit slip if required.

Shortcuts

Type 'p' into the Drawer field to insert the current patient's surname. The cursor will
jump to the beginning of the surname to allow you to enter the initials as they appear
on the cheque. This is handy for personal cheques when the initials on the cheque do
not match the patient's initials. If you just wish to show the surname only, simply hit
the ENTER key again.

Type "t" into the Drawer field to insert the surname of the third party addressee as
shown on the Patient Addr page.

Type 'b' into the Amount field to insert the current balance owing. This is handy when
entering a personal cheque for the balance after Medicare and fund payments have
been added or even for entering a cheque for the entire amount of the fee.

Missing data

Each payment requires a Payment date, a Drawer and an Amount. If these are not
entered you will be given a warning message. You may Retry the payment entry, or
Cancel. If you choose Cancel, the payment will be deleted.

Editing and deleting payments
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Once a payment has a Date banked, it is 'locked' and cannot be edited. This is
because if edited, the details stored in Access Anaesthetics will not necessarily match
the details held at the bank. However, there are circumstances where a banked
payment needs to be edited.

To do this, click anywhere in the payment to be edited,
then click the Unlock button labelled with the key icon.
This will allow the selected payment to be edited.    

Unbanked payments can be deleted using the Delete button, after a warning prompt is
given. Banked payments can also be deleted after a louder than usual warning is
given with an option to cancel the deletion. If you go ahead with the deletion, the
details of the deleted payment will be stored in a separate table of Deleted payments,
which can be viewed (but not edited) from the List of Payments  screen. The main
purpose of this deletion function is to allow the user to manage a bounced cheque. It
is expected that you would not otherwise delete a banked payment.

5.1.2 GST

When the GST functions are enabled (Options, Misc page ) an additional GST
column is shown on the Payments page.

The amount of GST to be entered is the amount which is
included in the payment. That is, the payment Amount should be
the total received, including the GST amount. The image here
shows a total payment of $110 including $10 GST.    

Also note that ...

· When adding payments to an account where GST is charged, when each
amount is entered, one eleventh of this will be automatically inserted as the
amount of GST included in this payment. The figure can then be manually
adjusted if required.

· When adding payments, the b (balance) shortcut will insert the total amount of
GST still outstanding, whether or not it is one eleventh of the amount of the
payment.

· The amounts of GST charged, received and owing will appear on the top of the
Payments page for reference.

5.1.3 Receipts

The system is set up so that printed receipts are simply account statements with
receipt information printed on them. Each payment is allocated a unique Receipt
number.

When a payment is entered, the system checks to see whether the Drawer of the
payment usually sends a receipt. If so, the receipt tag is set to true. This receipting
behaviour (receipt tags) can be edited in the Drawer's lookup list by clicking the Edit
button just to the right of the Drawer heading. The checkbox UsuallySendReceipt
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should be ticked (or set to either 'Yes' or 'No' if the checkbox is absent). Generally,
drawers in the list probably won't need a receipt; health funds, Medicare and so on.

Accounts with receipt tags checked will be shown in the List of Patients when the
Receipts option is chosen from the Select menu. These can then be printed together
in a batch. Receipt tags are cleared automatically when a receipt is printed.

5.1.4 Payment status

When a payment is entered into an account, the amount owing is reviewed and the
payment status is changed appropriately.

If the payment fully pays the account fee, the status will be set to Paid in full, and the
current date will be inserted into the Date Account Closed field. This will also occur if
there is a small residual amount owing provided the residual is less than that specified
in the Options form (Automatic functions page). This avoids an account being deemed
unpaid when a trivial amount is left outstanding.

If a payment is made but an amount is still owing, the payment status will be updated
to include the subscript, -part paid.

If required, the Date closed, Payment
status and Receipt tag can all be
manually adjusted and, in particular, you
can enter your own status phrase if you
like.

The presence or absence of a Date
account closed determines whether an
account is open or closed. Adjusting the
payment status may insert or remove
the date closed automatically.

If you want to 'write off' an account
without it being fully paid, simply select
Part Payment Accepted, or any other
appropriate status phrase, and insert a
Date account closed.

   

Missing receipts

When you enter one or more payments for an account and they total the amount
owed, the account status is automatically set to Paid in full. If a receipt is required, the
receipt tag is automatically (or can be manually) set to true. If you then jump to the List
of accounts you may find that the account is no longer in the list. This is because the
list is probably displaying only Open accounts and the account you were just working
on was just closed automatically by the addition of a Date closed. In this case, choose
Receipts from the Select menu and the account will reappear.
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List of automatic changes to payment status

When Access Anaesthetics opens, and when payments and other data are entered,
the status of any Open accounts is reviewed and adjusted automatically as follows:

Status This status is set when...

Further information required a new account is first created

Too early to send sufficient data is entered but operation date is too close
to today's date, as specified in Options

Ready to send sufficient data is entered and account may be printed
and sent

Awaiting payment account is first printed

Overdue the difference between the account date and today's
date is more than the specified overdue period, and the
account is still open

Medicare only accepted the payment of a MO account is completed

Discounted fee accepted the payment of a discounted account is completed

Paid in full the full payment of an account is completed

Unpaid a payment is deleted and the system does not know
what other status to assign

Notes

· The subscript -part paid is added to the existing account status when a payment
is entered which does not fully pay the fee charged.

· The other status phrases must be added manually if you wish to use them.
· Adjusting the payment status may insert or remove the Date account closed.

However, adding, modifying or deleting the Date account closed will never
change the payment status.

5.1.5 Discounted accounts

When a discounted fee is charged, the discounted fee is treated in exactly the same
way as a standard fee as far as payments are concerned. That is, if the total amount
of the discounted fee is paid, the status is set to Paid in full and the account is closed.
If the discounted fee is part paid, the status will be subscripted -part paid, the account
will remain open, and any receipt or reminder will show the discounted fee and the
balance owing.

When a discount expires or is manually removed, the fee reverts to its original
amount. If a payment is entered in these circumstances which equals the discounted
amount, you will be prompted as to whether you wish to reinstate the discount and
accept the payment as full payment for the account.

For discounted accounts, the pre-discounted fee is also shown on the Payment page
for reference. Similarly, for accounts where a discount has expired or been removed,
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the discounted fee is also shown on the Payment page. This assumes that the
discount details have been retained on the Fee page , but the Apply/Remove
checkbox has been cleared. Removing the discount altogether from the Fee page will
remove any reference that there ever was a discount.

5.1.6 Co-payments

When an account is sent to a health fund under that fund's No Gap arrangements, an
additional co-payment account may also be sent directly to the patient. Both these
accounts are actually managed from within one account in Access Anaesthetics,
according to which print button is pressed to produce the account. When a payment is
received, it is possible to specify whether it was received on behalf of the fund or the
patient, so that the receipt information can be managed appropriately.

To do this, tick the CoPay checkbox for any payment that is
made towards the co-payment account. Leave the box blank
if the payment is from a fund for the fund's component. The
checkbox will only appear for accounts which have a patient
co-payment amount entered on the Fee page.

   

When receipts or reminders are printed, only the payments which relate to the
appropriate account type (fund or co-payment) are shown. Also when printing a
receipt or reminder for a patient co-payment, an alternative message (set up in the
Options form) will appear in place of the standard message when any amount has
been received as part or full payment of a co-payment.

Summary amounts for the co-payment are shown above the list of payments for
reference when entering payment information.

Note For accounts to be recognised as having co-payments, there must be an
amount in the Co-payment field on the Fee page, AND the Account Type
must be the same as the Health Fund Fee. That is, the health fund fee
must be set as the main account fee.

5.1.7 Medicare only accounts

There is no function to specifically manage accounts for which the Medicare rebate is
accepted as full payment. Normally in this situation, an account is sent for the
Medicare schedule fee (SF). Then, as described above , you can select the
Medicare only (MO) account type on the Format page to insert a message indicating
that the Medicare rebate will be accepted.

If this is done, the Payment page will have a notation to this
effect as shown here. To accept a Medicare only payment,
enter the payment as usual, then select Medicare only
accepted from the Status menu. This will close the account.    
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5.1.8 Batch payments

Batch payments are those where more than one account is paid using a single
payment. This may happen, for example, when you receive a cheque from Medicare
or Veterans' Affairs and it includes payments for several patients in the one cheque.

One batch payment is distributed across several accounts. When this is done, a new
payment record is created for each account which receives part of the batch payment.
Thus if one batch payment contains payments for 3 accounts, there are a total of 4
payments - one batch payment and 3 distributed payments. The three distributed
payments add up to the same amount as the 1 batch payment.

So that these amounts are not duplicated in any reports, the batch payments are
included only in bank deposit slips or listings of unbanked payments, while the
Distributed payments are included in all other financial reports, effectively taking the
place of the single batch payment. In this way, the payment is never added up twice
and never omitted.

To add a batch payment, click the Add button
under the Batch Payments heading on any
patient's Payment page (you can also do this
from the List of Payments screen). The following
screen will open.

   

There are three steps to entering a batch payment.

1. Enter the details of the actual batch payment on the left hand side of the form,
that is, the cheque you have received which covers multiple accounts. This data
entry is identical to the method for entering standard payments in an individual
account record. Thus, you should enter a date received, payment type, drawer,
bank, branch and amount. The standard abbreviations, lookup tables and
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shortcuts are all available, and the same payment type conventions apply to bank
deposit slips.

2. Once you have entered an amount and pressed the <ENTER> key, the fields on
the right hand side will become activated. For each account you wish to distribute
part of the batch payment to, enter the account number and the amount to be
distributed to that account. A lookup list of open accounts is provided in the
account entry field. When an account number is entered, the amount owing is
automatically inserted into the amount column as the default. This may be
changed if required.

3. When you have entered all the distributions, the total of the distributions should
equal the amount of the batch payment. If this is so, button 3 will become
activated. Click button 3 to store the batch payment details in the database.

During this final process, the payment status is updated in the same way as it
would be for a standard payment. That is, if the payment matches the fee owing,
the status will be changed to Paid in full and the account will be closed by
inserting a Date account closed. If money is still owing, the status will be updated
to include the subscript -part paid. The receipt tag will be ticked if appropriate.

You can click the Cancel button at any time (before clicking button 3) to abandon the
batch payment process.

Once the process is completed, the batch payment will appear in the unbanked
payments list and the distributed payments will appear in each individual account
record and will be available for financial reporting. When the next deposit slip is
printed, the banking date will be inserted into both the batch payment and the
distributed payments. If the payment is a type which does not appear on a deposit
slip, today's date will be automatically inserted as the banking date when entering the
payment details and, after distribution, will appear in all 4 payment records.

Batch Co-payments

If the batch payment is for a patient co-payment, tick the Copayment checkbox on the
left side of the window. Distributed payments will also be designated as copayments.
It is not possible to enter a batch payment which contains a mixture of standard and
copayment payments. When entering a batch co-payment, the lookup list on the
account number field on the right of the window will automatically insert the co-
payment amount owed. This can be edited if required.

Editing batch payments

Batch payments can be identified by a red star in the Amount
field. A batch payment shown in an individual account shows
only that part of the actual payment which was allocated to the
displayed account.    

To view the complete batch payment, put the cursor (click in) the row containing the
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payment and press the View/Edit button under the Batch Payments heading.

Batch payments can only be edited by first pressing the Unlock button on the editing
window shown above. Once any change is made, button 3 must be pressed to
complete the editing process. Otherwise the edits will not be saved.

It is also possible to delete batch payments by pressing the Delete button. The original
batch payment and all the distributed payments will be deleted by this function. As
with standard payments, if the batch payment already has a banking date when
deleted, the payment details will be stored in the list of deleted payments which can be
viewed (but not edited) from the List of Payments screen . The main purpose of this
deletion function is to allow the user to manage a bounced cheque. It is expected that
you would not otherwise delete a banked payment.

Viewing the main batch payments screen

To view all the batch payments stored in the database, click the List all button below
the Batch payments heading on any account's Payments page (or do the same on the
List of Payments screen). The following screen will appear.

The top section of the batch payments screen shows the actual batch payments
stored in the system. When you select one of these payments, the lower section
shows the distributed payments for the highlighted batch payment. That is, the batch
payment highlighted in the top section was divided up amongst the accounts shown in
the bottom section. You can scroll the bottom section to the right to show all the fields
currently not visible on the screen.

The batch payments at the top of the screen can be sorted by choosing a sorting field
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and direction from the Sort by list box on the top right of the screen. The distributed
payments on the bottom of the screen can be sorted by using the A-Z and Z-A icons
in the top menu bar when the cursor is in the column you wish to sort by.

5.2 Status page

The Status page shows a summary of the account's current status, the time elapsed
since various significant events and the fees charged and payments received.
Although these fields are updated automatically, some of them are editable although it
is not expected that these would ever be manually edited. In particular, the account
date can be edited if required.

Current status

The current payment status for each account is shown
in the green area at the top of the screen just under the
Account details button. This is set automatically
according to various criteria. For example, when an
account is first printed, the status is set to Awaiting
payment. If it is not paid within a specified period (as
set in the Options form on the Automatic functions
page ), it is changed to Overdue.     

Normally it is not necessary for the user to manually change the status. However, it is
possible to do this by selecting a new status phrase from the drop down list. You may
also enter your own custom phrase by selecting Enter my own from the list and typing
any phrase you wish. If you do this, you will need to manually keep track of the
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account since the built-in functions operate according to which of the listed phrases is
stored.

Status log

Any modification to the account status is logged, whether it is done automatically by
the system or manually by the user. You may delete status log entries by highlighting
the record selection boxes on the left of the relevant rows and pressing the delete key
on the keyboard.

5.3 Documents page

Whenever an account, receipt or letter is sent to a patient, the details are recorded on
the Documents page. Details are recorded only when a document is printed, not when
it is previewed. If a document is printed but needs to be printed again because of a
problem with the printer, the document information will be saved each time. Therefore,
if you print a document which is subsequently discarded, you may wish to delete the
item from this list. Alternatively you may make a note in the Notes field on the right of
each document in the list.

Snapshots

If you have ticked the Save snapshots checkboxes on the File Management page
of the Options form, whenever you print an account or letter, an image of it will be
saved on your hard disk in the Snapshots subfolder of your Access Anaesthetics
folder (e.g. C:\Access Anaesthetics\Snapshots\ACC0305121035.snp). Documents
saved in this way have a tick in the checkbox in the document list, and may be viewed
by clicking on the camera button on the lower right of the screen (or by double clicking
the file name).
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Snapshots are read-only copies of an Access report. The aim of including them in
Access Anaesthetics is to provide a unchangeable copy of an account which has
been sent. This is relevant, since the data stored in the system for a particular patient
can be edited at any time and there may come a time when you are not sure exactly
what was sent to a patient. The snapshots provide a reliable historical record much
like a photocopy of the original account.

While viewing snapshots, you
may zoom in or out by clicking
directly on the page. For finer
control of zooming, click the right
mouse button and choose Zoom.

Print the snapshot using the
printer icon on the bottom of the
page. You may also print using
the right-mouse shortcut menu.

    

Snapshot filenames

The name of the snapshot file starts with either ACC (for accounts) or LET (for letters)
followed by the date and time the document was printed. Snapshots will contain a
single account if printed from the Account details form, or will include multiple
accounts if printed with other accounts from the List of Accounts screen. In the latter
case, the snapshot page number for the specific account is also shown on the
Documents page.

If you delete a document record, the snapshot is also deleted unless it is part of a
multipage snapshot. This is so since deleting such a file may delete snapshots which
you had not intended to delete.

As well as allowing you to view snapshots from within Access Anaesthetics, the free
Microsoft Snapshot viewer program allows snapshots to be viewed outside Access
Anaesthetics. The snapshot viewer is included on the installation CD, or may be
installed from version of Microsoft Office of 2000 or later. It will allow you to double
click on a snapshot file in Windows Explorer to view it.

If you routinely store snapshots when printing accounts, you will eventually have a lot
of files in your snapshots folder. You should consider deleting these from time to time
to recover disk space. Since the snapshot files are named according to the date and
time they were created, you can easily reorder the list of files in Windows Explorer
according to the file name, then delete files created prior to a chosen date.

Note The snapshot checkbox cannot be edited. It is ticked automatically if the
file exists in the Snapshots folder.
If you cannot view a snapshot when you double click on it, you need to
install the free Microsoft Snapshot Viewer from the installation CD.

External Documents
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The documents page also allows you to store a reference to an external document.
This might be a letter created in Microsoft Word, an image, or a pdf (Acrobat)
document. This feature allows you to keep a record of all documents related to a
single patient in the one place in Access Anaesthetics, irrespective of where they are
on the computer, or which application was used to create them. See the Letter and
Documents section for more information.

5.4 Account notes

Any information may be entered into the notes page to assist in managing the
account. Some examples are:

· changes of address,
· attempts to contact the patient by telephone, or
· explanations by the patient of late payment and when payment might be

expected.

To assist in organising the notes chronologically, a date stamp function has been
provided to insert the current date when entering notes.

If accounts are created on a Palm or Pocket PC handheld computer, and
subsequently imported into Access Anaesthetics, the import time and any import
errors will be shown in the Comments field. A button has been provided to quickly
remove these import notes without removing any other notes you may have entered
manually.

Where there are notes stored in a particular account, the notes page will be labelled
'Notes +++' to quickly alert the user to the fact that notes exist. If there are no notes,
the label will simply show 'Notes'.

The notes will be printed on the Followup Worksheet, a report which is designed to
assist in the process of telephoning patients who have accounts overdue. Print the
Followup Worksheet from the List of Accounts screen .123
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6
Item Schedules

C H A P T E R

This section examines the Medicare and ASA RVG schedule books; how to find the
items you need and how to customise the books to suit your way of working. The
health fund 'no-gap' schedules are described, as are the DVA and other custom time-
based fee calculation methods.

6.1 MBS/RVG items schedule book

Open the MBS or RVG schedule book from the Items page by clicking the appropriate
button on the bottom left. The MBS book looks like this:

This section describes the MBS book in detail. The ASA RVG book contains the
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Relative Value Guide schedule as created by the Australian Society of Anaesthetists.
It's function is essentially similar and will not be described separately.

Layout of items

The Medicare Benefits Schedule book shows all MBS items in order of item number.
Each item is shown in a single row. To view the full item description, click in a row and
the details will be shown at the bottom of the form, with the schedule fee and RVG
units. If it exists, the matching item number from the ASA RVG schedule will be
shown in the second column.

There are a number of features of the book which are only applicable to the pre-
November 2001 schedules. These are the T column (time units) and the A.Rate and
A.Fee fields. These have been retained for backward compatibility with previous
schedules.

Moving and sizing the MBS book

The MBS book, like other popup forms, can be moved around the screen by clicking
in its title bar and dragging it to a new location. This can be useful if you want to see
what is under the form without closing it.

The form can also be resized, to make it taller or wider by
moving the mouse to the edge until it becomes a double-
ended arrow. Then click and drag the border to resize the
form. In particular, it may be useful to shorten the form to see
more of the underlying page, or to lengthen it to show a
greater number of items at one time.    

Changing the width is not recommended as it will only hide relevant data or show
additional blank space. After closing Access Anaesthetics and starting again, the book
will revert to its original size.

Which version do you have?

The version of the MBS book is shown in the title bar with a phrase such as Medicare
Benefits Schedule Book, May 2003. The book is usually updated at least twice yearly.
See the File Management section  to find out how to update to a new version.

Adding an item to a patient's account

Locate the item you wish to add to the account and make sure the cursor is on that
row in the list so that the correct description is shown in the box at the bottom. Then
press the Add to account button. The item will be added to the account with the
default date, item number, unit value, description and fee. You can continue to add
additional items without closing the MBS book. If the item you added was an
Anaesthesia for ... item, the appropriate time item and age modifier should also be
added automatically.
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Note When using the MBS book, the item will be added to the MBS or DVA
section of the Items page depending on which section was visible when
you opened the book. ASA RVG items will always be added to the ASA
RVG section, no matter which tab was selected when the book was
opened.

The Quick Item List

The Items page on the Account details screen has a Quick item list  which allows
easy entry of an item without having to open the MBS book. To add an item to the
quick list from the MBS book, locate the item in the book and click the Add to quick list
button. Items added in this way will retain any existing subitem codes .

6.1.1 My Own list

There are approximately 5000 items in the MBS book. It is possible to create your
own list of commonly used items to simplify your viewing of the MBS book. Each row
of the book has a checkbox on the left labelled 'My' which indicates whether or not the
specified item is stored in My Own List. Add or remove an item from My Own list by
clicking the checkbox.

To view just the items in My Own list, select this option
from the drop-down list at the top of the window. The
other options are Entire MBS, which shows all 5000
items, and Anaesthetics, which shows most of the
items an anaesthetist is likely to use (about 700).    

There is a checkbox on the Miscellaneous page  of the Options form which allows
you to specify which of these filtering options is used when the book is first opened.

6.1.2 Searching for items

To go to a specific item number in the book, type the number into the field labelled Go
to on the top right of the window. If you don't know the number, click the drop down
arrow and select one of the item categories. You will be taken to the beginning of the
specified group.

If you have either the My Own list or Anaesthetics filters in operation (see above), the
item you are looking for may not exist in the subset of items currently displayed. You
may need to reset the filter to Entire MBS to find the item.

Alternatively, you can use the Search field to locate a specific string of text. This will
restrict the items displayed to only those where the specified text is included in the
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item description. For example, the text colon will find all items with colon,
colonoscopy, colonoscope etc in their description. The above example uses the text
EPID to search for all items with epidural in the description. When this type of filtering
is active, a button will appear on the top of the form showing e.g. Viewing 10 items. To
reset the form to show all the items, click the button, or delete the text from the
Search field.

The filtering using the search function works in conjunction with the Entire MBS, My
Own List and Anaesthetics filtering. Consequently, the text search function will only
search for the specified text in the already filtered list of items. Resetting the search
function will see the list revert to the original filtered view.

Hint If you open the MBS book when the cursor is on a particular item on the
Items page of the Account details screen, that item will be located
automatically when the book opens.

6.1.3 Editing item descriptions

Some MBS item descriptions are quite long and it is advisable to shorten them when
adding them to your accounts. This can be done directly on the Items page after
adding the item to your account (see above ). This method will only change the
description for  one account. To save a modified description for an item so that the
system will always use your modified description, proceed as follows.

Locate the item in the MBS book. Click anywhere in the description at the bottom of
the form and edit it to your desired wording. Click the Save button. This process
creates a custom description (My Own Description) which is stored in addition to the
standard MBS description. Henceforth, the custom description will be inserted onto
the account in preference to the standard MBS description when that item is added to
an account. Whenever you create a custom description, that item is added to My Own
list .

Once you have created a custom description, buttons will appear to enable you to
toggle between the standard and custom descriptions, or you can remove the custom
description to restore the standard MBS description. A Save button will also appear
although the data will be saved automatically when you move out of the description
field. When the new description is saved, you will be asked whether you wish to add a
subitem abbreviation (see below ). If you just wish to save the custom description
as the default for the item, click OK leaving the dialog box empty.

If you always want the custom description to be inserted onto the account, proceed as
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described above. If you only want to edit the description for the account you are
currently working on without modifying it in the MBS book, simply add the item by
clicking the Add to account button, and then edit the description directly on the
account's Items page. In the latter case, the edited description will not be saved in the
MBS book as a custom description.

The post-November 2001 Medical Benefits Schedule book has a rather verbose way
of describing items 20100-21997. They all begin with Initiation of Management of
Anaesthesia for... Access Anaesthetics has already abbreviated these descriptions to
a certain extent, replacing the above text with Anaesthesia for …, and removing other
non-essential descriptive text from these and some other anaesthesia-related item
descriptions. Consequently, the description initially shown in the MBS book (of Access
Anaesthetics) may not be identical to that in the printed book from the Health
Insurance Commission (HIC). However, the original description is always available for
viewing or copying by clicking the View complete MBS description hyperlink in the
MBS book for affected items. This link is not available when the description has not
been altered.

6.1.4 Creating subitems

In some circumstances, it is useful to store several descriptions for a single item. For
example a hip replacement may be designated right or left, or blood pressure
monitoring may be Arterial, CVP or PA and so on. This can be managed by storing
each separate description as a Subitem.

To do this, first locate the 'parent'
item e.g. 22012 (blood pressure
monitoring …). Edit the displayed
description to e.g. Blood pressure
monitoring, systemic arterial. When
the description is saved (either by
clicking the Save button or
automatically when you exit the
description field) you will be asked to
enter an abbreviation code to identify
the subitem.

   

Enter art and the new description will
appear as a new item in the list. If you
leave the subitem code blank, a new item
will not be created, and the custom
description will simply be attached to the
parent item. To delete a subitem,
uncheck its My Own List checkbox.    

Once created, the subitem may be inserted into your accounts in the same way as
any standard item. If entering the item directly onto the Items page, type the item
number followed immediately by the subitem code. The following items were added to
the account by entering 22012, 22012art and 22012cvp. You can create as many
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different subitems as you like for one parent item. All of them will automatically be
added to My Own List.

6.1.5 MBS - RVG item links

The MBS book has a column labeled RVG. This contains the item number from the
ASA RVG book which matches the MBS item number. This is used to correlate the
MBS and RVG schedules, and to create a list of RVG items based upon the MBS
items already entered onto the account.

Prior to the incorporation of the RVG into the Medicare schedule, this system enabled
anaesthetists to compare the two types of billing, and to set a fee using the RVG
system while displaying items from the MBS schedule on the account. This is rarely
required post Nov 2001, but the links are maintained to provide an easy method of
creating a list of RVG items based upon the MBS items entered.

Caution is needed in using this linking system since there are some anomalies.
Specifically, there may be more than one MBS item which matches a particular RVG
item, and vice versa. This is especially true of item descriptions, and it is
recommended that if you use the Create RVG from MBS function , you carefully
check the items and descriptions which have been created.

In the pre- November 2001 system, it was left to Access Anaesthetics users to create
their own links between MBS and RVG items. This was mainly because of the large
number of items in the MBS schedule and the difficulty in matching them all
appropriately. The post - Nov 2001 schedules have the links built in for all the items
which are likely to be needed by anaesthetists. Even so, it is possible to edit these
links if any of them are not suitable for your practice. To do this, open the MBS book
and double click on the RVG column alongside the MBS item it is to be matched with.
Enter the matching RVG item number into the dialog box which appears. Because the
links are stored in the MBS items file, any modifications you make here will no longer
be active once you upgrade to a new items file. If you believe we have inserted any
incorrect links, contact us so that these can be corrected in a future update.

6.1.6 My Own fees

On an account's Items page, clicking the My Own Fee button allows you to enter your
own fees  for individual items. Most of the time, these fees are based on a number
of units multiplied by a dollar value per unit. However, there are some items, such as
the pre-anaesthetic consultation (17603) and a number of anaesthetic extras which do
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not have a unit value. These cannot have a fee attached based upon a particular unit
value and, for these items, you can store a default dollar value fee in the MBS book.

To be able to do this, the item must first be in My Own List . Locate the item in the
MBS book and, if it is not already, tick the checkbox in the My column. For items in My
Own List, which do not have a unit value, an additional blue column will appear
towards the right of the window. A specific fee for the item can be entered here.

When you subsequently
click the Insert 'non-unit'
fees from My Own list
button in the My Own
Fee dialog box , the
fee stored in the MBS
book will be inserted.

   

The button Edit my own fees list opens a datasheet showing the list of My Own items.
The fees can be edited, along with the item description and subitem codes.

6.2 Health fund schedules

The major Australian health funds provide No-Gap schedules of specific fees which
are above the MBS schedule fee. The use of these requires the anaesthetist to
register with the appropriate health fund and to follow the fund's guidelines about
sending accounts. Usually, an account is sent directly to the health fund for that fund's
published fee. Payment is then made directly into the doctor's nominated bank
account. Additionally, a patient co-payment account may be sent to the patient.

Each fund provides a schedule of fees and we have incorporated the fees for
anaesthetic-related items into Access Anaesthetics. Unfortunately, it is often difficult to
obtain timely information from some funds and the process of obtaining the schedules
is often in response to client queries. That is, a client finds that his rebate from the
fund is not what the fee schedules suggest, he contacts us, we contact the fund, the
fund informs us that they have changed their schedule, we update the schedule and
finally make it available to our clients. Clearly not the ideal situation, but it what we're
stuck with. Consequently, while we make every effort to keep the fund schedules up
to date, we cannot guarantee that they always will be.
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Because we anticipated problems with updating schedules, we designed a system
which allows the individual user to update and modify the schedules themselves. This
system is described below. However, as time goes on, we find that clients rarely need
to make their own modifications.

Open the Health Fund Fee Schedules configuration screen by selecting Health Fund
Fees from the Tools menu, or by clicking the Edit button to the right of the funds drop
down list on the Items page. The following screen will appear.

Editing schedules

The health fund fee schedules provided by us are contained in an Access database
file called AAFundsWithRVG.mdb. These are shown in the configuration screen as
Built-in. It is also possible for you to create your own User-defined funds. These are
stored in your own data file, AAUser.mdb. The purpose of providing this ability is to
allow individual clients to create and use fee schedules which are unique to their
situation and which have not been incorporated into the general list of funds. As time
goes by, there is less need to do this since we have incorporated many funds based
upon client requests.

The fund editing buttons below the list of funds allow you to create, copy, edit and
delete user-defined funds. The fee editing buttons towards the middle and right allow
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you to edit specific fees for the selected fund. Fees can be edited for all funds (except
the MBS schedule) but item numbers cannot be added, edited or deleted.

It is possible to hide funds you never use from the Health Funds drop down list so that
the list on the Items page is more compact. You can unhide them just as easily. Your
preferences will be remembered after updating to a new health fund file. When
printing a list of 'All' fund schedules, hidden funds will not be shown. Click the Show or
Hide button to toggle this feature. 'Hidden' funds will move to the bottom of the list so
that the list of 'visible' funds will be clearer.

We will provides updates to the AAFundsWithRVG.mdb file (containing the Built-in
funds) from time to time. Conversely, you will need to manually update any User-
defined fund tables that you have created.

What do the values in the tables mean?

· Positive amounts. This is the fund's dollar fee for the specified item. There are
two exceptions - for epidural items 18219 and 18227, where the amount is an
amount per 15 minutes.

· Negative amounts.This is a factor which is multiplied by the equivalent MBS fee
to calculate the fund's fee. It is used for most RVG modifiers. A factor of 1.53
equates to 53% more than the MBS fee for the same item. The negative sign is
irrelevant in the calculation; it is just to tell the system how to use the numerical
value.

· Amounts between 0 and 1. This factor applies only to after hours loading items
(25025, 25030 & 25050) and is multiplied by the total health fund fee to
determine the loading (0.5 indicates a 50% loading). Note that most funds use
the percent of MBS method described above, and therefore have a negative
factor for these items.

6.3 Custom time-based schemes

The Department of Veterans' Affairs uses a system of time-based fees  to
remunerate anaesthetists. This allows for a set dollar value per hour for time spent
administering anaesthetics and this is independent of the Medicare or other fee
schedules. The Victorian Workcover Authority also offers a time-based system (as
well as a fee schedule system). Instead of using a specific process for the VicWC
method, Access Anaesthetics has a customisable system which will allow the creation
of any number of different time-based systems using different rates and time periods.

The Time-Based Schemes configuration form shown below can be opened from the
Tools menu  or from the My Own Fee dialog box. This will allow you to create and
customise your own time-based schedules. A scheme for the VicWC Time-engaged
method has already been set up and will be used as the example below.
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All available schemes will be shown. Initially this contains 4 schemes for VicWC and a
number of others for demonstration purposes. The DVA and RVG schemes are just
examples; they are not intended for use with DVA or RVG accounts.

Functions are provided to create new schemes, edit existing schemes and delete
schemes. Dollar values are inserted alongside time periods to indicate how the fee will
be calculated. A calculator is provided to test the schemes.

For the Victorian Workcover, one scheme has been created for the normal
anaesthesia time and another for the out of hours time. Also, 2 other schemes are
provided which will separately list the first 30 minutes, and subsequent time.

Using a time-based scheme on your account

To use one of the time-based schemes on your account, go to the MBS tab of the
Items page and click the My Own Fee button. Then select the preferred time-based
scheme from the list in the My Own Fee dialog box . This will perform the fee74
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calculation and insert the appropriate item details (as specified in the configuration
form). Lastly, select My Own Fee on the Fee page.

Note that if the start or stop times of the procedure are changed, the time-based item
should be removed from the list and re-inserted, so that the fee is recalculated. (The
account does not keep track of how the fee was first calculated and has to do it again
from scratch.)

Account Types and Default Messages

In the configuration form, you can specify the default account type to be used when
each scheme is used. Take care that you don't use an account type which is already
being used for something else, e.g. SF+, RVG, DVA or any of the health fund codes.
This is particularly the case for VicWC where this account type may clash with the
standard MBS schedule - based method provided by VicWC in the health funds list.

When a My Own Fee is selected on the fee page, the message shown on the account
will be that listed under the code MyOwn in the messages list. If you like, you can
create additional messages which will be shown when a particular account type is
used. So if you create a message with the code VicWCTime, this will be shown when
the account type is VicWCTime. If no message code matches the account type, the
default message for MyOwn will be shown.

6.4 AMA schedule

The Australian Medical Association (AMA) has its own schedule of fees which
includes items for surgical and anaesthesia services. Mostly, the items which relate to
anaesthesia are identical to the RVG schedule of the Australian Society of
Anaesthetists (ASA). Consequently, Access Anaesthetics does not include the AMA
schedule.

It is sometimes said that the RVG may be used with a unit value up to the maximum
recommended by the AMA. This rate is often used for workers compensation and
third party accounts, and defaults for these rates can be set up on the Unit and time
values page  of the Options form. If you want to 'charge AMA rates', you should
create an account based on the green RVG page of the Items form and specify your
own unit value on the Fee page, up to the maximum recommended by the AMA. This
maximum rate is advised periodically by the ASA.

There is no documented method of using AMA items on your accounts if they do not
appear in the RVG schedule. However, using the (hidden) item editing window , it is
possible to include any item number, unit value, description and fee you wish. This
could be adapted to insert a non-listed AMA item.
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6.5 Updating the schedules

From time to time, the fee schedules need to be updated. Installation instructions are
provided with the update files.

Medicare schedule May & Nov, plus smaller updates

ASA RVG schedule Less than once per year

Health fund schedules May & Nov and at any other time

DVA time-based fees November each year

AMA recommended RVG value November each year

The DVA and AMA values are easiest to update and can be done simply by changing
the values in the Options form  at the appropriate time.

The Medicare and ASA RVG schedules are contained in the MBS items file which is
provided to clients at the appropriate time. The file needs to be unzipped and installed
as described in the File Management section .

The health fund schedules are provided whenever an update is made and installation
simply involves unzipping the file into the Access Anaesthetics folder. When you
update your health fund fee schedules, the previous schedule is overwritten. In
contrast, the MBS items file is added to the system and it is possible to switch from
one MBS file version to another.

When the RVG was incorporated into the MBS schedule in November 2001, a
number of changes were made to the system. We have enabled backward
compatibility of the Medicare and health fund fees by providing two health fund files,
one for pre-RVG and one for post-RVG. The post-RVG file (AAFundsWithRVG.mdb)
will be automatically attached to your system when you attach an MBS items file of
November 2001 or later, and the pre-RVG file (AAFundTables.mdb) will be attached
when you attach to an earlier MBS file.
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7
Printing Accounts

C H A P T E R

There are a number of methods of printing accounts and other documents. Receipts
and reminders are different from initial accounts, and may include additional
messages with increasing levels of encouragement to pay the account. Health fund
accounts and co-payments are printed in two separate processes. Bank deposit slips
are the other main day-to-day printout required.

7.1 Printing initial accounts

There are several ways to print
accounts. The simplest is to use the
Print now button on the bottom of any
Account details  screen.

 

This will open the print dialog box
(shown at right) enabling you to
preview or print the current account.

   

While in the preview window, use the Print button on the toolbar to
print one copy of the account to the printer. You can specify in the
Options form (Misc page ) if you would like to be prompted to
print multiple copies.

   

Printing multiple accounts

If you wish to print a batch of accounts at one time, do this from the List of Accounts
screen . First select a group of accounts to print using the Select menu. For
example, select accounts which are Ready to send or Overdue.
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Then use the Print Accounts - All Shown button on the bottom
left of the screen. Alternatively, you can limit the accounts by
tagging selected accounts in the list, and printing the Tagged
accounts.

    

This method is useful if you wish to enter a batch of accounts in one
go, then print them all out later. The Tag field is duplicated on the
Account details screen, and you can tick these as you go if you just
want to print specific accounts.

   

Tagging is not necessary for printing. A group of accounts can also be selected by
other means.

Inserting the Account date

When an account is first printed on a printer, the date specified in the print dialog box
will be inserted into the account as the Account Date. This will happen only if the
Account date is currently blank and will happen whether you print an account
individually from the Account details screen, or in a batch from the List of Accounts
screen. The date will not be inserted if you just preview the account without printing it
on the printer.

7.2 Printing accounts again

There is no separate printing format in Access Anaesthetics for receipts or reminders.
These are the same as account printouts except that payment details or reminder
messages are included in addition to the original account details.

If you print an account which already has an Account date, it will be considered either
a copy of an account, a receipt, or a reminder. In this case, although the standard
print dialog box will appear, the date specified in the box will not be inserted into the
account. Rather, the account will retain its original Account date, and the date in the
print dialog box will appear on the account in the format This statement was printed on
27/Jul/2003 (provided this option  is specified in the Options form).

Additional message when re-printing accounts

When an account is re-printed it is assumed that it is either a receipt, a reminder or a
copy of the original account. At the time of printing, an additional message can be
added to the account which will appear at the very bottom below the items list,
standard message and any payment details. This additional message is intended to
add information relating to the payment of the account. That is, for paid accounts, a
thank you message or remark that a balance is required. And for overdue accounts, a
message related to the degree of 'overdueness' of the account.

When an account is reprinted, a default message will be attached. Which message is
attached will depend upon whether the account is designated an account (copy),
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receipt, or reminder. Before each account is printed, you are shown the attached
message and given the opportunity to change it. The following screen appears after
you have pressed the preview or print button in the print dialog box. If you are printing
multiple accounts, each will be shown in a separate row.

Usually you would simply accept the default messages. However, for each account
being reprinted, you can use the listboxes to specify whether it is an account, receipt
or reminder, and you can select an alternative message. Additionally, you can adjust
the message by directly typing in the message field.

Of course, you can also elect not to show any additional message either by deleting
the displayed message, or by selecting NO ADDITIONAL MESSAGE from the drop
down list. In all cases, the standard message  will be unaffected and will appear
exactly as it is stored in the account.

If an account is reprinted within 16 hours of it first being printed, the COPY OF
ORIGINAL ACCOUNT message will not be automatically inserted. This is to make it
easier if an account is printed more than once in its first printing session. The aim of
this is to avoid the user having to delete the additional message if the account is
simply being reprinted after a minor modification was made or a printer problem
resolved.

When printing a lengthy list of accounts, you can untick the OK to print? checkbox if
you do not wish to print one or more of the listed accounts. This is to avoid you having
to close and reopen the window while in the process of printing.

86



Chapter 7.  Printing Accounts

118 Access Anaesthetics Practice Management System

Setting up the messages

The additional account messages are stored in the same table that stores
the standard messages . Open the messages table by clicking the pencil
button to the right of the standard account message on the Format page of
any account.

   

The MessageType for these additional messages should be set to Rpt so that they will
appear in list on the additional message screen shown above. You can edit the
messages taking into account the following MessageCodes:

MessageCode This message appears where

Copy the document type is Account and the account is not overdue

Paid the account is paid in full, or a part payment is accepted and the
account is closed

PartPaid the account is part paid, and an amount is still owing

Over1 an account is overdue and no reminders have yet been sent

Over2 an account is overdue and 1 reminder has already been sent

Over3 - OverN an account is overdue and 2 to N-1 reminders have already been
sent

There is no limit to the number of additional overdue messages you can specify. If the
number of reminders is greater than the numbers of reminder messages available,
the 'biggest' message will be shown. Note that all consecutive codes must exist, that
is, you can't have Over1, Over2, Over4, Over7, or the intervening reminders will show
no message.

Note Whenever you print an account on the printer, the type of account
(account, receipt, reminder), the printing date and a snapshot will be
stored on that account's Documents page for future reference.

7.3 Printing receipts

As described in the previous section, there is no separate printing format in Access
Anaesthetics for receipts. These are the same as account printouts except that
payment details are included in addition to the original account details.

A receipt can be printed at any time simply by reprinting an account which has had
payment details entered. The itemised payment details will be shown with an
additional message indicating whether full payment was received or whether an
amount was still owing. See the Printing accounts again  section for a discussion of
account messages.

Receipts can be printed individually from the Account details screen  as payments
are entered. Alternatively, you can tick the Send receipt checkbox on the account's
Payments page  for batch printing later. This is done automatically when some
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types of payment are entered. To batch print receipts, go to the List of Accounts ,
select Receipts from the Select menu and then click the Print Accounts - All shown
button. This process is similar to printing any group of accounts as described in detail
in the previous section.

7.4 Printing reminders

There is no automatic process in Access Anaesthetics which will print reminders at a
set period. The problem with such a system is that you may send reminders to people
you did not intend to send them to. For example, you may know that a particular
patient is having financial difficulties, or has telephoned recently about the account,
and you would prefer not to send a reminder to these people. Consequently, we have
set up a system which allows you to easily print groups of reminder notices when you
want to, and which allow you to control exactly which reminders to send.

As with receipts and copies of accounts, Reminders are identical to original accounts
except that they may contain additional messages (+/- details of payments) . See the
section on Printing Accounts Again  for full description of the relevant issues.

Suggested method to manage reminders and overdue accounts

1. Go to the List of Accounts and select Overdue from the Select menu.
2. Click in the Weeks column, then click the Z-A button on the toolbar to sort the

list from most to least overdue.
3. Visually scan the list and tick the Tag checkbox for accounts you wish to send

a reminder to.
4. Click the Print Accounts - Tagged button. If you like, review the messages to

be added to the account, then press the Continue button to complete the
printing process.

The following notes may assist to develop a strategy which works best for you:

· For a quick result, select the Overdue accounts and print reminders for all. The
overdue period (time after sending the account before it is deemed overdue) can
be set up on the Automatic functions page  of the Options form.

· Try filtering the list by using the Select > Advanced option, then insert a value
into the Accounts still unpaid after x weeks field. Entering a value of 4 would be
equivalent to obtaining a list of accounts which were still unpaid after 30 days.

· Try ordering the list by the payment status column to make it easier to determine
which accounts should be sent reminders.

· Scroll to the right in the list to review the # Rem column which shows how many
reminders have already been sent.

· Scroll to the right and review the columns labelled LastContactDate and
LastContactType. These will show how long it has been since the last reminder
or other contact. Order the list by the LastContactDate column to more easily
review the status.

Whenever an account is printed which is deemed a reminder, the Num reminders field
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on the Status page  is increased by 1. This is the field which is used to determine
which level of reminder message should be attached to the account.

7.5 Printing co-payments

When an account is sent to a health fund under that fund's No Gap arrangements, an
additional co-payment account may also be sent directly to the patient. Both these
accounts are actually managed from within one account in Access Anaesthetics,
according to which print button is pressed to produce the account.

To send an account to the health fund, follow the instructions in the Setting the
Fee  section and print the account by clicking the standard Print now button on the
bottom of the Account details screen. To print a patient co-payment account, enter the
co-payment amount into the appropriate field on the Fee page, and press the small
print button just near the co-payment amount field.

When receipts or reminders are printed, an alternative message (see Options, Health
fund page ) will appear in place of the standard message when any amount has
been received as part or full payment of a co-payment. Print co-payment receipts
using the same button that you use to print co-payment accounts.

Fund co-payments can also be printed for a batch of accounts
from the List of Accounts screen  by using the specific Co-
Payment buttons.    

Note For accounts to be recognised as having co-payments, there must be an
amount in the Co-payment field on the Fee page, AND the Account Type
must be the same as the Health Fund Fee. That is, the health fund fee
must be set as the main account fee.

7.6 Printing banking slips

A bank deposit slip can be printed directly from Access Anaesthetics to eliminate the
need to handwrite payments on bank stationery. Do this by pressing the Print Bank
Deposit Slip button on either the Main Menu  or the List of Payments  screens.
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Specify the banking date and the
number of copies required
(usually one for the bank and one
for you).

For unbanked payments, the
deposit date will be stored with
each payment when the deposit
slip is printed on the printer.

   

Once the deposit slip is printed and the banking date is inserted into the payment
records, there will no longer be any unbanked payments. Payments appearing on
bank deposit slips are defined by their date of deposit. If you need to print a copy of
bank deposits made on previous occasions, select a banking date from the drop down
list. It is assumed that only one deposit is ever made on the one day.

If you print one copy of the bank deposit slip and then wish to print another copy, you
will have to select the deposit date from the list of previous bank deposit slips. This is
because the banking date will have been inserted into the payments and they will no
longer be deemed unbanked.

Not all payments will appear on bank deposit slips. This is because not all payments
need to be physically taken to the bank and deposited. Only payments of type
Cheque, Cash, Credit card or Money Order will appear on bank deposit slips.
Payments of type E-Credit Card, EFT, Other, or any other type will not appear on
banking slips. Usually the banking date for these payments types will be inserted at
the time of entering the payment, instead of at the time of printing the banking slip. All
payments with the same banking date will, however, be included in any list of
payments printed using the Print this list button on the List of Payments screen .
See the Accounts - Payments chapter  for further details about payment types.

Cheque, credit card, money order and cash payments are listed in separate
categories on the bank deposit slip. Cash payments are totalled and printed as a
single summary amount. In contrast, cash payments are itemised separately when the
payments are printed using the Print this list button. Within these groupings, payments
can be sorted in different ways according to what is selected in the Options form on
the Banking page . You can also customise whether or not to print the patient's
name and account number on the list.

Once a banking date is stored in a payment, the payment is locked and can only be
edited by first unlocking it. This is to reduce the chances of having stored banking
details which do not match with previous printouts which have since become bank
records. See the Accounts - Payments chapter  for further details.
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8
List of Accounts

C H A P T E R

The List of Accounts screen allows the Access Anaesthetics user to get an alternative
view of the accounts by examining many accounts at one time. Each is shown as a
single row in a spreadsheet-like format. Multiple accounts can be printed at once,
overdue accounts can be easily managed and summary data can be produced for
practice analysis.
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8.1 What does the List of Accounts show?

The list of accounts is used for viewing, printing and analysing account information,
rather than for entering and editing data.

To navigate around the screen, use the vertical scroll bar to move up and down to
view the entire list of accounts, and use the horizontal scroll bar to scroll to the right to
show more information on each account.

The data shown in this form cannot be edited except for the Tag field. To edit the
data, go to the Account details view by clicking the Account details button on the top
right of the screen. This action will locate the same patient the cursor is currently on.
You can also jump to the Account details screen for any account by double clicking on
the account number or patient's name.

The New, Find and Options buttons have identical functions to those on the Account
details screen and are reproduced here for easy access.
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8.2 Which accounts are visible?

When you first open the List of accounts, only Open accounts are shown. That is, new
accounts which have not yet been sent or existing accounts which have not yet been
paid. Accounts are either Open or Closed according to whether they have a Date
account closed on their Payments page .

To view a different set of accounts (other than
Open accounts), choose an option from the
Select menu. This might be Closed accounts
to show all paid or all lost-cause accounts,
Overdue to show accounts unpaid after more
than a specified time, and so on. You can also
select according to discount status and
whether or not a co-payment account was
sent.

Advanced selection criteria  can be used to
view a more specific group of accounts.

The grey button on the top right of the screen
just under Main Menu shows which group of
accounts is currently being displayed and how
many of them there are.

Clicking the button will show you the SQL
(structured query language) query used to
select the records and gives you the option of
resetting the current criteria to show all the
accounts in the entire database.

   

If you would prefer the system to show all accounts, rather than just Open accounts
when it first starts, you may specify this in the Options form (Miscellaneous page ).

Note The accounts selected in this screen will also be selected in the Account
details screen. In this way, you can select a group of accounts, go to the
Account details screen and scroll through the selected accounts.
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8.3 Quick Filtering

It is possible to quickly
filter the list of accounts
using the 'Filter by
selection' button on the
toolbar.

Use the mouse to highlight the text you wish
to filter by, as shown at right. Then press the
Filter by selection button on the toolbar. Only
the records which match the selected text
will be displayed, as shown below.

   

Click the Remove filter button to reset the list
back to its original selection. Filters created
in this way work cumulatively, but are not
reproduced on printouts.

   

8.4 Sorting functions

  The A-Z and Z-A icons in the top menu bar allow you to sort by any column
in the displayed list. Click in the column you wish to sort by, then click either of the sort
buttons. This is useful for many purposes such as reviewing overdue accounts,
checking for erroneous data entry and examining fee variations.

The sorting order will be preserved when printing a list of accounts. If the sort order is
set from the ordering field in the Advanced Selection dialog box  this will take
precedence over the ordering which is set with the A-Z and Z-A icons. Preview the list

132



8.4.   Sorting functions >  

Copyright © 2003 HealthBase Pty Ltd 127

and modify the sorting order until you are happy with it.

8.5 Amounts billed, received, waived and owed

The fields on the bottom right of
the screen show summary
amounts for the accounts
currently displayed.

   

The Total Fee is the sum of all the fees charged for the listed accounts. If discounts
are in effect, the discounted fee will be tallied, not the undiscounted fee. GST is
included if applied. The amount Received is the sum of all payments received for the
listed accounts.

The amount Owing is the sum of the differences between the fee and the amount
received, for open accounts. It is assumed any amount owing is still to be collected.

The amount Waived is the sum of the differences between the fee and the amount
received for closed accounts. In other words, for closed accounts, any amount left
owing is deemed waived. This allows you to 'write off' an amount for accounts where a
partial payment is accepted as full payment, or where complete payment is not
expected for any other reason. Whenever you close an account (by entering a Date
Closed) which has an amount left owing, the residual amount owing will then be
deemed an amount waived.

Note that the list may show a mixture of both open and closed accounts. The amounts
waived and owing will still be accurate in this situation.

8.6 Printing accounts or the list itself

Before printing anything from the list, ensure you have selected the group of accounts
appropriately so that the accounts listed are the ones you are interested in. Use the
options on the Select menu, or enter criteria into the Advanced selection box . You
may additionally fine tune your selection by ticking the Tag checkbox for selected
accounts. You will later be able to print all accounts, or just the accounts you have
Tagged.

There are several printing options on the List of Accounts

· Print an account for each of the patients
· Print a co-payment account for each of the patients
· Print a list of the accounts in a list format
· Print a summary of the listed accounts
· Print a followup worksheet
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To print standard or co-payment accounts, use the
All Shown or Tagged buttons on the bottom left of
the screen, in either the Accounts or Co-payment
box. This will print an account for each record.

When printing accounts in this way, any accounts which have previously been printed
will receive a default message as described in the Printing accounts again  section.
You can review and adjust these messages after pressing the print or preview buttons
in the Print dialog box. If printing co-payment accounts, only those accounts in the list
which have a co-payment amount entered and which are otherwise designated a
health fund type account  will be printed. Any accounts in the list without these will
not be printed.

To use the List of accounts for sending overdue account notices, see the Printing
reminders  section.

Click the Print this list button to print all the displayed accounts in a
tabular format with each account in a single row (much like what is
currently displayed on the screen). Only the most important fields are
shown since only a limited number will fit on the landscape size report.

Printing a list of accounts may be useful for a variety of auditing reasons. Because the
data you print may include accounts selected in many different ways, when you
choose this printing method you are given the option of entering brief notes on the top
of the printed list. This will allow you to easily label what data is actually in the report.

Click the Followup worksheet button to print a report listing all the
patient's relevant operation and contact details, payments made,
current status and individual comments stored in the database. Blank
space is also provided for writing notes.

The followup worksheet is a report intended to be used when telephoning patients
about outstanding accounts. Some clients find it easier to print a list of the relevant
information rather than jump around the computer screen while telephoning patients.
Or, the printed list may be given to a third party to do the followup.

The followup worksheet will print all accounts shown on the List of Accounts screen
irrespective of whether they are overdue, paid in full or any other status. You must,
therefore, first apply appropriate selection criteria to limit the list to only those
accounts which require followup. This may be as simple as selecting Overdue from
the Select menu, or more specific criteria may be defined in the Advanced selection
criteria box.

Hint! You could also use this function to enable a person to manage your
outstanding accounts without a computer while you are on holidays.
Simply print a list of all open accounts and have your assistant manually
record payment (and other) details on the list.
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8.7 Printing receipts

After entering payments into each account, the Receipt tag is either manually or
automatically set. You can view all accounts for which the receipt tag is true by
selecting Receipts from the 'Select' menu. Then it is a simple matter to print all the
listed accounts to complete your batch receipting task.

For more information on receipting see the Printing receipts , Printing accounts
again  or Payments  sections.

Note Clearing the Tag field shown on the List of accounts by using the Clear
All Tags hotspot also clears the Receipt Tag for that account. Therefore,
print any pending receipts before resetting the tags.

8.8 Batch Header

The batch header is a summary page which may be used as a cover sheet when
sending multiple accounts to one payer. Most often, this will be used when sending a
batch of accounts to a health fund under their 'no-gaps' scheme.

First, select the accounts you wish to include in the summary on the List of Accounts
screen. Then select Batch Header from the Summary menu. The dialog box shown
below will appear.

Select the fund or other
organization you wish to send the
accounts to. The funds listed are
those stored in the Addresses
lookup table.

Specify the date of the claim
(default is current date) and
whether to itemise accounts and co-
payments.

Additional comments may be added
to the bottom of the page by
entering them into the Comments
field. These will be printed on the
current batch header, but will not be
saved anywhere.

Default options for the batch header
can be set up by clicking the Edit
details button on the top right.
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The batch header setup details are stored with the list of third party addresses. Open
the following window from the Tools > Edit Lookup Tables > Addresses menu option.
A batch header may be configured for any of the addresses you have in the lookup
list. Adjust the entries to suit your requirements. The button 'Insert default declaration'
adds a list of statements to the Declaration field. Some of these will be appropriate to
particular funds and some will not. You must customise these for each individual fund.
The default declaration is provided to reduce the amount of typing required, but no
guarantee of appropriateness is given.

8.9 Practice activity summary

The options on the Summary menu of the toolbar
provide cross tabulation summary reports of the
accounts currently displayed.

That is, they will provide a summary of the number
of accounts, their average fee, the average
amounts received, waived and owing and the
average time until closure of the account (listed as
separate columns).

   

This will be broken down by the grouping field you choose from the list, namely the
surgeon, hospital, operation, account type or payment status. Each specific value of
the field you wish to group by (e.g. all the surgeons who have done operations for
these accounts) will be shown in the leftmost column.
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The summary tables summarise the data currently on the screen. To get summaries
for data not currently visible, first specify selection criteria for the displayed accounts
using the Select menu or the Advanced selection criteria options. For example,
choose Overdue from the Select menu, then choose Surgeon from the Summary
menu. This will give you a list showing which surgeon's patients are the tardiest
payers.

Using this system you can produce very detailed and specific reports. For example,
you may show a list of a specific procedure performed in a particular hospital between
certain dates, and the total amount of money received and owing grouped according
to the surgeon. Experiment with different selection criteria and grouping fields to see
what can be done. There are endless combinations!

When you activate a summary report, you will be given the option of entering notes
you wish to have printed on the report. This allows you to label the report very
specifically so you don't have multiple reports where you have forgotten which shows
what. The notes appear on the top of the report printout (and preview) but not in the
initial spreadsheet form.

Aged Trial Balance report

The Aged Trial Balance report provides a summary of the total amount
outstandanding at various times after the accounts are sent. See the description  of
this in the List of Payments section for more information.

8.10 Edit in Excel

Click the Edit in Excel button on the menu bar to export the data in
the current list to an Excel spreadsheet file for further editing, analysis or printing. You
will be asked to supply a file name for the Excel file. This will be stored in the
Documents subfolder of your Access Anaesthetics folder (e.g. C:\Access
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Anaesthetics\Documents\MyExcelFile.xls).

This function allows you to export selected parts or all of your data to a spreadsheet
format for further analysis or to be read by other software packages. Only the columns
which are currently displayed in the list will be exported. To export additional columns,
first select a datasheet format  which includes the desired columns.

8.11 Advanced selection criteria

The List of accounts and
Account details screens
display accounts according to
your preferences. Usually this
would be Open accounts, or
other account types chosen
from the Select menu.

It is also possible to specify
advanced selection criteria to
refine the selection in a more
detailed way.

To do this, choose Advanced
from the Select menu to
display the screen shown here.

   

Entering criteria

Enter a single criterion into one field, or enter criteria into several fields. Multiple
criteria are automatically joined using AND (as opposed to OR) so that only accounts
which satisfy all entered criteria are displayed.

For 'from - to' fields such as dates and account numbers, the 'to' value is optional. If
you just enter a 'from' value without a 'to' value, only accounts with the specified 'from'
value will be displayed.

Open and Closed accounts refer to whether or not an account has a date in the Date
account closed field.

For text fields such as patient's name or surgeon, you may enter a word, part of a
word or more than one word. If you enter part of a word you could find, for example,
all patients whose surname includes 'Jen'. This would find Jenkins, Jennings and
Jenson. You may also select an option from the drop down list for some fields. The
patient's name field searches the patient's entire name, that is, a text string which
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includes the title, first name and surname. If you use the 'part of word' option, you
could find a specific patient by entering, for example, 'en Jen'. This would find Owen
Jenkins and Ben Jenson but not George Jenkins. Note that for fields with a drop-down
list, you can either choose an item from the list, or type directly into the field. Not all
available options will necessarily be included in the drop-down lists.

You can optionally select a sorting field to sort the list in either ascending or
descending order. This can also be done after the records are actually retrieved by
using the A-Z and Z-A buttons on the menu.

Applying criteria

After you have specified all the criteria you wish, press the Apply button. The relevant
records will be displayed and the Advanced selection form will disappear. If no records
are found which match your criteria, you will be given a message and allowed to
review your criteria.

Press the Clear button to remove all selection criteria and thus display all accounts.
The Advanced selection form will remain open for you to insert additional criteria, or
you may close it without applying new criteria by pressing the Close button.

Once criteria have been specified, they will remain in the form for you to modify later if
you wish. This is the case even though you may reset the accounts shown in the List
of Accounts without using the advanced selection form. For example, suppose you
use the Advanced selection form to display all accounts sent between 1/4/1999 and
31/8/1999, where the surgeon was Dr Z Smith and the hospital was St Jupiter's. Later,
you chose Overdue from the Select menu to show all overdue accounts. The next
time you open the Advanced selection form, the 1/4/1999 - 31/8/1999 dates, Dr Z
Smith and St Jupiter's criteria will still be shown even though the underlying list still
shows just the overdue accounts. You can either modify the selection criteria to your
needs, click the Clear button to reset the criteria or simply close the form without
applying the specified criteria. In the latter case, the existing selection (overdue
accounts) will be maintained.

The SQL option for expert users

When you specify selection criteria, you are actually creating an SQL (structured
query language) statement with a Where clause which contains the details of all
selection criteria in a string of text. This SQL text string is created automatically when
you choose an option from the Select menu or when you specify criteria in the
Advanced selection form. The SQL text string can also be edited manually without
using the Select menu or the fields on the Advanced selection form by simply typing
into the string itself. To do this, click the blue Edit SQL statement label on the
Advanced selection form. The SQL WHERE clause will appear and can be edited.
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After editing, click the Apply button
as usual to show the matching
accounts. Note that editing the
SQL statement directly will not
modify any of the data in the fields
on the Advanced selection form
and thus the form may not be a
true representation of the criteria.

   

The best way to use this function is to first add some criteria to the form fields, then
view the resulting SQL statement. You can then see the syntax which has been
inserted automatically and this will make it easier to determine how to modify it for
your own purposes. It is then quite easy to modify a field name, a criteria or add
additional phrases joined with AND or OR operators. The possibilities are endless!

Tip The 'Sort By' list box on the Advanced selection form shows all the fields
in the accounts table which may be used for selection criteria.

It is expected that most users would never use this option. It requires some
knowledge of the Microsoft Access Visual Basic language and is prone to errors if the
exact wording is not correct. It does, however, provide an additional level of
customisation for expert users who may wish to create reports using more specific
criteria than the Advanced selection form allows. If you get into trouble with this, just
click the clear button to reset all the criteria and start again.

8.12 Formatting the list

The List of Accounts shows a tabular selection of the data in the Access Anaesthetics
database. The records shown in the list are determined by the various selection
methods described in this chapter. Two other aspects of the list can also be
customised. They are 1) the font, font size and other other formatting options and 2)
which columns are displayed. You can adjust these by selecting Format Datasheet
from the Tools menu.
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Select a format and click Apply (or double click
the format). The properties of the selected
format will be applied to the list. These include
the font, font size, bold face, gridlines, and the
selection of columns.

The format will remain in effect until you select
a different format, or until you install an Access
Anaesthetics program update. In the latter
case, the format will revert to the <Standard>
format.

To create your own formats, or customise
existing ones, click the Customise button.    

The format higlighted will be that which is currently in effect in the list. You may modify
this format by adjusting the font options, or by adding to or removing columns from the
list. The <Standard> format cannot be modified.

To create a new format, click the Save as button to copy an existing format with a new
name. Then modify the properties of the new format.

Tips

· Experiment with different formats showing different columns. One group of columns
may be better than another when performing particular tasks. A format with just a
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few columns may be more easy to manage than one which requires horizontal
scrolling.

· Reorder the columns in a format to suit your own viewing preferences.
· If you have a high resolution screen, adjusting the font size may be desirable.
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9
List of Payments

C H A P T E R

The Payments list is the starting point for all financial reporting. You can do everything
from printing a bank deposit slip to generating a summary of income by surgeon over
the last financial year (for example). It is a dynamic screen, responding to your
preferences as to which payments to show, in what order, and how to summarise
them.

9.1 What does the List of Payments show?

The Payments list shows all payments entered into the system, one payment per row.
It looks much like the List of Accounts  except that there is one row for every
payment, rather than one row for every account. Use the vertical scroll bar to move
down to see more payments or the horizontal scroll bar to show more details about
each payment.

Since each payment is associated with an account (usually), the details of the account
are also shown in some of the columns on the right. Because there may be more than
one payment per account, the details for one account may appear in more than one
row of this screen.

Payments associated with accounts cannot be added or edited here. This must be
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done in the individual patient's Account details screen . Put the cursor in the row
you wish to edit and click the Account Details button on the top right of the screen.
(You can also do this by double clicking the account number or patient's surname.)
You will jump to the account for which the payment was made. If the account is not
included in the current selection of accounts, you will be given a message telling you
this. If you like you can then reset the selection criteria to show all accounts by
choosing the appropriate option from the Select menu.

Note Except when showing unbanked payments, the list does not show 'batch'
payments, that is payments which are divided up for distribution over
more than one account. Instead, the payments 'distributed' to individual
accounts are shown. See below for more details.

9.2 Selecting payments to display

When it first opens, the payments screen shows all Unbanked payments, that is all
payments where the banking date is blank (these are due to appear on the next bank
deposit slip). If there are no unbanked payments, all payments in the database will be
shown.

Select which group of
payments to display by
choosing from the
Select menu on the
toolbar.

Select according to the
time period when the
payments were
received or banked, or
use the Advanced
selection criteria to
limit your selection
using a number of
other fields.

   

The grey button on the top right of the screen just
under Main Menu shows which group of payments
is currently being viewed and how many of them
there are.     

Clicking on the button will show you the SQL (structured query language) query used
to select the records and gives you the option of resetting the current criteria to show
all the payments in the entire database.

29
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9.3 Quick Filtering

It is possible to quickly
filter the list of payments
using the 'Filter by
selection' button on the
toolbar.

Use the mouse to highlight the text you wish to
filter by, as shown at right. Then press the
Filter by selection button on the toolbar. Only
the records which match the selected text will
be displayed, as shown below.

   

   

Click the Remove filter button to reset the list back to its original selection. Filters
created in this way work cumulatively, but are not reproduced on printouts.

9.4 Sorting functions

  The A-Z and Z-A icons in the top menu bar allow you to sort by any column
in the displayed list. Click in the column you wish to sort by, then click either of the sort
buttons. This method of sorting will not necessarily be preserved when printing a list of
payments. If you wish to print the list in a particular order, set the ordering field in the
Advanced  selection dialog box. Preview the list and modify the sorting order until
you are happy with it.
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9.5 Miscellaneous payments

It is expected that most payments will be attached to individual accounts. However, it
is possible to enter a one-off payment not related to a particular account. This might
be from a hospital for a VMO sessional payment or a payment from any other
organisation.

Click the Add button on the
bottom of the screen just under
Miscellaneous payments to open
the window at right.

    
The data entry is identical to the
method for entering standard
payments  in an individual
account record. The usual
abbreviations, lookup tables and
shortcuts are all available.

    

Like standard payments, Miscellaneous payments can only be edited while their
banking date is blank. Once a banking date is inserted (manually or by printing the
bank deposit slip), the payment is locked and can only be edited by first unlocking it
with the Key button. If deleting a payment that has already been banked, you will
receive a louder than usual warning and the option to cancel the deletion. If you go
ahead with the deletion, the payment details will be stored in a separate table of
Deleted payments  for reference. These can be viewed (but not edited) by clicking
the Deleted Payments - List all button.

Miscellaneous payments can be identified in the list by the fact that they have no
associated Account Number. When the cursor is on a miscellaneous payment row,
the Miscellaneous Payment label on the bottom of the screen will appear in bold
yellow.

9.6 Batch payments

Batch payments are those where more than one account is paid using a single
payment. This may happen, for example, when you receive a cheque from Medicare
or Veterans' Affairs and it includes payments for several patients in the one cheque.

One batch payment is distributed across several accounts. When this is done, a new
payment record is created for each account which receives part of the batch payment.
Thus if one batch payment contains payments for 3 accounts, there are a total of 4
payments - one batch payment and 3 distributed payments. The three distributed
payments add up to the same amount as the 1 batch payment.

90
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So that these amounts are not duplicated in any reports, the batch payments are
included only in bank deposit slips or listings of unbanked payments, while the
Distributed payments are included in all other financial reports, effectively taking the
place of the single batch payment. In this way, the payment is never added up twice
and never omitted.

Identifying batch payments in the payments list

When the cursor is in a batch or distributed payment
row, the Batch Payment label on the bottom of the
screen will appear in bold yellow and the relevant
buttons will be enabled.    

Batch payments can be identified in the list because they have the code 'MP' in the
field MultiPaymentNumber in the extreme right column of the Payments datasheet
(scroll across with the horizontal scroll bar). Distributed payments have the payment
number (same as the receipt number) of the original batch payment in this field.
(Standard payments have nothing in this field.)

Once a batch payment has been deposited, it will disappear from the unbanked
payments list and will no longer be viewable in any standard financial reports. Instead,
the distributed payments will be shown. The batch payments themselves will however
be visible in the main Batch payments form which you can view by clicking the List all
button under the Batch payments heading in either the Payments list or on the
Payments page of an individual account.

For full details of adding, editing and reviewing batch payments, see the individual
account Payments section . Briefly, batch payments can be added, edited or
deleted by clicking one of the buttons shown above on the List of Accounts screen or
from an individual account's Payment page.
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9.7 Deleted payments

As described elsewhere, if you delete a payment which has already been banked, the
details of the deleted payment will be stored in a separate table of Deleted payments.

This table can be viewed but not edited by clicking the button on
the bottom of the screen. Normally banked payments would not
be deleted, except where a cheque has bounced. In any case,
this function allows you to keep track of any which have been
deleted.

While viewing the deleted payments list, standard scrolling, sorting and printing
functions are available but no data can be edited or deleted. The date and time each
payment was deleted is stored with each deleted payment.

Note Deleted payments cannot be restored from the deleted payments list.
They must be re-entered manually if required.

9.8 Printing a list of payments

Before printing anything from the list, ensure you have selected the group of payments
appropriately so that the payments listed are the ones you are interested in. Use the
options on the Select menu, or enter criteria into the Advanced selection box .

There are several printing options on the List of payments.

A bank deposit slip is a particular type of payment list which is
described in detail in the Printing banking slips  section.

This button prints a list of payments which may be useful for a
variety of auditing reasons as described below.

The Summary button prints a summary of the listed
payments . This provides a method of cross tabulation to
obtain totals for groups of payments.
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Use the Print this list option to print all the displayed payments in a tabular format with
each payment in a single row, much like what is currently displayed on the screen and
similar in appearance to the bank deposit slip. Because the data you print may include
payments selected in various ways, when you choose this printing method you are
given the option of entering brief notes on the printed list. This will allow you to more
easily label what the data actually is in the report. (Even the payments due to be put
on a bank deposit slip can be printed in a standard list if you wish.)

Notes When printing the list, cash deposits are itemised, unlike the summary
amount shown in bank deposit slips.

When the list includes batch payments, only the Distributed payments
are shown, not the original batch payments.

9.9 Payment reports

Payment summary reports
Aged Trial Balance
Group practice payment summary

9.9.1 Payment summary

Financial reports are provided by clicking the
Payment Summary option on the Summary
menu This opens the dialog box shown.

Specify whether to use the date received or
the date banked, and select a summary
frequency and grouping. Finally click the
Table or Report button.      

There are two viewing formats – table or report.

· The table format shows the results of the summary in a tabular spreadsheet
format. This is quickest to view, easiest to scroll through and can be re-sorted
by any column.

The table format looks like this ...
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· The report format is a neater layout for printing and includes subtotals and a
grand total. It looks like this ...
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The report format is restricted in the number of columns it can display. If only a few
columns are required, a portrait format will be used. For more columns, a landscape
format is used. If the landscape format is not wide enough to show all the columns
(maximum number of grouping columns is 9), the extra columns will not be shown. In
the table view, ALL columns will be shown no matter how many there are and you can
scroll to the right to view them all.

The summary tables summarise the data currently on the screen. To get summaries
for data not currently visible, first specify selection criteria for the displayed payments
using the Select menu or the Advanced selection criteria options. Using this system
you can produce very detailed and specific reports. For example you could view all
payments in the current financial year, grouped monthly by surgeon. Or you might
view the annual change in your payments from Medicare over the last 3 years.
Experiment with different selection criteria and report formats to see what can be
done.

9.9.2 Aged Trial Balance

Select the Aged trial balance report from the Summary menu on either the List of
Payments of List of Accounts screens. The dialog box which opens has buttons for
showing outstanding Accounts and Copayments separately. These are grouped
according to the account type so that total amounts due from particular creditors are
shown. A summary button shows the total amounts outstanding.

The aged trial balance report
shows a summary of the total
fees currently outstanding for
all open accounts.

There are no date criteria to
be inserted - all open
accounts are included.

   

The summary amounts are grouped according to how long it is since the account was
first sent. Totals are given for each 30 days up to 300 days. All amounts still
outstanding after 300 days are included in the 300 day total.
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The total amount outstanding broken
down by age is displayed by pressing
the summary (Sigma) button.

The dialog box stays on the screen
while the reports are being viewed
and the various buttons can be
pressed to view different results.
When the dialog box is closed, the
report datasheets are also closed.

     

9.9.3 Group practice summary

Multiple provider versions of Access Anaesthetics include the Group practice
summary report. This is a dynamic report which allows you to quickly get summary
information on the payments received by an entire group.
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Select the report from the Summary
Menu to open the dialog box.

Modify the selection criteria as you
wish then click the View data button
to display the results.

The defaults are set up to provide
the most likely set of criteria for
performing a daily summary for the
current day's activity.

The result will be a datasheet
showing the breakdown requested.

   

While the report is on the screen, the dialog box will remain open to enable you to
dynamically change the criteria and requery the report. This allows you to easily adjust
the output to what you require. Print the report using the toolbar icons.
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By specifying different date ranges, doctors and payment types, you can create a
summary of virtually any payment data.

9.10 GST

Most anaesthetists will not need to charge GST for their services. However, since
cosmetic procedures and some other payments for private work may attract GST, a
set of reporting functions have been included in Access Anaesthetics. Once enabled
in the Options form (Misc page ), columns for GST will appear in all appropriate
data entry screens, and listings of account and payments.

Click the GST
button on the List
of Payments
screen ...

to open the
screen shown at
right which
provides functions
for GST reporting.

   

The buttons in the window apply selection criteria to the underlying payments list so
that payments satisfying the criteria will be shown in the main screen. You can then
use the standard reporting options, or use the specific GST reports in the GST
reporting window.

The basis of the GST summary reports is the presence of data in two fields recorded
for each payment, viz

· GST - the amount of GST included in a payment, entered at the time a payment
is entered.

· GST -> ATO - the date on which the GST was paid to the Australian Taxation
Office, entered as described below.

176
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Entering a date into the GST -> ATO field is not required, although it will enhance your
reporting abilities. As payments are added to the system you can review those which
include GST by using buttons 2, 3 or 4. Initially all payments which include GST will
also be shown using button 1 since the date the GST has been paid to the ATO will
not have been entered. A function is provided to insert the date that the GST was paid
to the ATO, into each payment. This records the fact that the GST has been paid, and
would normally be done after the BAS reporting period for the quarter. To insert the
date, click the Pay GST button on the bottom left of the window. This will insert the
specified date into each payment. Thereafter, those payments can be reviewed using
button 5. As additional payments are entered, the total GST currently owed to the tax
office can be determined by using button 1.

Both brief and detailed summary reports of payments made to the ATO are provided.
These functions are not intended to replace your normal accounting methods, but are
provided as an aid to keeping track of GST in your accounts.

Note If you find that you have entered some incorrect GST -> ATO dates and
you wish to edit them, select a group of payments and reinsert the date
using the Pay GST function.

9.11 Edit in Excel

Click the Edit in Excel button on the menu bar to export the data in
the current list to an Excel spreadsheet file for further editing, analysis or printing. You
will be asked to supply a file name for the Excel file. This will be stored in the
Documents subfolder of your Access Anaesthetics folder (e.g. C:\Access
Anaesthetics\Documents\MyExcelFile.xls).

This function allows you to export selected parts or all of your data to a spreadsheet
format for further analysis or to be read by various commercial accounting software
packages. (Specific export formatting for individual accounting packages is not built in
to the system - this is left up to the individual user.) Only the columns which are
currently displayed in the list will be exported. To export additional columns, first select
a datasheet format  which includes the desired columns.152
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9.12 Advanced payment selection criteria

The List of payments screen
display payments according to
your own preferences. Usually
this would be Unbanked
payments, or specific time
periods chosen from the
Select menu.

It is also possible to specify
advanced selection criteria to
refine the selection in a more
detailed way.

To do this, choose Advanced
from the Select menu to
display the screen shown here.

   

Entering criteria

Enter a single criterion into one field, or enter criteria into several fields. Multiple
criteria are joined automatically using AND (as opposed to OR) so that only payments
which satisfy all entered criteria are displayed.

For 'from - to' fields such as dates and account numbers, the to value is optional. If
you just enter a from value without a to value, only payments with the specified from
value will be displayed.

New payments or Unbanked payments are those which have not yet been banked,
that is, their Banking date is blank.

Accounts and Non-Accounts refer to whether or not a payment is associated with an
account. Non-account payments are otherwise termed Miscellaneous payments
and are payments from a hospital or other institution which are not allocated to
particular patient accounts. They are defined by their not having an account number.

A third type of payment, Batch payments, cannot be specifically selected using this
form. Go to the Batch payments list  to get data on this type of payment (click the
List all button under the Batch payments heading on the bottom of the form). Note that
all payments distributed from a batch payment are treated as standard payments and
will be included where appropriate in any selection of payments.

For text fields such as surgeon or operation, you may enter a word, part of a word or
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more than one word. If you enter part of a word you could find, for example, all
surgeons whose surname includes 'Jen'. This would find Jenkins, Jennings and
Jenson. You may also select an option from the drop down list for some fields. Note
that you can either choose an item from a drop-down list, or type directly into the field.
Not all available options will necessarily be included in the drop-down lists.

You can optionally select a sorting field to sort the list in either ascending or
descending order. This can also be done after the records are actually retrieved by
using the A-Z and Z-A buttons on the menu bar.

Applying criteria

After you have specified all the criteria you wish, press the Apply button. The relevant
records will be displayed and the Advanced selection form will disappear. If no records
are found which match your criteria, you will be given a message and allowed to
review your criteria.

Press the Clear button to remove all selection criteria and thus display all payments.
The Advanced selection form will remain open for you to insert additional criteria, or
you may close it without applying new criteria by pressing the Close button.

Once criteria have been specified, they will remain in the form for you to modify later if
you wish. This is the case even though you may reset the payments shown without
using the advanced selection form. For example, suppose you use the Advanced
selection form to display all payments received between 1/4/1999 and 31/8/1999,
where the surgeon was Dr Z Smith and the hospital was St Jupiter's. Later, you chose
Received last month from the Select menu to show all payments received last month.
The next time you open the Advanced selection form, the 1/4/1999 - 31/8/1999 dates,
Dr Z Smith and St Jupiter's criteria will still be shown even though the underlying list
still shows just last month's payments. You can either modify the selection criteria to
your needs, click the Clear button to reset the criteria or simply close the form without
applying the specified criteria. In the latter case, the existing selection (last month's
payments) will be maintained.

The SQL option for expert users

When you specify selection criteria, you are actually creating an SQL (structured
query language) statement with a Where clause which contains the details of all
selection criteria in a string of text. This SQL text string is created automatically when
you choose an option from the Select menu or when you specify criteria in the
Advanced selection form. The SQL text string can also be edited manually without
using the Select menu or the fields on the Advanced selection form by simply typing
into the string itself. To do this, click the blue Edit SQL statement label on the
Advanced selection form. The SQL WHERE clause will appear and can be edited.
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After editing, click the Apply button
as usual to show the matching
payments. Note that editing the SQL
statement directly will not modify any
of the data in the fields on the
Advanced selection form and thus
the form may not be a true
representation of the criteria.

   

The best way to use this function is to first add some criteria to the form fields, then
view the resulting SQL statement. You can then see the syntax which has been
inserted automatically and this will make it easier to determine how to modify it for
your own purposes. It is then quite easy to modify a field name, a criteria or add
additional phrases joined with AND or OR operators. The possibilities are endless!

Tip The 'Sort By' list box on the Advanced selection form shows all the fields
in the payments table which may be used for selection criteria.

It is expected that most users would never use this option. It requires some
knowledge of the Microsoft Access Visual Basic language and is prone to errors if the
exact wording is not correct. It does, however, provide an additional level of
customisation for expert users who may wish to create reports using more specific
criteria than the Advanced selection form allows. If you get into trouble with this, just
click the clear button to reset all the criteria and start again.

9.13 Formatting the list

The List of Payments shows a tabular selection of the data in the Access Anaesthetics
database. The records shown in the list are determined by the various selection
methods described in this chapter. Two other aspects of the list can also be
customised. They are 1) the font, font size and other other formatting options and 2)
which columns are displayed. You can adjust these by selecting Format Datasheet
from the Tools menu.



9.13.   Formatting the list >  

Copyright © 2003 HealthBase Pty Ltd 153

Select a format and click Apply (or double click
the format). The properties of the selected
format will be applied to the list. These include
the font, font size, bold face, gridlines, and the
selection of columns.

The format will remain in effect until you select
a different format, or until you install an Access
Anaesthetics program update. In the latter
case, the format will revert to the <Standard>
format.

To create your own formats, or customise
existing ones, click the Customise button.    

The format higlighted will be that which is currently in effect in the list. You may modify
this format by adjusting the font options, or by adding to or removing columns from the
list. The <Standard> format cannot be modified.

To create a new format, click the Save as button to copy an existing format with a new
name. Then modify the properties of the new format.

Tips

· Experiment with different formats showing different columns. One group of columns
may be better than another when performing particular tasks. A format with just a
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few columns may be more easy to manage than one which requires horizontal
scrolling.

· Reorder the columns in a format to suit your own viewing preferences.
· If you have a high resolution screen, adjusting the font size may be desirable.
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10
Letters and Documents

C H A P T E R

Access Anaesthetics incorporates a built-in word processing system which allows you
to write letters to patients and third parties. You may create, edit and send standard
form letters with just a few mouse clicks and keep track of all correspondence within
the one easily-accessible location. While it lacks the features of true word processing
applications, it makes up for this in its ease of use and its ability to maintain a record
of all documents sent to particular patients.

10.1 Documents Page

The documents page of an individual patient account records details of accounts and
form letters sent to a patient. A similar page is opened from the Letters and
Documents button on the Main Menu. In this case, the letters and documents listed
are those which are not attached to particular patient accounts. These might be
documents related to your anaesthetic practice in general.

As well as recording letters and documents, you can store a reference to any external
document or web page, as described in the next section. Each document is either an
account (A), letter (L) or external file (X). You can optionally give each document a
category to better organise them, and you can filter the list by the category, thus
displaying only those documents which match the category selected.
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10.2 External documents

The Documents page (accessed from either the Main Menu, or from within an
individual patient's account) is able to record a reference to an external document.
That is, any file on the computer which is not an account or letter created by Access
Anaesthetics itself. To create a link to a document, click the Add button on the bottom
of the Documents page.
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Linking to a file

This will open the following
dialog box.

Use the file browse button to
locate the file you wish to
create a link to.

Then enter an optional
category and notes.

   

You are not limited to the categories in the list - you can simply type a new category
into the category field, or select <Edit Lookup List> from the list to add a new category
to the list so you can use it again later.

Linking to a website

To store a link to a web
address, type the entire web
address into the Folder name
field, and enter a description
into the File name field.

For web addresses, the File
name is ignored when
navigating the Internet.

   

On the main Documents page, the description will be visible in the File name field. To
see the actual web address, click the Show folder button at the top of the window.

Multi-provider Document Search

Multiple provider versions of Access Anaesthetics allow searching for documents
within all doctors' files at one time. This is useful if documents related to a single
patient are stored in multiple doctors' files on multiple occasions of service. Click the
search button on the bottom left of the Documents page and enter an account number
or patient's name. If searching from within an individual patient's account, that
patient's name will be inserted as the default search text. The following window will
open displaying the results of the search.
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Patients matching the text you enter are shown in the small blue box on the top left.
Select one of these to show the details of documents stored for this patient in the list
below. This shows the provider and account number where the records are kept.
Select a document and use one of the two button to either go to the selected account,
or to directly open the selected document.

By default, the search lists only external documents, that is all linked documents that
are not accounts or letters created within Access Anaesthetics. Untick the Show
external ... checkbox to show all documents.

While the search window is open, you can enter a different search text into the field at
the top of the screen to perform a new search.

10.3 The letter writing window

Click the letter button on any patient's Account details screen to send a
letter to that patient. If you want to send a letter which is not associated
with any particular account, click the Letter button on the Main Menu.

When the letters window is opened a new letter is created automatically and is
addressed to the patient from whose account the letter button was pressed. You may
simply type your letter text into the main body of the letter, then save, preview and
print it. If you do not save it, you will be asked whether you want to save or cancel it
when you close the form. This happens even if you do not enter any text since a new
letter is created automatically.
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Specify the name of the letter in the field on the top left of the screen. This will identify
the letter in the list of letters on this patient's Documents page. A default will be
inserted automatically, which will be the name of the form letter if a form letter is
inserted into the body of the letter (see below). Otherwise it will be 'Custom letter'.

The patient's name and address details are entered automatically. If you have entered
a third party billing address, you can toggle to and from this using the P and B buttons.
Also, you can select any third party address from the lookup list which contains the
same addresses as are available on the Patient Address page. If you open the letters
window from the Main Menu, no addressee details will be entered and you should
enter this manually.

Letters will be signed by default using the Salutation, Signature and Designation
specified on the Provider page of the Options form. If you have selected an alternative
provider designation for a particular account, this will replace the default designation.
You may need to scroll down to see the signature name.
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10.4 Letters already sent to this patient

All letters created for a particular patient are listed in the box on the top right of the
letters window. Re-order the list by clicking on a column heading. Clicking again will
reverse the sorting order. This may be particularly useful in locating letters which are
not attached to accounts, since there may be a long list of them.

Click on a letter in the letters window to display it. Once a letter has been printed, its
latest printing date will also be shown. You may edit the letter or, alternatively, make a
copy of a letter and edit the copy. If you have checked the Snapshot option ,
formatted copies of all letters printed will also be stored on the hard disk and be
available for viewing in the patient's Documents page . The snapshots may also be
viewed directly in the letters window by pressing the camera button. Whether or not
you keep snapshots of your letters, the names of letters sent (printed) will be listed in
the Documents page.

10.5 Form letters

To send a form letter, simply choose the letter text from the Form letter list. The
stored text will automatically be inserted into the main body of the letter.

If you are going to send a form letter, you should select the letter before doing any
other editing in the main body of the letter since the form letter text will replace any
text already stored there. In other words, if you start to type your own letter, then click
one of the form letters, the text you have already entered will be overwritten without
warning. There is an Undo button available on the form which may help in this
situation.

You can also save the text of any letter as a form letter by clicking the appropriate
button and giving the letter a name. In this way, you can type one letter, save it's text
as a form letter, then select it in the Form letters list to send to other people whenever
required.

To delete one of the stored form letters, first highlight it by clicking on its name in the
list. Then press the Backspace key on the keyboard. Note that the keyboard Delete
key (DEL) will not work.

To rename a form letter, make a copy of it and rename the copy as follows. Insert the
text of the letter you wish to rename into the current letter, click the button Save text
as form letter, and type in the new name. You may then wish to delete the letter with
the original name as described above. You can also use this method to create
additional form letters with minor variations in the content of the letter text.
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10.6 Formatting your letter text

The built in letter writer has limited formatting options in comparison to a word
processor such as Microsoft Word. It is effectively a text editor which is attached to
the database system. The emphasis of the letter writer is to quickly and painlessly
create and send standard letters to patients or third parties, and to keep track of the
letters in a database format. The latter is something you can't do with a standard word
processing program.

As a trade off, formatting of letter text using underlining, bold face, italics, line
centering and so on is not possible with the built-in letter writer.

Printer fonts

It is possible to modify the font and font size for printing letters by specifying these at
the bottom of the letter window. You may also modify the default font name and size,
which are stored in the Options form (Account format page ).

Only a small number of fonts are shown in the listbox, although any font may be used
by typing its name directly into the Font field. You can view the names of all your
available fonts in Microsoft Word or other similar programs and then type in your
preferred font. Similarly, you are not limited to the font sizes listed; any size may be
entered.

Spell check

Click the Spell check button to check the spelling of the body of the letter. A standard
Microsoft Office spell check dialog box will be shown. This will only work if you have
Office installed on your computer.

10.7 Writing your letters in Microsoft Word

If you wish to write letters in Microsoft Word to take advantage of its richer word
processing environment consider the following points:

· The sending details (date sent and type of letter) of letters written in Word will
not be stored in the Access Anaesthetics documents list so you will need to use
another method of keeping track of which letters were sent to which patients.
You can, however, make notes about having sent a Word letter in an individual
account's Notes page. You may, for example, specify the document's file name.

· You can write a letter in Word and then copy and paste it to the built-in Access
Anaesthetics letter writer. To do this, select the text in Word, press <CTRL>C (or
Copy from the Edit menu), switch to the Access Anaesthetics letter writing
window, click in the body text box and type <CTRL>V. The text will be inserted
into the current letter. You may wish to do this to create new form letters in Word
and save them in Access Anaesthetics. Note that formatting such as italics and
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underlining will not copy across to Access Anaesthetics.

· If you wish to edit an existing Access Anaesthetics letter in Word, display it in the
letter writer and press the Preview button. When the preview screen appears,
press the 'Edit in Word' button and the letter will be opened in Word as an rtf
(rich text format) file. You can then edit it as you please. Note that some
formatting is lost in the transfer to Word - notably lines do not transfer across so
your letterhead may look a little different. Also, carriage returns may be added to
the end of lines and this may prevent appropriate wrapping of text to the
following lines. You may also need to adjust the page margins.

Apart from the additional formatting features that Word offers, there is no real
advantage to using Word as your letter writer over the built-in system.
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11
Options

C H A P T E R

The Options form stores your preferences for how Access Anaesthetics operates. You
can specify your provider details, the unit values to be used in calculations, default
formatting options, payment instructions and a number of other features. The Options
form can be opened at any time with a specific button on the Main Menu, Account
details screen or List of accounts screen, using the Tools > Options menu, or with the
keyboard shortcut CTRL O. Options can be changed at any time.

11.1 Provider details

The provider details shown here will appear as the header for your accounts and
letters. Adjust the entries and preview the account letterhead with the button provided.
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· The data shown is an example only. You can rearrange the address and
telephone etc details to suit yourself using any of the available fields. However,
only the Name fields are shown in large bold type.

· The last line of the header (5th line) will only appear if you have selected the 5
line format on the Account Format page . It will be justified to the right, so if
you want items to appear on the left, you should add additional spaces to
achieve this.

· The default designation (e.g. Anaesthetist, Cardiac Anaesthetist, Medical
Perfusionist) can be chosen from a list or typed into the field. This can also be
changed for individual accounts.

· The optional account number prefix is intended for use with multi-provider
groups where identical account numbers may otherwise cause confusion. It will
appear on printed documents, but is not otherwise used in the system.

· If you don't want to use the built-in letter head for your accounts and letters you
can use paper with your own letterhead design. Select the blank letterhead
format from the Account Format page.

· The Restart account numbering button allows you to specify a new account
number to begin incrementing from. This will not affect existing accounts. The
maximum account number allowed in the database is 32,000.

11.2 Unit and time values

The numbers you enter on this page determine the fees that are set by default when
you create an account. It is possible to additionally modify some of these on individual
accounts. You need to keep these values updated manually and we will usually advise
you when to do this.

The default RVG value and the values for workers compensation and third party
accounts should be determined from your own practice and from the
recommendations of the ASA or AMA. The DVA values are for Veterans' Affairs time-
based payments.
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The Current items file shown on the bottom of the form displays the version of the
Medicare book which is currently in use for your program. This can be updated as
described in the File Management section . The items file contains the
recommended values of the RVG and DVA factors which are current at the time the
items file is current. You can check these rates by clicking the Check current rates
button above to open the window shown below, and insert them into your Options
form by clicking the Insert these rates ... button below. You should update these rates
when you are about to begin creating accounts using the new rates. Don't update
these rates if you still have accounts to create for procedures performed prior to the
starting date of the new rates.

In multi-provider versions of Access Anaesthetics, there is an additional button which
enables the rates to be changed for all data files in one process.

The default entries are those which were current at the time your program version was
created. Those shown here were current in November 2002.

179



Chapter 11.  Options

166 Access Anaesthetics Practice Management System

Note You need to update these values manually when they are changed by
the Health Insurance Commission since they are stored in your own data
file. Updates to the Access Anaesthetics system and MBS and RVG
books provided by HealthBase will not update these figures
automatically. We will however endeavour to alert you when these should
be updated.

11.3 Account format

Fields shown on accounts

These specify the defaults for new accounts and can all be changed within individual
accounts, either by adjusting the checkboxes next to the appropriate field, or those on
the account's Format page. Some of these were created in the pre-RVG era and
would not normally be used after Nov 2001. In particular,

· If you have created a list of both MBS and RVG items, you can include a brief
list of the alternative item numbers on the account. That is, for accounts which
show RVG items, the equivalent MBS item numbers can be shown at the
bottom of the list of RVG items and vice versa. They are shown in a single row
and only the item numbers are shown, no other details.

· Since ASA RVG accounts would previously have been used for some standard
patient accounts, the option to show the equivalent MBS items was provided
so that patients would have the best opportunity to obtain Medicare rebates.
This would rarely be required now.

· The option to not show item numbers on DVA accounts was included because
of problems where the DVA would incorrectly make payments by MBS
methods rather than by time-based methods. With the new A001-A007 items,
this is not an issue and all accounts should now include item numbers.
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Document formats

The standard account and letter formats print a built-in
letterhead with your provider information. Select one of
the letterhead styles from the two drop down lists.

Use the Blank Letterhead if you wish to print on paper
which has your own custom designed letterhead. Or
tick the 25 mm blank footer checkbox if your letterhead
has its own footer.     

For letters, you also have the option of choosing either a Short or Long letter format.
Choose Short if you want to space out a short letter over a whole page, and choose
Long if you need additional space to fit a longer letter on one page.

The other options are self-explanatory and may be tested using the Preview button on
this form, or on an individual account or letter.

11.4 Payment instructions

Payment instructions are printed at the bottom of each account in two columns. These
can be modified by editing the two fields provided. The entire footer (including optional
credit card or BPay details) can be previewed with the Preview button.

There is only one set of payment instructions and these are intended for individual
patients since, generally speaking, health funds and other institutions follow their own
payment methods. Consequently, by default, payment instructions do not appear on
DVA, Third party or Worker's Compensation accounts or health fund accounts. Nor do
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they appear on accounts where the fee has been paid in full, or on patient co-payment
accounts . These defaults can be modified for individual accounts on the Format
page. You may consider doing this for overdue accounts.

The payment instructions can include a dividing line, account number, patient name
and balance owing for use as a return payment slip.

Credit card payment details can be added to accounts by clicking the relevant
checkbox. Normally these will appear only when the payment instructions are shown.
The one exception is for patient co-payment accounts where credit card details will
appear even though no payment instructions are shown. This is because the standard
payment instructions do not appear for co-payments since Medicare and fund rebates
will not be applicable.

BPay Payments

BPay billing information can be included on the account. This must first be organised
with your bank. Access Anaesthetics allows printing a unique customer reference
number on each account. The system is managed as follows:

· Tick the checkbox to specify whether BPay details should be shown on the
account.

· Insert your BPay biller code.
· Insert your template for the customer reference number. This will be determined

in conjunction with your bank. You may specify the number of characters and the
identity and location of any fixed characters.

· The template must contain the code 'xxxxx' which will substitute for the account
number when the account is printed. This makes each customer reference
number unique. For account numbers less than 10000, a leading zero is added.
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· A Check digit as required by the banks is added automatically to the end of each
customer reference number for each account printed. This is calculated using
the Luhn Modulus 10 (MOD10V01) method.

· The customer reference number is stored in each account when the account is
printed (not previewed). It only exists if it has been printed on an account. If it
exists, it is displayed on the bottom of the Payments page .

· The customer reference number cannot be edited. Rather it is automatically set
during the printing process according to the template, the account number and
the Check digit.

· Printed Accounts will display the BPay details at the bottom. If credit card
payment details are also shown, a significant amount of the bottom of the
account is used, and accounts which have a number of items may spill over onto
a second page. Where this happens, the payment instructions including credit
card and BPay details will be shown on bottom of the second page.

· BPay details, like credit card details, are only shown if the Payment Instructions
are shown, except for patient co-payment accounts where the BPay details will
be shown in any case if the BPay checkbox is ticked.

· A button is provided to create sample BPay numbers using the template you
have specified.

Note When sending a receipt or copy of an account, the payment instructions
are omitted if the account has been paid in full or has otherwise been
deemed closed. You can override this convention in the account's
Format page.

11.5 Fund co-payment

When separate accounts are sent to a health fund and a patient for the one
anaesthetic service, the patient co-payment account does not show the list of items
which appears on the fund's account. Rather, it shows a customised message which
is set up using the text shown below.

The co-payment account is printed using the small print
button near the middle of the Fee page. This button is
used for both accounts and receipts for the co-payment.
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· Both a Paid and an Unpaid message are available. The Paid message appears
when the co-payment is partly or fully paid, otherwise the unpaid message is
shown.

· Substitution codes may be inserted in the text to have the relevant patient's
account data appear on the printout.

11.6 Discounts

The default discount label on printed accounts is Discounted Fee. Other
recommended labels are Reduced Fee or Early Payment Fee. You may have to enter
several spaces to the left of the text so that the label lines up correctly with the Fee
label on the printed account. Test this by viewing a preview of a discounted account
and adjusting the spaces as required. The label specified here will appear on all
discounted accounts.

Discounts can be set on the Fee page for any account. When initially inserted on an
account, the discount message will be as specified here in the Options form. Adjust
this to the message you will most often use. It can later be modified on individual
accounts after the discount is set. Use the # character here to substitute for the expiry
date on the actual account message.

Specify the Number of days before a discount lapses. Then, when Access
Anaesthetics opens, the discount expiry date is checked against the current date and,
if appropriate, the discount is disabled while retaining the discount information for
reference. A suggested starting point is 21 days. Some clients recommend using a
shorter time, say 10 days, to encourage patients to pay the account prior to obtaining
Medicare and fund rebates.
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If you do not want to
have the discounts
expire automatically,
set the number of
days until the
discount lapses to
zero.

Tick the Don't
automatically...
checkbox if you
wish to keep
discounts on part
paid accounts.

   

11.7 Banking

Enter your bank account details if you would like them to appear on the top of bank
deposit slips. If you don't want the details to appear, leave this field blank.

You can specify whether or not to print the patient's surname and account number on
bank deposit slips. These details are useful for your own accounting and checking
purposes, but you may prefer not to provide this information to the bank.

Select the fields to use to sort the bank deposit slip. Cheques, credit card payments
and money orders will appear in separate categories, each category sorted in the
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order specified here. Cash payments are totalled and displayed below all the other
payments. If you need an itemised listing of cash payments, use the Print this list
button on the bottom of the List of Payments .

11.8 File management

Snapshots

We recommend that you check the option to save snapshot files of all accounts and
letters. This is effectively like making a photocopy of each account after sending it,
because the snapshots provide an exact image of the account as it was when it was
printed. Since these cannot be edited, they provide a valuable record.

Snapshots are stored in a subfolder called Snapshots within your main Access
Anaesthetics folder (e.g. C:\Access Anaesthetics\Snapshots). You can view stored
snapshots in an individual account's Documents page . If you cannot create or view
the snapshots you should install the free Snapshot Viewer from Microsoft. This is one
of the separate applications provided on the installation CD. (Some versions of Office
2000/2002 include the snapshot viewer, although it may not be installed by default.)

Automatic backups

It is a good idea to have the system do an automatic backup each time you start an
editing session so that you always have something to fall back on if any problems
occur during an Access Anaesthetics session. This will save the last 2 versions of the
User data file (AAUser.mdb) to a separate file name on your hard disk (in your Access
Anaesthetics folder) when you start up the system. The most recent will be given a file
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extension of .bk1, and the older file will be designated .bk2. In the unlikely event that a
problem occurs, you can easily go back to the most recent backup with very little loss
of data. Specify a name for the backup file in the File Management page of the
Options form. This process should not be used as a substitute for the essential
manual backup process.

Manual backups

It is ESSENTIAL that you also make regular manual backups onto a removable disk
to safeguard your data. The folder and file name shown here will be used as the
default backup location when you do a backup from the File Management menu. You
can specify any folder and file name on a hard, floppy, zip disk, CD or network
location. Go to the File Management Menu from the Main Menu to perform a manual
backup .

If you would like to be prompted to do a backup before closing Access Anaesthetics,
tick the appropriate checkbox. You can also specify a time within which you should not
be prompted if you have recently done a backup.

11.9 Automatic functions

The following options will affect the data entry process

Inserting a new surgeon, hospital or operation

Each time you type a surgeon, hospital or operation into a patient's account, the
system looks to see if it exists in the appropriate lookup list (e.g. the list of stored
operations). If it doesn't exist, a form will pop up asking you for details of the surgeon,
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hospital or operation to be stored in the list. This is useful if you want to store new
names for future reference. However, since anaesthetists typically do many
operations a small number of times each you may not want to store all the operations.
Similarly, if you do a lot of cases with many different surgeons, you may not want to
store them as a routine. In these cases, having the form pop up each time may be a
bit annoying. You can disable this feature by unchecking the relevant box in the
Editing section.

Note This process doesn't happen if you enter a surgeon, hospital or operation
abbreviation or if you choose one from the lookup list. See the
Operation  section for more information.

Copying operation details

There are two copy buttons  on each account's Operation page to copy the
operation details from one account to another to streamline data entry for commonly
performed procedures. The detailed copy function can be customised by specifying
whether or not it should copy the surgeon, hospital and operation date (as well as
copying the operation, item and fee details). If, for example, you do a list of several of
the same type of procedure, say colonoscopies, you may prefer to copy the surgeon,
hospital and operation date. If you mainly use this function to copy operations done in
other hospitals by other surgeons on other days, it would be better to uncheck these
options. Of course, they can all be manually entered or removed as appropriate in
each individual account. These options do not affect the Quick Copy function; this
always copies the surgeon, hospital, operation and operation date from the previous
account.

Capitalisation

If checked here, when names and addresses are entered into an account, the first
character of each word is automatically capitalised. This means you don't have to use
the Shift key when entering the data. If you wish to enter a name with a lower case
first initial such as 'van de Someone', turn this function off, enter the data, and then
turn the function back on. If you choose to leave the automatic capitalisation off, you
can capitalise name and address fields by double clicking on them with the left mouse
button.

Some clients also prefer to show the surname and/or suburb in all capital letters and
this can be specified here. Note that in most instances, the suburb inserted from the
lookup list will already be capitalised since this is how it exists in the Australia Post list.

Insertion of item details

Normally when you enter an item number into an account's Items page, that item's
details are entered for you. This option can be disabled by switching off this checkbox.
The reason you may want to disable this is so that you can have greater control over
what appears in the items list. For example, you may wish to enter an item, then
remove its item number without removing the procedure and fee details. Or you may
wish to be completely free to enter whatever you wish into the item number fields
without having the system look for matching items. We would expect that you would

45

49



11.9.   Automatic functions >  

Copyright © 2003 HealthBase Pty Ltd 175

only disable this function in very unusual circumstances.

If you have disabled this function, you can still insert the item details from either the
MBS or RVG book by clicking the Insert item from book button on the Items page. And
you can always add the item directly while viewing the book.

Prolonged anaesthesia calculation

The prolonged anaesthesia calculation was used in the pre-RVG era and is no longer
required. It is left here for backward compatibility. The post- November 2001 multiple
anaesthetic rule (where the base unit value of the second anaesthetic procedure is
discounted to zero) is calculated automatically irrespective of the setting of this switch.

Automatic ordering function

When entering items on an account's Items page, the list of items is ordered
according to built-in rules . In most cases this ordering will be satisfactory, and
minor adjustments can be made by adjusting the ordering codes in the leftmost
column. It is possible to disable the automatic ordering so that items simply appear in
the order they are entered. It it then up to you to specify your preferred ordering. If you
do disable this function, it can be activated for individual accounts by pressing the
Auto Order button on the Items page.

Automatic data check

The data check can be run manually from the Account details screen, or you can have
it activated automatically just prior to printing the account. In the latter case, you will
be alerted to any high-priority errors, but not low-priority errors, before printing
proceeds. You can switch the automatic check on or off in the Options form (default is
on).

Automatic status functions

These three fields allow you to specify how long after an operation the account should
be sent, how long after sending an account before it is deemed overdue and the
amount the payment may be short while still being deemed paid in full. These control
the automatic status changes in the system which are updated each time the system
is started.

Note The system will not automatically print accounts, receipts or reminders
which are due for printing. The automatic status functions simply change
the phrase shown in the Status field to allow you to identify which
accounts are ready for certain processes.
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11.10 Miscellaneous

The Miscellaneous page is used for configuration items which do not fit elsewhere.

Show open accounts

If you tick this box, when you first open the Account details or List of Accounts
screens, only accounts which are currently open will be shown. That is, accounts
where the Date Account Closed is blank. This will be the most practical option for
most users. If unchecked, all accounts in the database will be shown.

MBS/RVG Book filtering

The MBS book can be filtered to show either the Entire MBS list of items (approx 5000
items), the Anaesthetics items (approx 700) or My Own List items. My Own List items
are those where you have ticked the checkbox or where you have modified the
description. The Anaesthetics or My Own lists will be most useful most of the time, but
may not include all items you wish to use. You can easily toggle from one filtering type
to another while using the book; this option simply specifies which list to open when
the program starts. The RVG book can show either the Entire RVG or My Own List.

Postcode defaults

When you enter the suburb of a patient's address, the relevant postcode is
automatically inserted. Since some suburb names exist in more than one state,
entering a suburb may find a postcode in a state other than the one you want. Specify
here which state should be used first for looking up postcodes. The relevant postcode
will be inserted and any other matching postcodes will be available for selection in the
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dropdown list on the suburb field.

If your practice is in a country town and most of your accounts go to the same
postcode area, you can specify a default postcode to insert into new accounts. If you
do this, be careful when sending an account to an out-of-town person.

Button autofocus

When switched on, moving the mouse over a button highlights the button. In other
words, it Sets the focus to the button. This can make the system a bit easier to use
but may cause some focus-related problems when entering data.

To-Do list

Upon system startup, the To-Do list will be opened in compact or detailed format as
specified here. You can toggle to the alternative view at any time.

System sounds

Turn the built-in sounds on or off using the checkbox.

Enable GST functions

Tick the Enable GST checkbox to have the system show GST related functions. This
will display appropriate fields in the various parts of the system where GST can be
entered or reported on. When unchecked, most of the GST fields will not be visible.

Tick the GST Free note checkbox to have 'GST FREE' displayed whenever a GST
free account is printed. If the Enable GST checkbox is unticked, the GST FREE
message will not appear.

Prompt for number of copies

Tick this checkbox if you would like to be prompted for a number of copies to print
when printing from a preview window. If you leave this box unticked, one copy will be
printed without prompting.

Resizing the Access Anaesthetics window

If you are using a high resolution monitor (1024 x 768 or greater), this option will allow
you to save the size of the Access Anaesthetics window so that the next time you
open the system, it will size itself to your preferred window size.

Sending troubleshooting information

Click this button to send configuration information to HealthBase by email for
troubleshooting. Owing to a Microsoft bug, this may cause the program to crash if you
are using Access 2000 (not Access 97 or runtime).
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12
File Management

C H A P T E R

This section explains how to perform data backups, change passwords, select items
files, and perform general housekeeping on your Access Anaesthetics installation.
This is essential reading for all users.

12.1 File locations

The File Management Menu is opened by clicking the similarly-named button on the
Main Menu. This screen provides access to backup and other utility functions that will
be required from time to time and shows the locations of the main files used in the
system and the location and time of the last backup.

If you have installed the system in the default folder C:\Access Anaesthetics, the main
files are as shown below. There is no obligation to install to the default folder, but it will
make upgrading the system easier. For single user systems, the various data files
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(user, items funds etc) must be in the same folder as the program file. For multi-users
systems (unlimited users), the data files can be located on a shared network folder.

Program file AA97.mde for Access 97 or runtime installations
AA2000.mde for Access 2000 or XP installations
This file is the user interface which operates all the functions of the
system.

User file AAUser.mdb. This contains all the data including the account
records, letters, payments and setup information such as the
provider's letterhead.

Items file AAItems2003_May.mdb. This contains the Medicare schedule, ASA
RVG schedule and postcodes.

For multi user installations, the User file is split into two separate files.

User file DoctorName.aau. Contains all the account and setup data for one
doctor. There is one of these files for each doctor.

Site file AASite.mdb. Contains the various lookup tables which are common
to all doctors in the multi-user group. There is only one of these files
per group.

Additional files include:
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AAFundsWith
RVG.mdb

Contains the health fund fee schedules.

RegNum.txt Contains your registration number.

DataPath.txt Is a reference to the data location for multi-user systems.

.snp files Snapshot files containing images of accounts and letters. Stored in
the Snapshots subfolder of your Access Anaesthetics folder.

.doc or .xls Word documents or Excel spreadsheets which you have exported.
These are stored in the Documents subfolder of your Access
Anaesthetics folder.

.zip Compressed files created with Winzip as backups of the user file.

.wav files Files which generate sounds.

.bmp files Picture files

.ico files Icon files

.hlp files Windows help files

.chm files HTML help files

.old files Old user data files which have been upgraded. May be deleted.

System.mdw MS Access workgroup file. May be in a different folder.

The program, items and health fund files need updating from time to time as
described below. The User file contains all entered data and is the only file which
needs to be backed up (multi user installations need backups of all the
DoctorName.aau files and the AASite.mdb file). All other files can be easily replaced
from the CD or website if required.

All Access database files are supplied in Access 97 format with the exception of the
main program file AA2000.mde which is in Access 2000 format. This file is
satisfactory for both Access 2000 and XP users and can read data from Access 97
files without conversion.

Contents of the data files

Each data file contains a number of tables with the subscript T. They are listed here
along with a brief description of the data they contain. Data stored in the site file is
accessible to all users in a multi-user installation. The single user file AAUser.mdb
contains all the listed tables from both the .aau file and the site file.

For multiple provider installations, the location of the various data tables has special
significance. When you change data which exists in the User file, it is changed for that
file only. When you change data which exists in the AASite file, it is changed for all
files in the group. This means that when a new surgeon is added, that surgeon is
available for all other doctors to add to their accounts. Generally speaking, all 'lookup'
type data such as surgeons, hospitals, operations, items and their abbreviations,
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health funds, banks, messages, addresses, form letters and so on, will be available to
all doctors in the group. The one table which will not always be clear is the SetupT
table. This contains all the doctors own settings and changes to this table (usually via
the Options form) will affect the selected doctor only.

User file (e.g. John Smith.aau) - Changes to data here affect the individual doctor
only

AccountDetailsT List of items on an account

DocumentListT List of documents printed for a particular account

PatientsT List of all accounts

PaymentsDeletedT List of deleted payments

PaymentsT List of all payments

PaymentStatusLogT List of changes in status of an account

SetupT Setup options for the provider

Site file – AASite.mdb - Changes to data in these tables affect all doctors in a group

AddressesT Third party addresses e.g. DVA and health funds

BankBranchesT Bank branch names

BanksT Bank names

DesignationsT Designations of the anaesthetist, surgeon, hospital and
operation

FormLettersT Text of form letters

FundFeesUserT List of health fund fees created by the user

FundNamesT List of cheque drawers, and their bank and branch details

FundsT Short list of health funds shown on the PtData page

Help_UserT Customised tips which are created by the user

HospitalsT List of hospitals

ItemAbbrevT Custom abbreviations for item descriptions

MessagesT Messages which appear on account

OperationsT List of operations

QuickItemLookupT List of items which can be quickly added to accounts

QuickNoteLookupT List of notes which can be quickly added to accounts

StatusPhrasesT List of phrases which describe current status of an account

SurgeonsT List of surgeons

TimeBasedSchemesT Details of time-based fee schemes such as the Vic WC
scheme

ToDoListT Items in the To-Do list
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12.2 Data backups

Caution It is ESSENTIAL that you regularly back up your data file(s). In the event
of theft or damage you can always replace your computer and get a new
version of Access Anaesthetics, but you may never be able to replace
your data.

Points to note

· Don't underestimate the importance of having an adequate backup. One day you
will need it.

· You should back up your data at least once for every day you use the computer.
· You can back up either to the computer's internal hard disk or to any other

removable storage medium such as a floppy disk, zip disk, removable hard disk
or rewriteable CD.

· A hard disk backup makes data recovery very simple, as it just requires copying
the backup files back again. However if the computer is stolen or damaged, the
backup will also be lost.

· A removable backup is required where the computer has been stolen or
damaged. Removable disks should be stored in a separate location to the
computer after the backup is complete.

· DO NOT perform a backup if you suspect your current data may be corrupt.
Performing a backup will simply overwrite what may be your only good data with
bad data.

· Removable backup disks should be handled carefully to avoid damage. It is a
good idea to keep several sets of backup disks in case one should fail. For
example, you could have a separate backup for each day of the week.

What data is backed up and how?

All data on your accounts, payments and custom setup options are stored in a single
file. This is the only file you need to back up. This file is called AAUser.mdb. The main
program file (AA97.mde or AA2000.mde) and associated files do not need to be
backed up since they can always be reinstalled from the Access Anaesthetics CD.
Similarly, the Medicare and RVG items files do not need to be backed up as copies
will always be available from us.

For multi-user installations, all the individual doctors data files need to be backed up,
that is all files of the format DoctorName.aau. Additionally the Site file, AASite.mdb
should be backed up.

The built-in backup system makes an exact copy of the data files. This contains all
data from when the system was first installed. There is no provision for making
incremental backups or of specifying a subset of data to back up.

Data which is not automatically backed up

The built-in backup system copies the entire database of your accounts as one file.
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However, it does not copy the additional documents you may have optionally created
while using the system. This includes Snapshot files and any Word or Excel
documents you may have created by exporting data from the system.

To backup these files, use Windows Explorer to copy the entire contents of your
Snapshots and Documents sub-folders. If you accepted the installation defaults, these
folders would be named C:\Access Anaesthetics\Snapshots and C:\Access
Anaesthetics\Documents. To restore these files, simply copy the entire folders from
their backup location to your Access Anaesthetics folder.

12.2.1 Performing a backup

All manual backups are performed from the backup window
which is accessed using the Backup data files button on the File
Management Menu.

Standard backup

Enter the location of the file to backup to. A default file name will be specified. You
may accept this, type in your own preferred folder and file name, or use the Browse
button to locate a folder and file to backup to. Press the Backup button to commence
the backup. You will be warned if you are about to overwrite an existing file, and you
would probably normally wish to do this if you are copying to a disk which has
previously been used for backups. A message will be shown when the backup is
complete.

The standard backup creates an identical copy of your data file containing all
accounts, payments and setup options for your system. If using floppy disks for
backups, be aware that the standard backup system cannot span multiple disks. If the
backup file becomes too big for one floppy disk (1.44 MB), attempting to backup to a
floppy disk will fail.

The time will come when one floppy disk is not sufficient to store an entire backup and
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you should plan your hardware resources to accommodate this. Depending on how
much data is stored with each account, one floppy disk should hold between 500 and
800 accounts. If using floppy disks, once the file gets too big for one disk, the first
option may be to use a compression program like Winzip to store more information on
each disk.

Tip To streamline backups, you can save a particular folder and filename as
the default location for backups. To do this, specify the folder and
filename as described above, then click the 'Click here to …' button just
below the file name field on the backup dialog box. The next time you
wish to make a backup, your specified file name will be inserted as the
default. This backup location is stored in the Options form (File
Management page ) and can also be edited there.

WinZip backup

The proprietary program Winzip (Nico Mak Computing Inc.) compresses files so that
much more data can be stored for the same file size. This is one of a number of
similar file compression programs which can be obtained from many Internet sites.
Access Anaesthetics supports the use of Winzip such that, if you have Winzip 7 or
later installed, you can use the Winzip backup button to create a compressed backup
file. This will store about 4 times as many accounts as a standard backup for the
same file size thus enabling you to fit a lot more accounts on a single floppy disk.

If you do use Winzip, the Winzip backup process is just as easy as the standard
backup, requiring just a few mouse clicks. Perform the backup in the usual way, but
click the Winzip backup button instead of the Standard backup button. The Winzip
dialog box will appear while the backup is proceeding.

Another advantage of using Winzip is that it will save a single file across multiple
floppy disks if the file is too big for one disk. To do this, you need to specify a floppy
drive for the backup location. If you create the backup on your hard drive and then try
to copy it to a floppy disk using Windows Explorer, it will not be able to span multiple
disks.

Note that Winzip is not created by HealthBase Pty Ltd. We cannot give or sell you the
program and cannot install it for you. It is up to you to obtain, install and evaluate it
and, if you wish to keep using it, pay to register it according to the instructions in the
Winzip documentation. An evaluation copy of Winzip can be downloaded from the
Winzip website (www.winzip.com).

Note also that there is no reason why you can't use any other file compression
program instead of Winzip. You can. Just make your standard backup as usual and
run your compression program on the backup file. Its just that Access Anaesthetics
will do this for you automatically if you use Winzip.

Multiuser Backup

The Standard and Winzip backups will copy the current user's data file. For multiple
provider installations, this has the disadvantage of having to do a separate backup for
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each doctor, and the problem that the AASite.mdb file is not backed up. To get around
this, the Multi-user Backup function copies all data files and the site file into one single
zip file.

Follow the
instructions
above for the
Winzip
backup, but
use the Multi-
user backup
button.

Your zip file
should then
look something
like this.

   

An important point to note with this process is that the default backup location is
stored in the individual user's data file and may initially be different for each user.
Consequently, the default backup location will vary depending on which user file you
have open when you do the backup. It is advisable to set all the default backup
locations to the same file when using the Multi-user backup system. To do this, open
each user file in turn, go to the File Management page  in the Options form, and
specify the correct backup location. You may also like to tick the checkbox to prompt
for a backup before closing the system.

Notes

After setting up the file locations for the first backup, subsequent backups are simply
done with a few clicks - File Management Menu > Backup data files > Standard
backup > OK.

Depending on how much data is stored with each account, one floppy disk should
hold between 500 and 800 accounts without being compressed. With compression,
perhaps 2000-3000 accounts will fit on a single floppy disk. By spanning multiple
disks, there is theoretically no limit to how many accounts may be backed up in this
way. In practice, however, a storage medium with a larger capacity than a floppy disk
may be more convenient. We recommend a zip drive, super disk, rewriteable CD or
removable hard drive in the longer term for more substantial storage solutions.
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12.2.2 Restoring data from a backup

Because a standard backup simply makes an identical copy of the single data file
AAUser.mdb, all that is required to restore a backup is to move and/or rename the
backup file back to your Access Anaesthetics folder and restart the system. Ensure
you know which file is the one you want to restore and which file you are replacing.
Avoid overwriting any files you may want to use later.

To restore a backup file:

1. Close Access Anaesthetics if it is open and start Windows Explorer .
2. Rename or move (rather than delete) the current AAUser.mdb file in your Access

Anaesthetics folder (e.g. rename to AAUserOLD.mdb) in case you need it later.
This is the old file you want to replace.

3. Move your backup file to your Access Anaesthetics folder if it is not already there.
You will be prompted to overwrite the current AAUser.mdb file if you have not
already moved or renamed it.

4. If the backup file was created with Winzip (it will have the file extension .zip rather
than .mdb). Use Winzip or another file compression program to uncompress it.

5. If the backup file is named something other than AAUser.mdb, rename it to
AAUser.mdb.

6. Restart Access Anaesthetics and the data in the backup file will be reattached
automatically and will be available for use.

7. Once you have verified that the data in the backup file is OK, you can delete the
old version of AAUser.mdb that you earlier renamed to AAUserOLD.mdb.

Notes If you have used Winzip (or another file compression program) to make a
compressed backup file, you will first need to uncompress the zip file
before re-attaching it to the system. The easiest way to do this is to
double click on the zip file in Windows Explorer. Unzip the file to your
Access Anaesthetics folder and rename it if required to AAUser.mdb as
described above.

For multiple user installations, restore one or more of the DoctorName
.aau files and/or the AASite.mdb file from the Winzip backup file.

12.3 Adding a password

Your data file starts out without a password and anyone with a copy of Microsoft
Access can read the data. If you add a password, no-one but you will be able to view
the data. However, if you forget your password, not even you will be able to view your
data, so be careful to keep a record of your password (not on the computer
obviously).

When a password has been applied to a data file, you will be required to enter it
whenever Access Anaesthetics is opened. If the correct password is not given,
Access Anaesthetics will not be able to attach to the data file. Additionally, the
password must again be supplied when some file management tasks are performed,
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for example, compacting the data file (see below). A password protected data file also
cannot be opened outside the Access Anaesthetics system by using the Microsoft
Access application itself.

To add or change your password, click the Change Password button to open the
password dialog box. To add a new password, enter it into the two fields, leaving the
current password field blank. If the data file already has a password assigned, you will
have to enter the current password before you will be able to change or remove it.

Notes When you create backups of a password protected data file, the backup
files inherit the password.

Passwords are not suitable for use in the multi-provider versions of
Access Anaesthetics since they must be entered each time a data file is
opened and since they prevent the use of the multi-provider patient
search function.

The database password is not a particularly good method of data
security and can be bypassed by people with password cracking
programs obtained from the Internet.

12.4 Compacting data

During use, data files can become fragmented, increasing their size and slowing the
rate at which information can be found. Use the Compact option to regularly compact
the current user data file to improve the efficiency with which data is stored. To
compact the data file, click the Compact button and follow the instructions.

When should data be compacted?

The frequency with which you need to compact your data file varies with its usage
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pattern. If you use the system intensively, it may be wise to compact each time you
start up or just before you close down. If you use the system infrequently, you may
find a monthly or six monthly compact is sufficient. You can get a hint as to how
effective it is by looking at how much the file size shrinks when the compact is done.
This is displayed immediately after the compact process is completed. File size is not
the only determinant, however, since compacting re-aligns indexes and make the data
file more efficient and data retrieval faster. If the system is behaving erratically in any
way, compacting may help to fix it.

If you use the automatic backup function  you should never need to perform a
manual compact function. This is because the backup process compacts the current
data file into the backup file, then uses the newly-compacted backup file, while
keeping the original uncompacted file as the backup. This is not the case for manual
backups because the current data file is not itself compacted, only the destination
backup file. (If you can understand that, you're doing better than most!)

Occasionally it has been reported that the sorting order of the List of Accounts screen
is not what would be expected. That is, the accounts are not listed in account number
order when the screen is first opened. Compacting the database has corrected this
problem in some cases.

Note Don't confuse the Compact function with file compression. This process
in not like using PKZip or Winzip. It simply stores the data more efficiently
in the standard Microsoft Access format. (During backups, data is
automatically compacted in the destination file.)

12.5 Selecting an items file

When you first install Access Anaesthetics, there will be an MBS and RVG items file
attached to the system. This file will be located in the Access Anaesthetics folder and
will be called something resembling AAItems2002_Nov.mdb. There may be one, or
more than one items file. This may be the latest file or it may be an older version if you
are using the Demo system.

When the MBS or RVG schedules are updated by the Health Insurance Commission
or the ASA, a new items file will be created by HealthBase and placed on our website
or mailed to registered users. The updated items file should be copied to your Access
Anaesthetics folder, and if it is in a compressed zip format, it should be unzipped by
double clicking on the file in Windows Explorer. In this way, multiple items files will
eventually exist in your Access Anaesthetics folder for your use.

Using a specific items file in Access Anaesthetics

An Items file is attached to Access Anaesthetics when you start up the system. This
will remain attached throughout opening and closing the system until you manually
attach a different items file. When you do manually attach a different items file, that
file will remain attached until you specify another. In other words, you should only
need to reattach an items file when a new version becomes available.
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To attach to a specific items file, click the Select an Items File button on the File
Management Menu. You will be shown a dialog box listing all the items files in your
Access Anaesthetics folder.

Click on a file to
highlight it and this
will show a
description of the
file's contents in
the box at the
bottom. Select the
most recent file (or
another if that is
your requirement),
and then press the
Use the selected
Items file button.
The specified file
will then be
attached to the
system.

   

A Delete button is provided to remove items files that you no longer need.

Note that you must perform this attachment step to have the system use the
appropriate items book. Simply copying the updated file into your Access Anaesthetics
folder will not attach it to your system.

Updating the MBS unit values

When you attach an updated items file to Access Anaesthetics, any of the MBS item
descriptions, item numbers, unit values and fees in the book may be different from the
previous version. These updated values are not automatically inserted into any
accounts. Rather they are inserted when new accounts are created or existing
accounts are modified. If accounts are not modified, they will retain the item details
according to the book that was in use when the account was created.

Updating DVA, TP and WC rates

The items book also contains the current time-based rates for DVA billing and the
maximum AMA recommended RVG rates for TP and WC accounts. These are not
automatically activated by attaching a particular Items file. Rather they have to be
manually inserted into the Options form. A button is provided on the Item and unit
values page  to streamline this process.164
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Note on pre-RVG items files

Prior to the introduction of the RVG in November 2001, the dollar value of anaesthetic
items was not taken directly from the items book. Instead, the dollar value was
calculated by multiplying the number of anaesthetic units specified for each item by
the unit value (dollars per unit). The unit value is specified on the Items and unit
values page of the Options form and this needed to be reset manually when a new
unit value was introduced. Although the items book listed the dollar value for a single
anaesthetic unit in item 17701, this still needed to be manually inserted in the options
form to allow the system to perform the calculations correctly.

The reason that the system was designed in this way was so that the user could, if he
wished, continue to use an out-of-date items book, but still be able to insert accurate
fees based upon the number of units and the dollar value per unit. This is reasonable
since, in most cases, there are only small variations in items from one book to the
next, but using an old unit value will affect the dollar amount of every item on an
account.

This system will still work even in a post-RVG world, if an pre-Nov 2001 items file is
attached to the system. If this is done, you should check the item unit value in the
options form and adjust it as appropriate. This field had no effect on the system in a
post-Nov 2001 system. All the original calculations will still work correctly if an
appropriate items file is attached, in particular, the old 100/20/10 multiple anaesthesia
rule and the complex prolonged anaesthesia rule.

12.6 Select another provider

The multiple provider versions of Access Anaesthetics function by having a separate
data file for each doctor, and switching between doctors to access the relevant
doctor's accounts. The separate data file system has the advantage that each doctor
can feel more secure about the integrity of his own data. Also, this allows an individual
doctor to maintain his own copy of the system and to review his own data with ease.

To switch from one doctor to another, click the
Select another provider button on the File
Management Menu. This button is also available
on the Main Menu, and on the Tools drop down
menu on most main forms.
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Select the provider you
want and click the Open
button. Or double click on
the provider in the list to
open the file.

After a short delay, the
new doctor's data file will
be opened ready for
editing or reporting. The
doctor's name will be
shown in the title bar of
Access Anaesthetics so
that you can easily
remind yourself of which
data file is currently open.

   

The window also includes buttons to create a new data file, rename an existing file, or
delete a file no longer required. It is not possible to rename or delete a file which is
currently open. Data may also be imported from a standard Access Anaesthetics
Single User file. This Import/Convert function, converts the single user file to a multi-
user format, and allows you to optionally import the some of the lookup lists
(surgeons, hospitals etc) from the single user file.

When switching from one doctor's file to another, the DoctorName.aau file is
switched. The AASite.mdb file is not switched since this contains data which is
common to all doctors in the group. That is, the list of surgeons, health funds,
hospitals, bank branches etc. The files listed in the window above are all those .aau
files found in the folder specified. A button to change folders is located on the form for
unlimited user versions. This allows storing the data files on a network folder. Single
and 2-5 user installations must retain their data files in the same folder as the Access
Anaesthetics program files.
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12.7 Satellite version

As described above, the multi-user version of Access Anaesthetics has a different
data file structure to the single user version. Specifically, the single user AAUser.mdb
file is split into two components, a DoctorName.aau file containing the doctors account
and setup data, and an AASite.mdb file containing data common to the group as a
whole.

In order to use this data in a single user setup, it is necessary to rejoin the two files
back into a single file. The function Create a satellite file on the File Management
Menu does just this. Click the button and follow the prompts to create a file with the
default filename AAUser_JS.mdb where JS is the doctors initials. This file can be
copied to the Access Anaesthetics folder of a single user installation, renamed to
AAUser.mdb, and then used in the same way as the single user version.

To create a satellite file from the main computer:

1. Open Access Anaesthetics and, if not already open, open the relevant provider's
data file by going to File Management Menu, click Select another provider, click
the appropriate file e.g. John Smith, click Open.

2. When the correct file is open (the provider's name appears on the very top of the
screen), click Create satellite file.

3. You will be asked to supply a file name for the satellite file. The default offered will
be of the form AAUser_JS.mdb where JS are the initials of the selected provider.

4. Click OK to create the satellite file. The satellite file will be created in the Access
Anaesthetics folder. If a file of the same name already exists in the Access
Anaesthetics folder, you will be asked if you wish to overwrite it.

5. Copy the satellite file to a floppy disk or network location for the single provider to
use. Or more simply, attach to an email message.

To view a satellite file on a single provider's computer

1. Insert the disk containing the satellite file into the computer to be used. Close
Access Anaesthetics if it is currently open.

2. Open Windows Explorer and copy the satellite file to the Access Anaesthetics
folder on the satellite computer.

The single user version of Access Anaesthetics always opens the data file called
AAUser.mdb in the Access Anaesthetics folder. Therefore, you must rename the
satellite file to AAUser.mdb so the system will recognise it. To do this, proceed as
follows:

1. If there is already a file called AAUser.mdb in the Access Anaesthetics folder
(there should be), you must first either delete or rename this file. If it contains old
data (e.g. a previous version of the satellite file) you should probably just delete it.
If you don't want to delete it, rename it to something else such as
OldAAuser.mdb.

2. Rename the satellite file from e.g. AAUser_JS.mdb to AAUser.mdb. This should
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simply involve removing the _JS.
3. Close Windows Explorer and open Access Anaesthetics as usual. The updated

data will be automatically located from the AAUser.mdb file.

Technical Support for Satellite Files

Satellite files are an optional extra for the multi-user installations of Access
Anaesthetics. HealthBase can provide registration numbers for satellite installations
although the demonstration version of Access Anaesthetics will provide sufficient
functionality for reviewing accounts managed by the multi-user site.

· When used with a satellite data file, the demonstration version will give a
warning message if there are more than 25 accounts. Clients may simply ignore
this message. All data will be accessible and accounts may be printed, but
editing existing data will not be possible. A satellite version will function in the
same way as a single user version with no restrictions except that new accounts
cannot be created.

· Technical support is not provided to clients operating satellite installations. Users
should contact their site manager for training, technical support and updates.

· A demonstration version can be converted to a satellite version by obtaining a
registration number from HealthBase. Clients need to quote the Computer ID
number from the specific machine. This is found on the registration form within
Access Anaesthetics.

12.8 Moving data between computers

Access Anaesthetics was designed as a single user application. However, it is not
unusual for a provider to need to use the system on two computers. These might be a
desktop computer in the office and a portable computer which is carried on the day's
work. Also, we recognise that often a practice manager handles the accounts for a
provider at a location other than the provider's office. The Access Anaesthetics
licence agreement allows for the transfer of data between such installations provided
that both locations are used for the one practicing anaesthetist.

The only file which changes during use of the system is the user's data file,
AAUser.mdb. This is the file which should be transferred between computers. For
example, an anaesthetist may use his system in a home office, transfer the file to a
portable computer, use the portable system to enter data while at work, then transfer
the file back to the home office computer at the end of the day. With this system it is
important to be aware of which copy of the file has the most up-to-date data.

When transferring the data file, standard methods using Window Explorer  are the
easiest. You should overwrite the existing AAUser.mdb file with the new file, provided
you know you are copying a more recent version. Normally, the system will just open
as usual and the up-to-date data will be available.
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You can change the name of the user file to any name you like which may help you
identify the version of the file. For example, you may wish to call it
'UserFile1999Sep10at9am.mdb'. If you include a date or time in the file name you will
always know which is the most up to date file. You already do this when you create a
backup (automatic or manual) by creating a backup which is an identical copy of your
data file with a different name or location. (You can, of course, use the built-in backup
function to copy your data file to a floppy disk for transfer to another computer, instead
of using Window Explorer.)

Note If you do change the file name or store the file in a different directory on
the two computers, you will have to rename it back to AAUser.mdb and
put it back into your Access Anaesthetics directory in order to view the
data.

Data transfer step by step

The recommended steps are as follows:
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1. Using the source computer (e.g. the office desktop), make a copy of the data file,
AAUser.mdb onto a floppy disk. You can use either the built-in backup system or
Windows Explorer.

2. Insert the floppy disk into the laptop computer and copy the backup file to the
Access Anaesthetics folder. (This step can also be done using a direct cable
connection between computers, or even by a file transfer over the internet.)

3. If the backup file is not named AAUser.mdb, rename it to this. If a file called
AAUser.mdb already exists on the laptop, you will first need to rename or delete
it.

4. Open Access Anaesthetics on the laptop computer and add, edit or print your
accounts in the usual way.

5. To reverse the process and move the data back to the desktop computer, follow
steps 1 to 4, replacing the term 'desktop' with 'laptop'.

Caution Always make sure you have only one 'active' copy of your data file. If
your secretary is entering data on the desktop and you are entering data
on the laptop, each data file will have a different set of data. When you
move a data file from one computer to another, one of the sets of
modifications will be lost.

Snapshot and document files

The above discussion relates to moving the Access Anaesthetics data file
AAUser.mdb between computers. As described in the backup section, snapshot files
and Word or Excel documents created while using the system are not included as part
of the AAUser.mdb file and need to be copied separately. If these files are not copied
from the desktop to the laptop, they will obviously not be available to the laptop user.

In practice, since these files are generally only created when accounts or letters are
printed on a printer, and since it is likely that they will only be created on one computer
(e.g. the office desktop), it may not be necessary to copy these files between the
different computers.

12.9 Updating the system

Access Anaesthetics is a dynamic system. The Medicare items schedule is updated
two or more time per year. The health fund schedules may be update anywhere
between twice yearly to monthly. The program file may be updated 2 to 5 times per
year. As the program file is updated, it may make modifications to the structure of
your data file. It is important that you understand how to obtain and install the various
updates so that you can get the most out of your system.

For greatest efficiency, we provide all the required updates on our website for clients
to download. For registered users, we also send an email message to notify you when
updates are posted on the site. We can also send updates by mail on floppy disks,
although this is not our preferred option. Also, we will not always provide minor
updates by this method.
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Which files need to be updated?

· the program file
· the Medicare items file (also includes RVG and postcodes)
· the health fund tables

Instructions for downloading updates from the HealthBase website are provided on
the website at http://www.healthbase.com.au. Most update files are provided as self-
extracting zip files. These are compressed files which can be uncompressed by
double clicking on them. The zip file may contain one or more files depending on what
is included in the update.

Most updates require the same general installation process as follows:

1. Download the file to a convenient location on your hard drive. The My Documents
folder or Desktop are suitable.

2. Ensure Access Anaesthetics is not running, and close it if it is.
3. Open My Computer or Windows Explorer   and locate the downloaded file.
4. Double click on the file to begin the unzipping process. After a short message

identifying the contents of the file, the window shown below will appear.

5. Important.
Check and
adjust the Unzip
to folder to
match the folder
where Access
Anaesthetics is
installed. The
default folder is
C:\Access
Anaesthetics.

     

6. Click the Unzip button.
7. You should receive a message saying that 'x files were unzipped'. Click OK, then

click Close to dismiss the Winzip box.

With some updates, a help file will open automatically providing information on the
changes in the new version of the program. Read this at your leisure and close it. If
this help file appears, you usually won't need to close the Winzip box.

After completing the installation, open Access Anaesthetics as usual and verify that
the system has been updated by checking which version  of the various files are
now installed. Once you are happy that the download and installation process was
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successful, you can delete the file you downloaded. The easiest way to do this is to
right click on the file in Windows Explorer and select Delete from the shortcut menu.

Additional steps required for item file updates

Once downloaded and unzipped, program and health fund files are fully installed and
will operate normally. However, the Medicare items file requires an additional step and
the DVA and ASA RVG rates need to be updated manually. This allows you to choose
exactly when to use a particular items file, and to switch to a previous one if you ever
need to. After completing the steps above, proceed as follows:

1. Start Access Anaesthetics and go to the File Management Menu.
2. Click the Select an items file button.
3. Click on the name of the most recent file and click the Use the selected Items file

button. When this step is completed, the new items data will be available for use.
4. Return to the Main Menu and click Edit system Options.
5. On the Unit and time values page, click the Check current rates button to review

and/or insert the DVA and RVG rates.

Updating multi-user systems

The update process for multi-user systems is the same as for single user systems.
However, if the data files are located on a network, some of the update files must be
updated to the network location, not to the location on the local drive. In particular, the
Medicare items and health fund files need to be updated once to the network location,
while the program file updates must be done on each local drive.

During installation, a specific folder should have been created to hold all the data files.
We recommend calling this folder AADataFiles. The following files should be moved
to this file from the local drive.

\\Server\AADataFiles\DoctorName.aau (all .aau files should be stored here)
\\Server\AADataFiles\AAItems2003_May.mdb (and any other items files)
\\Server\AADataFiles\AAFundsWithRVG.mdb
\\Server\AADataFiles\AASite.mdb

The program file should be updated to the local drive. All other program related files
should also be in this folder. Note that it is essential to update the program file on
each individual PC which will access the network files.

C:\Access Anaesthetics\AA97.mde (or AA2000.mde)

Because the zip files provided may occasionally contain both program and items or
health fund files, it may be necessary to move these from the local drive to the
network location manually after unzipping. If this is done, it only needs be done once,
not once from each PC.
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12.10 Which version do I have?

To get the best from Access Anaesthetics, you should always have the latest version
of the program and data files. Check the Access Anaesthetics website to see which
are the most recent versions. After performing an update, check the versions as
described below. If the versions are still not the latest, review the installation
instructions or contact us for help.

For program versions of 3.4 or later (March 2004) you can quickly get version
information by selecting About Access Anaesthetics from the Help menu, and clicking
the Version button.

Program file

File name: AA97.mde or AA2000.mde

Function: This is the file which contains all the functions of Access Anaesthetics.
It is the file which is used to start up the system. When updating, you
need the latest version of this file, but do not require any earlier
versions. So if you currently have version 2.8 and the latest version is
3.3, you only need the latest version. You don't need any of the
versions in between.

Version: On any menu, click Help > About Access Anaesthetics > Version. The
version number is shown in the first item listed. (Item 4 shows the MS
Access version you are using and item 5 shows whether or not the
Access runtime version is being used.)

Note: If you have MS Access 2002 (Access XP), you will use the AA2000.mde
file.

MBS Items file

File name: AAItems2002_Nov.mdb (for example)

Function: This file contains the Medicare schedule, the RVG schedule, the links
between the MBS and RVG schedules, the list of RVG modifiers, a list
of miscellaneous fee rates, and the postcodes database.

Version: From the Main Menu, click File Management Menu. The version of the
current items file is shown as the name of the Items file (3rd row). The
version is simply the year and month the file was released. Further
information can be obtained by clicking the Select an Items File button.
Then select a file in the window to view its contents. (The V3.3
information at the end of the line may be ignored.)

Health Fund file
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File name: AAFundsWithRVG.mdb

Function: This contains all the specific fees or calculation factors for each item
for each health fund.

Version: On any menu, click Tools > Health Fund Fees. The version is a date
shown in blue type at the top of the form just to the right of the Health
Fund Fee Schedules title.

User's data file

File name: AAUser.mdb for single users, DoctorName.aau for multiuser
installations.

Function: This file contains all the patient account data and provider setup
options.

Version: From the Main Menu, click File Management Menu. The version of the
current User file is shown at the end of the 2nd row in the format V3.3.

Site data file

File name: AASite.mdb - exists only for multiuser installations.

Function: This file contains all the data which is likely to be common to all users
in a multiuser environment such as hospital and surgeons names,
health funds, banks and so on.

Version: From the Main Menu, click File Management Menu. The version of
the current Site file is shown at the end of the 4th row in the format
V3.3.

12.11 Maintenance Log

The Maintenance Log is a record of user activity in Access Anaesthetics. The
log records opening and closing of Access Anaesthetics, switching of data
files for multiuser versions, deletions of accounts, payments and batch
payments, unexpected errors encountered and backups performed.

For each event, the time, computer name, user name, activity type and
details are recorded. The last 1000 entries are recorded; older entries are
deleted automatically. Records cannot be manually deleted from the
maintenance log, but the entire log may be cleared after entering a password.
If cleared, a note to this effect is recorded, and this note cannot be deleted.

The log can be viewed by selecting Maintenance Log from the Tools menu on
the File Management screen. It can also be saved to a csv file for additional
analysis.
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12.12 Miscellaneous

Archiving old data

We are considering incorporating an archiving function into Access Anaesthetics so
that old accounts that are no longer needed can be stored in a separate file. There are
several advantages of NOT doing this - all accounts are always available for long term
practice activity comparisons, you can always find every patient you're looking for,
there is less computer housekeeping to worry about, etc, etc. At present we have not
decided whether to do this, since the only disadvantage of not doing this seems to be
that the data file will increase in size. We'll gladly listen to your comments and
suggestions on this issue.

Data security

Your data is stored in a single file, AAUser.mdb which you may rename, copy and
move as described above. Because it is a standard Microsoft Access database file,
anyone with a copy of Access will be able to view the data. It was a deliberate decision
to store data in this format to give the user a greater measure of long-term security
over their data. This is because the Access mdb format is widely accepted and can
easily be converted into other data formats if required.

However, if you want to keep out prying eyes, you should ensure the physical security
of your computers and password protect access to them. Although the password
function described above provides a measure of security, a determined person could
still bypass this. It is up to the individual client to assess the medico-legal implications
of their data security policies.
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13
Miscellaneous

C H A P T E R

This section describes generic functions which are relevant to more than one section
of Access Anaesthetics. Basic data editing, printing and file manipulation tasks are
explained. Finally, a set of sample printouts is provided to demonstrate the layout of
standard accounts and reports.

13.1 To-Do list

Use the To-Do List to enter any tasks you want to keep track of. These may be
accounts which need updating, people to contact, instructions for your secretary or
yourself and any other things to do.

Each task may be given a priority, category and status. You can choose these from
the list, or just type what you like to enter a new priority, category or status into the
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appropriate field. If you do enter a new item into a field, it will then appear in the drop-
down list.

Sort the items by clicking on the column heading. You can also filter the items (only
show those in a certain priority or category) by choosing from the list box in the
heading of the Priority or Category column.

The date shown on the left is the date the item was created. You can sort using this
as well. The most recent entries will initially be at the bottom of the list. When you set
the status of an item to Completed, the date completed will be inserted automatically
on the right under Status. Or you may prefer to simply delete completed items by
clicking the white-on-red cross.

Print the entire list by clicking Print. A preview is shown first.

Click the Shrink or Expand button to show less or more of the window as you prefer
(you may also set this as a default on the Miscellaneous page  of the Options
form). Click the magnifying glass button to zoom the message text in a larger window.

13.2 Keyboard shortcuts

Menu navigation

Menus can be activated without using the mouse as follows:

· Activate a menu using the keyboard ALT key and the underlined letter of the
desired option. The first menu option will appear in a raised format.

· After activating a menu with the ALT key, use the left and right arrow keys to
move through the menu options.

· Press the ESC key to deactivate the menu.
· If you inadvertently activate a menu, clicking on the main screen may just

result in a sound with no action. You may need to first deactivate the menu
using the ESC key.

General navigation

A number of keyboard shortcuts are available on the main screens. These include the
Main Menu, File Management Menu, Account Details, List of Accounts and Payments
screens. The shortcuts vary on each screen but generally follow the scheme below.

Hold down the CTRL (Control) key and press the key mentioned below:

F. Find an account or patient
N. New account
P. Print the current account or current list of accounts
B. Print a Bank deposit slip
D. Delete the current account
O. Display the Options form
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L. Open the Letter writing window
(on Payments screen, prints List of payments)

M. Return to the Main Menu
(on the Main Menu, opens the File Management menu)

T. Print Tagged accounts (List of accounts screen)
A. Print All accounts (List of accounts screen)

Notes

· The file management menu has more specific functions for the shortcut keys.
· The keystrokes are underlined for options on the Main Menu and File

Management menu. Other screens may not have the keystrokes underlined
since this can cause focus-related problems. The lack of underlining does not
necessarily mean the shortcut is not available.

· Some shortcuts are not available when the focus is on a subform. This may
be the payments data entry section, the list of accounts or other subforms. If
you move (click outside) the subform, the shortcut may become available.

Account Details form navigation

Additional shortcuts have been added to the Account details form to allow the user to
go directly to a specific page. The key combination is CTRL plus a number from 1 to
9, with 0 substituting for 10. This opens to the respective page number starting at 1 on
the left, through 2, 3 … 9 with 0 as page 10. For example, CTRL 5 takes you to the
Fee page. This is in addition to the already existing shortcuts of CTRL LEFT ARROW
and CTRL RIGHT ARROW to move to the previous and next pages of the same
account.

Note that these shortcuts all move the focus to different pages of the same account.

13.3 Print preview window

Previewing and zooming

When you press a print preview button, a window similar to that shown below will
appear. This will enable you to see how the account, letter or report will appear before
you print it. Use the zoom button or drop-down list to get in close, to show a whole
page or to show many pages. Or click directly on the report to zoom in and out.

Printing

To print the document, click the printer icon on the top left of the screen. This will print
one copy of the entire document to the default printer. For multiple copies, press the
printer icon the required number of times. You can have the system prompt you to
specify the number of copies to print by ticking the appropriate checkbox on the
Miscellaneous page  of the Options form. It is not possible to print part of a
document, all pages in the preview will be printed. If you want to print to a different
printer go to the Windows Control Panel, choose Printers and set the desired printer
as the default printer.
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Accounts are recorded as having been sent when the print button is pressed from this
screen (or from a print dialog box if you pressed Print rather than Preview).
Previewing an account does not record it as having been sent. However, once you
press the print button, this information is recorded whether or not the printer
successfully prints the document.

Default printer

If you have not already done so, choose a default printer by going to the Windows
Start button and clicking Start > Settings > Printers. Select the printer you wish to
make the default and click Set as default from the File menu. Also, make sure the
paper size is set to A4 by viewing the Properties from the File menu. If it is set to
another length (e.g. US Letter), your accounts and letters will not be printed properly,
especially when you print more than one at a time.

Page setup

You can change the page setup options such as the size of margins by clicking the
page setup button on the toolbar. Normally you would not need to do this since the
defaults have been set up to be appropriate for most printers. If you do so, the
changed settings will only be valid for the current document. They will revert to the
default settings when the document is closed. This is so even if the system asks
whether you wish to save the settings and you do so. The default settings will not be
changed.

Storing report snapshots

You can specify in the Options (File Management page ) whether to store all
accounts and/or letters as snapshot files on your hard disk when they are printed. If
this option is ticked, a formatted copy of the printout is stored in the Snapshots
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subdirectory of your Access Anaesthetics folder (e.g. C:\Access
Anaesthetics\Snapshots\ACC030617170619.snp). The snapshot can later be viewed
within Access Anaesthetics on the Documents page of the account.

Exporting to other Office applications

If you like you can export the data in the previewed document to either a Word
document or an Excel spreadsheet. This may be useful if you wish to modify the
formatting of a document, or if you wish to do further analysis of an account list or
financial report.

Click the appropriate button on the toolbar. You will be asked to supply a file name for
the Word or Excel file. This will be stored in the Documents subfolder of your Access
Anaesthetics folder (e.g. C:\Access Anaesthetics\Documents\MyExcelFile.xls).
Documents sent to Word are sent as 'rich text format' (.rtf) files while those sent to
Excel go simply as Excel spreadsheet files (.xls). If you edit a document in Word, you
may need to adjust the page margins if they are not the same as they are in the
Access Anaesthetics report. Some formatting is lost in the transfer to rtf files, in
particular any lines or boxes on the page will not transfer.

Emailing reports

Any report you can preview can also be sent as an email attachment. Click the E-mail
button on the toolbar and your default email application will open with a new message
and the currently previewed report will be attached automatically as an rtf document
('rich text file', viewable in Word). Then simply enter the email address of the recipient
and add an additional message if you like. (If you are using the Access 2000 version
of the system, you may encounter a Microsoft bug when doing this which causes
Access to crash.)

Although it is unlikely that you will be sending accounts by email, it is possible to do
this. In practice, this function may be more useful for sending copies of letters to
patients or other doctors, or for sending financial reports to your accountant.
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Finally

Don't forget that you can mail, fax or email comments to us about how you like (or
dislike) Access Anaesthetics and make suggestions for enhancements you would like
to see. We're always keen for feedback of any kind. Open the Tips form  from any
location and click the Feedback button. The Built-in tips will explain what to do.

13.4 Editing lookup tables

There are a number of Lookup Lists
in Access Anaesthetics to
streamline the entry of data used
regularly. You should customise
these to include the items you need.

Most of the tables can be opened
by selecting the option <EDIT
LOOKUP LIST> from the list itself.
For example, select <EDIT
LOOKUP LIST> from the Provider
Designation field on the Format
page of an individual account, and
the Provider lookup list will open for
editing.

Alternatively, you can edit any of the
lookup lists by selecting an option
from the Tools menu.

   

Most of the lists have a specific form which allows easy editing of data. The Other
Lookups category shows a group of lookup lists which are similar in data structure.
The specific lists can then be selected from yet another drop down list as shown
below.

13
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Each lookup editing form also has a button which allows editing the list in a datasheet
format. For further information on editing, see the section on Using Access
Datasheets .

13.5 Using Access datasheets

In many parts of the system, Access Anaesthetics provides the user with a Microsoft
Access datasheet for viewing and editing data. Datasheets display data in a
spreadsheet-like format which is good for looking at a list of records and is a useful
environment for making changes to multiple records in a table. The most recognisable
datasheets in Access Anaesthetics are the lookup tables. That is, the tables of
postcodes, surgeons, hospitals, messages, cheque drawers, banks and so on. These
can usually be viewed by clicking the Edit button associated with the relevant field. For
example, the surgeon's field looks like this:

The surgeon's name is stored in the field. The dropdown List of surgeons box allows
you to select a surgeon by clicking on a name in the lookup list. The Edit this surgeon
button allows you to view and edit the chosen surgeon's details (which are stored in
the lookup table) in a popup form. Finally, the Edit all surgeons button allows you to
view and edit the stored details of all the surgeons. The screen you see when you
click this button is an Access datasheet. The following image shows part of the
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Hospitals lookup table datasheet.

There are a number of other places where datasheets are used but where the
standard datasheet editing window is not always visible. This is because the
datasheet is set within another form (it is a subform). The Lists of Accounts and
Payments are examples of datasheet subforms. There are also a range of smaller
datasheets which appear inside other forms, for example, the status log on the Status
page of the Account details form and the list of payments on the Payments page of
the Account details form.

The following editing methods apply to some datasheets but not to others. In general,
all these methods are applicable when editing lookup table datasheets but may not all
be available in datasheet subforms.

Menu options

The toolbar menu on the top of the datasheet has a number of functions as described
below. However, not all datasheets will have the same options on the toolbar menu
and this depends on the type of datasheet you are viewing.

Scrolling and zooming

Use the horizontal and vertical scroll bars to view rows or columns which are not
currently visible on the screen.

Setting the width of columns

Move the mouse to the line on the right of the column
heading you wish to resize. When the arrow turns to a
double headed horizontal arrow, click and drag the column's
border to increase or decrease its width.

    

Moving columns

Select (highlight) the column (or columns) by moving the mouse to the column
heading until it becomes a down arrow, then click the left mouse button (drag to select
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more than one column). Move the mouse again to the heading until it shows a normal
pointer then left click and drag the column(s) left or right as desired. You can drag
columns past the left or right edge of the screen if you are not at the left or right edge
of the entire datasheet.

Saving changes to datasheets

If you make any changes to the datasheet layout as described above these will not be
saved unless you specifically save them. When you close a datasheet where you
have modified the layout, you will be asked whether you wish to save the changes. In
general it is best not to save the changes unless you are sure that you want to keep
the changes you have made. You cannot lose anything by not saving the changes and
remember that you are not being asked to save data changes, but only changes to the
visual layout of the datasheet. In some instances, the datasheet is created only when
you want to view it and the formatting is recreated too, so saving the datasheet layout
may have no effect on the default formatting provided by the system.

Not all datasheets will allow changes to be saved. For example, any report datasheet
is simply an Access query and as soon as another report is run, the formatting will
revert to the default according to what data is returned by the query. In most
datasheet subforms embedded inside other forms, saving changes is not
recommended since the datasheets have been formatted especially to work within the
form and formatting changes may reduce the functionality of the datasheet.

If in doubt, do not save changes when prompted.

Adding Records

To add a record to a datasheet, position the cursor in the last row and begin typing
data into the fields. The last row is called the data entry row and will have an asterisk
(*) in its leftmost grey column. Not all datasheets will allow the user to add records
and this is a feature built in to the design of the Access Anaesthetics system to avoid
inappropriate data entry. This is so where there are specific methods for adding
records such as in the List of Accounts and List of Payments etc. Usually you would
only add records to datasheets in places such as the lookup tables, for example, in
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the Surgeons or Hospitals tables.

Editing and saving records

When a change is made to a field in a datasheet, the leftmost grey
column displays a pencil icon. This indicates that the record (row) is
currently being edited but that the changes have not yet been saved.
Changes do not have to be specifically saved; this happens
automatically when the user closes the datasheet or form, or moves
to another record.

When the record is saved, the pencil icon is replaced by the
standard right arrow icon. If the record is currently being edited (the
pencil icon is visible), the changes already made to the record can
be reversed by pressing the ESCAPE key on the keyboard. Not all
datasheets will allow data to be edited.

   

Deleting records

To delete one or more records from a datasheet, select
them by clicking (or clicking and dragging) in the grey
record selection box on the left. Then press the Delete
key on the keyboard. You will be given a warning before
the records are deleted. Not all datasheets will allow
records to be deleted.

   

Sorting records

Click in a column you wish to sort the datasheet by then press the Sort
Ascending (A-Z) or Sort Descending (Z-A) icon on the toolbar. Not all
datasheets will allow this option.

Finding data

Place the cursor in the field (column) in which you wish to search. Click the Find icon
(binoculars) on the toolbar. Use the popup dialog box to specify what you want to find
and where to look.

To jump to a record in a long list,
click in the record navigation box
at the bottom left of the screen
where it says, for example,
'Record 37 of 2500' and type a
record number to go to.

   

The record number is a simple incremental listing number. It is not necessarily related
to the Account Number or any other built-in identification number.
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Printing the datasheet

Datasheets may be printed by using the Print Preview icon on the toolbar, but
sometimes this will result in messy printouts which are difficult to format. If possible,
use the print methods which are built in to the system and which are accessed by
specific Print buttons. Where print setup options are changed, from the print preview
screen, saving them may or may not save the changes to the datasheet depending
upon the type of datasheet it is (table, query, form or report). If in doubt it is probably
best not to save formatting changes.

Exporting data

Data in a datasheet may be exported to a Microsoft Excel file by clicking the Edit in
Excel button on the toolbar. You will be prompted for a file name and the file will be
stored in the DOCUMENTS subfolder of your Access Anaesthetics folder (e.g.
C:\Access Anaesthetics\Documents\ MyDatasheet.xls). Any data in a Print Preview
screen can also be exported in this way, or additionally exported as a formatted .rtf
(rich text format) file which can be read in Microsoft Word.

13.6 Copying and moving files

Transferring files from one place to another on your computer or from your computer
to a floppy disk is a fundamental technique all computer users should be adept at.
Although file transfers are not required to run Access Anaesthetics, a brief description
of how to move files is given here in any case, since you will inevitably have to do it for
backups, re-installations and hardware upgrades etc.

When transferring files, standard methods using
Window Explorer are the easiest. Open the Explorer
window by right clicking on the Start button and clicking
Explore (there are other ways of doing this but this one
is fairly generic). In later versions of Windows, you can
do most of these functions also by using My Computer.

    

Viewing the file hierarchy

The Explorer window shows a list of folders (or directories) on the left and a list of
folders and files on the right. The list on the right shows the folders and files which are
contained in the open or highlighted folder on the left. Click on another folder on the
left to display its contents on the right.

The folders on the disk exist in a hierarchy where one folder contains other folders.
Folders which contain other folders have a + sign next to them in the left window.
Click the + sign to display the folders inside the first folder. These folders may in turn
contain other folders.
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All the storage devices on your computer are shown in the Explorer window. This may
include one or more hard disks (typically C: or D:), one or more floppy disks (usually
a:), a CD ROM (D: or E:), a zip drive (D: or E:), or, if your computer is on a network,
one or more network drives (D: to Z:).

Moving and copying files

1. Click the file or folder you want to copy or move, thereby highlighting it.
2. On the Edit menu, click Copy or Cut. (Both commands copy the file to the

clipboard, but Cut additionally deletes the original.)
3. Open the folder where you want to put the file or folder.
4. On the Edit menu, click Paste.

As a shortcut, click on and drag the file or folder to the folder you wish to move it to.

Copying a file to a floppy disk

1. Insert a disk into the floppy disk drive.
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2. Click the file(s) you want to copy, thus highlighting it (them).
3. On the Edit menu, click Copy.
4. Click the icon for the floppy drive and, if necessary, open the folder where you

want to put the file or folder.
5. On the Edit menu, click Paste.

Alternatively, click and drag the file or folder to the floppy disk folder you wish to copy
or move it to.

Also use this method to copy files to any other storage devices you may have such as
zip drives.

Deleting files

1. Locate the file or folder you want to delete and click to highlight it.
2. On the File menu, click Delete, or press the Delete key on the keyboard.
3. The file(s) or folder(s) will be moved into the Recycle bin.

Deleted files remain in the Recycle Bin until you empty it. To empty the recycle bin,
open it and delete its contents.

Another way to delete a file is to drag the file or folder icons onto the Recycle Bin icon.
If you press SHIFT while dragging, the item will be deleted from your computer without
being stored in the Recycle Bin.

Restoring deleted files

1. To restore a file you have deleted, open the Recycle Bin and select the file or
folder to restore.

2. From the File menu, select restore. The selected file or folder will be returned to
its original location.

Note on copying versus moving

If you copy a file, it remains in its old location and a copy is created in the new
location. If you move a file, a copy is created in a new location but the existing file is
deleted from the old location. When you drag files with the left mouse button, the
default action is to copy if the destination folder is on a different drive (e.g. from a hard
drive to a floppy drive). If the destination drive is the same as the source drive, the
default action is to move, and the source file will be deleted from its original location. If
you use either method to copy an executable file (one with an .exe file extension) to a
different location on the same drive, the file will not be moved, but rather a shortcut to
the existing file will be created in the new location.

Creating a new folder

1. Open the folder in which you want to create a new folder.
2. On the File menu, point to New, and then click Folder. The new folder appears

with a temporary name.
3. Type a name for the new folder, and then press ENTER.



Chapter 13.  Miscellaneous

216 Access Anaesthetics Practice Management System

Renaming a file or folder

1. Click the file or folder you want to rename. You do not need to open it.
2. On the File menu, click Rename.
3. Type the new name, and then press ENTER.

Alternatively, click the name twice slowly to rename it without going to the File menu.
(N.B. Clicking twice is slightly different to double clicking.)

A filename can contain up to 255 characters, including spaces. But, it cannot contain
any of the following characters: \ / : * ? " < > |.

Tips

· To change the size of either side of the Explorer window, drag the bar that
separates the two sides. To increase the size of the entire window, click the
Maximise button on the top right or drag the left, right or bottom borders.

· To quickly open a folder and display its subfolders, double-click the folder on the
left side of the window.

· To open a file or folder, or start a program, double-click it.
· You can use the keyboard shortcuts <CTRL>C to copy files and CTRL>V to

paste files, that is, hold down the Control key while you press C or V.
· Right click on a file or group of selected files or folders to open a shortcut menu

containing the Cut, Copy, Paste, Delete, New and various other commands.
· If you want to select more than one file or folder to copy or move, hold down the

CTRL key, and then click the items you want. You can also select a group of
files by clicking one file, then holding down the SHIFT key and clicking the other
file. All the files in between will be selected.

· If you drag a file with the right mouse button, when you let go, a menu will
appear giving you the option to move the file, copy it or create a shortcut to it.
The last option is a useful way of putting a shortcut to a program or file onto the
desktop. Drag the file out of the Explorer window to the desktop.

File types

Each file is a certain type according to the data it contains or the application required
to open or activate it. The file type is identified by the file name extension, that is, the 3
character code on the end of the file name after the full stop. For example,
'Recipes.txt' is a text file and 'Recipes.mdb' is a database file. Some common file
types are:

.doc Word document .bmp Bitmap image

.mdb Access database .zip compressed Zip file

.txt Ascii text .xls Excel spreadsheet

.exe executable program .html hypertext markup language (web
page)

It is important that you know the file name extension when you are copying or moving
files because there may be several files with the same name which have different
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extensions. For example, in Access Anaesthetics the following files are all called
AA97.

AA97.mde main program file which runs the database
AA97.hlp the on-line help file
AA97.ico icon appearing in the Access Anaesthetics title bar
AA97.bmp the image which appears when the system first opens
AA97.ldb a file used for managing multiple users on a network

If you cannot see the file name extensions when you look at the files in Windows
explorer, go to the View menu, click Options, click the View tab, and make sure the
option to 'Hide MS-DOS file extensions for file types that are registered' is unchecked.
You may also need to select the 'Small icons', 'List' or 'Details' option on the View
menu. The 'Large icons' options will not show the file type, although the icon itself will
give you a hint as to what type of file it is.

If you need to move Access Anaesthetics files from one computer to another, see the
Transferring data between two computers  section.

13.7 Sample Printouts

The following pages contain sample printouts from various parts of Access
Anaesthetics. They are shown to demonstrate the layout of the reports rather than the
information they contain. Layouts can be customised to some extent by adjusting the
formatting Options .

Standard account

All accounts, receipts, reminders, letters and so on are designed for A4 size paper
with an address box to fit in a standard DL window envelope when folded into 3. The
standard account shows the general layout with the header, address window, account
number and fee area, patient details, procedures times, items list, account message
and payment instructions. A number of customisable options allow you to modify
which pieces of information are shown on the account.

Standard receipt

Receipts are identical to accounts except that payment information is printed as well
as the original account details. This ensures that patients will always have sufficient
information to obtain rebates. Account reminders are also printed in the same format.
The title can be customised in the Options form (Provider details page ). Receipts
and reminders may have an additional message shown at the bottom of the account
to advise of payment status. This is set automatically at the printing stage but may be
customised.

Co-payment account

A Co-payment account is an account sent to a patient for a residual fee when the
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main account is sent directly to a health fund. Since no rebates will be available to the
patient, the standard payment instructions do not appear. The message shown on the
account in place of the items list can be customised in the Options form (Patient co-
payment page ) using codes which substitute for the various amounts. A separate
message can be shown for paid or partly paid accounts.

Form letter

This shows the layout of a standard form letter which can be created and printed with
just a few mouse clicks. Letters are attached to individual accounts for easy retrieval.
You can create an unlimited number of form letters which can be inserted into any
account and saved for future use. The font and font size of the letter text can be
adjusted, but other formatting features such as bold face and underlining are not
supported. Use a word processor program if you need additional formatting for your
letters.

Bank deposit slip

The banking slip can replace a manual deposit slip and is acceptable to most banks.
The surname column can be hidden if preferred (Options > Banking ) and the
ordering of the payments can be customised. Cheques, credit card and money order
payments are shown in separate groupings, and cash payments are summarised at
the bottom. A similar format is used when printing a list of any payments from the List
of payments screen by pressing the Print this list button. In the latter case, cash
payments are itemised.

List of accounts

This shows a standard report printed from the List of accounts screen by pressing the
Print this list button. You can customise the reports by selecting accounts using
criteria such as date, surgeon, account type etc. The columns appearing on the report
cannot be modified. The Followup worksheet is a special design of this list which
shows account comments, reminder details and leaves blank space for writing notes,
to assist in manually following up unpaid accounts.

Batch header

This shows a batch header printed from teh List of Accounts screen by selecting
Batch Header from the Summary menu. The accounts to be included are first
selected in the list. The various options can be customised on the Batch Header tab of
the Addresses editing form. Open this from the Tools > Edit Lookup Tables menu
option.

Practice activity summary

This shows an example of a cross tabulation summary created from the List of
accounts by pressing the Summary button on the top menu. A large number of activity
summary combinations can be created this way. To do this, first select a group of
accounts you wish to report on using the options on the Select menu of the List of
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accounts. Then from the Summary menu, choose a grouping variable. The example
shows all accounts grouped according to the payment status.

Payment summary

This shows a financial summary report created by pressing the Summary button on
the List of payments screen. After selecting a group of payments to work with, the
Summary button allows you to choose the date frequency grouping and the field to
break down the payments by. The sample here shows all payments in 1995 and 1996,
grouped monthly, broken down by account type. Experiment with the groupings to
create exactly the type of financial report you need.

13.7.1 Standard account

227
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13.7.2 Standard receipt
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13.7.3 Co-payment account



Chapter 13.  Miscellaneous

222 Access Anaesthetics Practice Management System

13.7.4 Form letter
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13.7.5 Bank deposit slip
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13.7.6 List of accounts
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13.7.7 Batch Header
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13.7.8 Practice activity summary
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13.7.9 Payment summary
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14
Technical Details

C H A P T E R

This section describes some important technical details of your Access Anaesthetics
software.

14.1 System requirements

We recommend the following specifications for minimum performance of Access
Anaesthetics. As with any software, the faster the processor and the more memory
available, the better the system will run.

Hardware recommendations

Computer: Windows PC (will not run natively on a Macintosh,
but will run using Virtual PC software)

Processor: Pentium (faster is better)
Memory: 32MB (more is better)
Hard disk space: Approx 10 MB (about 20 required for runtime version)
Screen resolution: 800 x 600 (higher is OK, lower is unacceptable)
Colour palate: 16 or 24 bit (images are poor with 256 colours)
Operating system: Windows 9x, 2000, NT, XP
Printer: Any Windows printer, printing on A4 paper
Backup device: Zip drive, Super disk or CD writer. Floppy disks are OK but
will eventually be too small.

Software requirements

Access Anaesthetics is based on Microsoft Access database files and requires
Microsoft Access to run. It is designed in Access 97 and versions are available for
Access 97 and Access 2000. The Access 2000 version will run without modification in
later versions of Access (2002 or XP).

If you do not have Access 97 or Access 2000, you can still run the system, by
installing the Access 97 Runtime version which is available on the installation CD.

Microsoft Access is included as a component of Microsoft Office in the Professional
edition and above. It is not included with the Standard or Small Business editions of
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Microsoft Office. Microsoft Access and Microsoft Office are copyrighted products of
Microsoft Corporation.

14.2 Screen resolution

Access Anaesthetics requires a screen resolution of at least 800 x 600 pixels to
function properly. If your screen resolution is less than this, say 640 x 480, you will be
prompted to allow the resolution to be changed to 800 x 600. If you do not accept this
change, the system will close. Otherwise the screen resolution will be set to 800 x
600.

Access Anaesthetics will actually open in a Window of 800 by about 550. This is so
that there is space for the Windows taskbar at the bottom of the screen. If you also
have a Microsoft Office toolbar visible on the screen, this may cause parts of the
Access Anaesthetics window to be obscured. Therefore, for 800 x 600 screens, we
recommend that you turn off the Office toolbar (by setting Auto Hide to On), and keep
the Windows taskbar on the bottom of the screen.

If your screen resolution is greater than 800 x 600, say 1024 x 768, Access
Anaesthetics will open in a window of size 800 x 600. You can resize or maximise the
screen if you wish. If you do, most of the objects on the forms will remain the same
size but the datasheet screens will expand so that you can see more rows and
columns. The List of Accounts  and List of Payments  screens can be
customised so that larger fonts are used to make data easier to read on higher
resolution screens.

For high resolution screens, there is a button on the Miscellaneous page  of the
Options form which will allow you to save the window size so that the next time
Access Anaesthetics opens, it will open at your preferred size.

14.3 Registration number

When you first install Access Anaesthetics, whether from a CD or via an internet
download, the system will function in Demonstration mode and allow only 25 accounts
to be entered. A registration number is required to get the system out of
Demonstration mode and to allow the entry of unlimited accounts.

The registration number provided upon purchase is valid for one computer only and
will not work on any other computer. In order to assign your registration number, we
need a computer identification number from your computer which is located on the
registration form. Click the registration button on the Main Menu to locate your
computer identification number. If you require an additional registration number for a
laptop computer or remote secretary, first install Access Anaesthetics on the new
computer and locate its computer identification number in the same way.

If you buy a new computer or replace your hard disk or other internal components, you
will require a new registration number. Contact us and we can provide this without
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delay.

14.4 Technical support

The annual maintenance and support plan

Twelve months free support and maintenance is included in the purchase price of
Access Anaesthetics. Thereafter an annual fee will be charged. Consult our website
for the latest details - www.healthbase.com.au.

The support and maintenance plan includes:

· MBS and RVG data file updates whenever new versions are published by the
Health Insurance Commission or the ASA.

· Health fund updates when appropriate after fee schedules have been modified.
· Program updates. There may be 3 to 6 program updates annually.
· Unlimited technical support by email with responses normally returned within

several hours.

Support by Email or fax

We prefer to receive support enquiries initially by email. This gives you a chance to
fully describe the situation, and gives us a chance to work through the problem and
develop a solution. This is often faster than talking to us in the first place, because in
many cases we need to duplicate the problem before devising a fix or work-around.
Email is the best way to resolve non-critical issues and to provide background
information for telephone support. We normally respond to email enquiries within
several hours, 7 days a week.

Additional pay-per-use support 

To reduce the annual support cost, telephone, modem and on-site support is not
included in the annual support plan. These can be provided, however, on a pay-per-
use basis. This will be charged at our standard hourly rate applicable at the time the
support is provided.

Telephone

Please use our telephone support number or indicate in your email or fax the best day
and time for us to call you. We can call you outside business hours if required but we
would prefer not to receive calls outside business hours. Our office telephone is
normally attended 4 days per week (Tues-Fri) during business hours. Voice
messages may be left when the office is unattended and we will return your call as
soon as possible. A mobile phone number will be offered for urgent calls although this
will not always be answered immediately. 

Modem
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If you have a modem, we can log into your computer remotely using pcANYWHERE
software. Users must have pcANYWHERE installed on their machine. A 30 day
evaluation version of this program is available on the Access Anaesthetics installation
CD. This may be sufficient to enable us to correct any initial setup problems. A full
version of pcANYWHERE costs approximately $250-$300 from software dealers.

On-site

On-site visits are available within the Sydney region. Individual on-site training can
also be provided in the Sydney region if required.

Users of the DEMO version

Reasonable support will be provided by email, fax or telephone on installation and
setup issues. It is expected that users will refer to the training resources to learn to
use the system and training support is not generally provided. However, we will
provide limited training assistance by email, fax or telephone at our discretion.

The 'No Support' plan

Once you have purchased Access Anaesthetics, there is no absolute requirement to
stay on the annual support plan. The system will not cease functioning on a preset
date. We can provide support on a pay-per-use basis and can also provide program
and item updates on a pay-per-update basis. However, this option is unlikely to
represent good value for money as the costs for each update will be disproportionately
high.

Training

To help reduce costs, no personal training is included in the purchase price of Access
Anaesthetics and it is up to the individual user to learn how to operate the system to
best advantage. To assist with this training, the system includes a number of
resources:

· a comprehensive on-line Windows Help file
· this detailed printed manual with screen images
· a set of training videos on the installation CD
· regularly-updated frequently-asked questions on our website
· additional material posted on our website from time to time

If you prefer, we can come to your office to provide individual on-site training at our
standard hourly rate of payment. At present this service is only available for Sydney
locations. Contact us or consult our website for the latest details.

Note We do not provide hardware support. You should consult your local
computer dealer for hardware or printer related problems.
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14.5 Licence agreement

Installation Agreement

Installation of this software indicates acceptance of this agreement. If the terms of this
agreement are unacceptable, or you are dissatisfied with this product for any reason,
you should cease to use it immediately. You may return all the original materials to
HealthBase Pty Ltd within 3 months of registration for a full refund. If you return the
software for a refund you are no longer licensed to use the program. You must
remove any and all copies of the program from your hard disk and destroy all
electronic copies of the program.

Copyright

The supplied software and documentation are copyrighted products of HealthBase Pty
Ltd. All rights are reserved, and the use of the software is expressly prohibited, except
as authorised by the terms of this agreement. Under no circumstances may you
remove the copyright notices which are part of the software or documentation. No part
of the software or documentation may be reproduced without express permission
from HealthBase Pty Ltd.

Unauthorised copying

HealthBase authorises registered users to make archival copies of this software for
the sole purpose of back-up and protecting your investment from loss. Under no other
circumstances may you copy the software for the purpose of distribution to others.
Copying (except as above), duplicating, selling, renting, transferring, or otherwise
distributing the software product is a violation of the law.

Registration

Upon installation, the system can be run in Demonstration mode which allow adding
up to 25 accounts. A unique registration number is required for each authorised
installation of the software to advance beyond Demonstration mode. Once correctly
registered, the About box will display the name of the registered user.

The registered software may be used for one anaesthetic practice only. The
registered user may install the software on more than one computer (for example,
desktop and notebook) provided that each installation will be used for the one
anaesthetic practice. Provision for a secretary to operate an additional installation will
be allowed according to conditions determined from time to time provided the system
is for the sole use of the registered provider of anaesthesia. Where the software is
used for multiple providers, the software will be licenced to the group practice.

The software is not transferable from one practice or practitioner to another. Once
purchased, the registered practitioner cannot give or sell his copy of the software to
another provider or practice. Each new practice must purchase a new copy of the
software.
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Warranty

HealthBase Pty Ltd have made every effort to ensure that this software is an effective
tool for its stated purpose. However, the software is distributed 'as is' including any
programming errors either known or unknown. To the maximum extent permitted by
applicable law, HealthBase Pty Ltd makes no warranties relating to this software
arising from a failure of this program to operate in the manner desired by the user. It is
strongly recommended that you thoroughly test the program with dummy data before
installing active data.

Disclaimer

Neither HealthBase Pty Ltd and its employees nor anyone else who has been involved
in the creation, production, or delivery of this software shall be liable for any damages
including any lost profits, lost savings or other indirect, consequential, or incidental
damages arising out of the use or inability to use such software, or any claim by any
other party, even if HealthBase Pty Ltd has been advised of the possibility of such
damages or claims. In no event shall the liability of HealthBase Pty Ltd for any
damages ever exceed the price paid for the software or the license to use the
software, regardless of the form of the claim. The person using the software bears all
risk as to the quality and performance of the software.

14.6 Privacy statement

Introduction

HealthBase respects your privacy. We comply with the recent Privacy Amendment Act
2001 effective 21 December 2001 and with the 10 National Privacy Principles (NPP).

The Information we collect

We collect personal information about our clients for the primary purpose of supplying
support for our software products.

Personal account information

We record your name, address, telephone number(s) and email address. We may
record limited computer hardware and software configurations if explicitly provided
(we do not collect this via our website). This may include your Computer ID number
for the purpose of providing a registration number for use with out software. We may
make notes on our dealings and correspondence with you. We record details of
payments made to us and of correspondence to or from you. We record all email
correspondence. We do not record credit card numbers on computers.

Recording website activity

We record limited information on all visits to our website for statistical purposes. This
cannot identify individual visitors. Information recorded includes computer operating
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system, browser version and host name.

Cookies

A cookie is a small file created by your web browser to assign a unique identification
to your computer. Cookies are used to allow us to identify visitors so that we can
personalise your experience in visiting our site. We do not currently use cookies, but
may do so in the future.

Access to information

You may request to know what information we hold on your behalf at any time.

Changing your information

You can make changes to your personal information by notifying us by mail, fax,
telephone or email. We shall acknowledge the changes have been made to our
records. We will send you details of the information annually when you renew your
support plan.

Disclosure of information

We will not disclose your personal information to any third party except where you
have provided express permission, or where required to do so by law.

Security of information

We maintain your records on secure standalone computers or internet-connected
computers operating behind a secure firewall. No personal information currently exists
on our website. However, in the future, we may keep a limited database of usernames
and passwords to allow secure access to our website by registered clients. Paper
based records are maintained in an office used by HealthBase staff only, with no
access to the general public or other clients. Electronic backups may be held at
locations outside the HealthBase office. We take all precautions to ensure that your
personal information remains private and secure.
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15
What's New in Access Anaesthetics

C H A P T E R

15.1 Version 3.4 - 2004 March 18

15.1.1 Summary

Version 3.4 was released on March 18, 2004

· The help file  has been completely updated to include everything in
version 3.4 in line with the revised printed manual (version 3.3).
Essentially it is the printed manual, plus updates since then.

· The Documents page  is now able to save a reference to an external
file such as a Word document. This allows you to catalogue all your
records for a patient within Access Anaesthetics even if they are
created with another program.

· New editing forms have been created for many of the lookup lists  to
make customising easier.

· Surgeon, hospital and operation labels  can be better customised.
For example, Dr Smith can be designated a surgeon, while Dr Jones is
labelled a gastroenterologist. And hospital provider numbers can be
recorded and displayed on accounts.

· A 'batch header ' can be printed for a group of health fund, DVA or
other accounts.

· New functions allow customising the font size  and columns
displayed on the main list and detail screens. Also the Access window
itself can be resized (and remembered). This will particularly benefit
clients with higher resolution screens.

· There are two new reports , an Aged Trial Balance report, and a
report for group practice payment summaries.

· Accounts can be selected according to a specific item number
(Advanced selection box). And quick menu options allow selection of
health fund accounts .
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· A new 'Maintenance log ' records program activity such as error
messages, account and payment deletions and other significant
events.

· There are various improvements in the way that multiple provider
files  are handled.

· There are a lot of bug fixes  (not that we admit there were any to fix!)
· There are a lot of other useful new features , so read about these

below.
· A number of issues related to using AA in Microsoft Access 2003

have been fixed.

Older Versions

15.1.2 Document Management

Modified the Documents page to allow saving a link to an external document
or website. Each document may be saved with a category and with notes.
The categories can be edited. The list can be filtered by a category.

A similar form is opened from the main Menu using the Letters & Documents
button. This lists letters and linked documents which are not attached to a
particular patient account. The 'External Documents' options is included on
the Tools menu of several main forms.

For multi-provider versions, it is possible to search all data files and obtain a
listing of all documents for a specified patient. This is simple to do for an
individual patient, but the search can be easily modified to look at multiple
patients.

15.1.3 Revised Help

Revised the help file to bring it up to date to version 3.3.

Created a small version of the help file with no images to save on download
space. The small version is installed by default; the full version can be
downloaded separately.

200

242

244

243

246

246



15.1.4  Version 3.4 - 2004 March 18 > Lookup Lists

Copyright © 2003 HealthBase Pty Ltd 239

15.1.4 Lookup Lists

New forms were created to enable easy editing of lookup lists including the
Surgeon Label, Hospital Label, Operation Label, Anaesthetist Designation,
Health funds, Payers (drawers), Banks, Branches, Quick items, Quick notes
and Document Types (Category of linked document). A link to the older
datasheet editing format is also provided on the editing form. The forms are
usually opened by selecting the <Edit Lookups> option from the appropriate
drop down list, or by clicking a 'pencil' button. Some of the separate 'pencil'
buttons have been removed where they were redundant.

Added an option to the Tools menu to easily open any of the lookup tables for
editing, without having to go to the specific field to open the lookup table.

15.1.5 Surgeon, Hospital & Operation Labels

For each of these fields, a designation may be stored in the lookup table. For
example, Dr Smith may be a Surgeon, but Dr Jones may be a
gastroenterologist. The appropriate designation will be automatically inserted
as the field label when a particular surgeon is selected. All are initially
designated 'Surgeon'.

The 'Surgeon' label can still be edited manually by selecting from the list box.

A new shortcut has been included to allow easily specifying a designation
which is different to the stored one. E.G. enter ZS/G in the surgeon field - get
Dr Zachary Smith as the surgeon and Gastroenterologist as the label (instead
of surgeon). For this to work, you must enter a one character code into the
Notes field in the lookup form for the surgeon, hospital or operation label.

The above features also work for the Hospital and Operation fields.

The Hospital lookup table now includes a Provider number field which can
optionally be included on the account. This is to allow easy insertion of the
hospital's Provider number when required by a payer such as a health fund.

15.1.6 Health Funds

It is possible to hide funds you never use from the Health Funds drop down
list. Click Tools > Health Fund Fees and click the Show/Hide button to hide
the funds you don't wish to appear. You can unhide them just as easily. Your
preferences will be remembered even after updating to a new health fund file.



Chapter 15.  What's New in Access Anaesthetics

240 Access Anaesthetics Practice Management System

When printing a list of 'All' fund schedules, hidden funds will not be shown.

Added an option to the Select menu on the List of Accounts to quickly show
all open health fund accounts. Also added an option to list accounts for any
specified health fund.

15.1.7 Batch Header

Created a batch header function to print a summary sheet for a group of
accounts. This is intended to be used as a summary sheet when sending
health fund accounts, but can also be used for other purposes, such as for
DVA accounts. From the List of Accounts page, select the accounts to be
included in the batch, then press 'Batch Header' on the Summary menu.

The title and other details on the batch header can be customised. Use the
Edit button on the batch header dialog box, or edit the details by opening the
Addresses lookup table.

15.1.8 Entering Payments

Added a co-payment checkbox to the batch payments entry screen and
adjusted the code to save the Copayment flag for distributed payments.
Previously this was missing.

Modified the lookup list in the distributed payments data entry form so that
both normal and co-payments are listed. If the Copay flag is ticked for the
batch payment, selecting the account number in the distributions list will enter
the copayment owed, instead of the total amount owed (& vice versa).

Added Eftpos and Direct deposit options to the dropdown list of payment
types in the standard and batch payment forms. Also to the payment type
field in the advanced payment selection box.

Prevented 'Type error' when printing payments where one of the payments
has no payment type. Modified the payment entry screen (standard and
batch) so that payments can't be saved unless a payment type is specified.

Adjusted the list of bank deposit slips so that banking dates which included
only electronic transactions (i.e. no physical banking slip was printed) did not
appear in the list. Also prevented showing an empty bank slip.

Added a payment type category subtotal to the bank deposit slip.
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Included 't' shortcut to enter a third party drawer into the Drawer field. This
will also look up the address code so that if the HCF address is shown on the
PtAddr page, the t shortcut will enter the HCF banking details. (Originally the
p shortcut would do this if a third party address was listed, but this function
was removed a few versions ago.)

Adjusted the List of Payments so that user-defined ordering is reproduced on
printouts.

15.1.9 Font Formatting and Screen Size

Provided the ability to change the font of the List of Accounts and Payments.
The font, font size, bold, and gridlines can be customised (Tools > Datasheet
Format).

Provided the ability to select the columns to be displayed in each list.

Provided the ability to store multiple formatting options for each list - so that a
specific set of columns and font formats can be displayed easily.

When exporting to Excel, the column selection is maintained.

Added appropriate Copayment columns to the printed list of accounts.

Added a menu option (Tools > Resize fonts) to toggle between 8 and 10 point
font size for selected fields on the main Account Details data entry screen.
This is an interim measure to assist users with high resolution screens. We
are currently in the process of incorporating a more comprehensive resizing
function.

For computers with higher resolution screens (> 800 x 600), created a
function to resize the Access window so that AA will always open in the
preferred window size. Also removed the option to revert to a screen
resolution of 800 x 600 since it is unlikely this would ever be used, and it may
cause some screen display problems.

15.1.10 Links to Executable Programs

Added the ability to launch an external application from within AA using a list
on the Main Menu. The list of applications can be customised to include any
application available on the computer.
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15.1.11 Maintenance Log

Created a logging procedure to record details of program activity for audit
purposes. This can be viewed from the Tools > Maintenance Log menu on
the File Management screen.

For each event, the time, computer name, user name, activity type and
details are recorded.

The log records opening and closing of Access Anaesthetics, switching of
data files for multiuser versions, deletions of accounts, payments and batch
payments, unexpected errors encountered and backups performed.

The log records the last 1000 entries. Records cannot be deleted from the
maintenance log, but the entire log may be cleared after entering a password.
If cleared, a note to this effect is recorded, and this note cannot be deleted.
The maintenance log can be saved to a csv file for additional analysis.

Updated all the error handling procedures to improve stability. Also created a
new clean database and imported all original objects and properties to try to
reduce Access crashes during development.

15.1.12 Reports

Created a basic Aged Trial Balance report to provide a summary of
outstanding fees. Open this from the Tools menu on the List of Accounts or
Payments.

Created a Group Practice Payment Summary for the days' end reconciliation.
This was specifically designed to reconcile EFT payments, but may be used
for other purposes. This is currently only available in multi-provider versions
of AA.

15.1.13 Multi-provider Features

Added a large popup notice to show the current doctor when switching data
files.

Modified the QualDesig field on the MainMenu to ensure it is updated when
data files are switched.

Inserted a warning message to alert the user to the inability to refresh the
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doctor's name in the title bar when the AA97.ico file is missing.

Added a Multi-provider document search function as described above in
'Document Management'.

Created a function to update DVA, TP and WC rates for all data files in one
process. This is operated from the Options form and means all data files can
be updated at once.

Provided an option to save the location of the backup file to all data files at
once. This option is available when the 'Save default' button is pressed in the
backup window, or when the manual backup location is changed in the
Options form.

Added a function to convert a single user data file into a file which can be
used in a multi-user system. Also allows importing of surgeons and hospitals
from a single user file. Useful where an existing single user joins a group
which is using Access Anaesthetics.

15.1.14 Miscellaneous Updates

Adjusted the 'Premed' shortcut on the RVG items page to insert CA002 item.
Also adjusted all other references to old premed item CA010 to include
CA002-CA008 items.

Adjusted the List of Accounts so that user-defined ordering is reproduced on
the printed output.

Removed the unnecessary 'Clear tags shown' button on the List of Accounts
and replaced it with a 'Tag all shown' button.

Added the ability to select accounts according to a specific item number
(Advanced selection box).

Added 'Filter By Selection' buttons to the List of Accounts and List of
Payments forms. To use these, highlight the data you want to filter by, then
press the Filter button. Press the Remove Filter button to cancel the record
filtration. This filtration method operates independently from the options
selected on the 'Select' menu or in the Advanced selection dialog box.

Adjusted the left side of form letters to be 0.5 cm further to the right, to fit into
window envelopes better.

Added the ability to specify the first account number when entering the first
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account (previously the first account number had to start at 1001).

Added a function to restart the account numbers from a user-specified
number (Options > Provider page).

Adjusted the automatic backup function to save 2 copies of the data file, with
extensions bk1 and bk2. (For multi-user installations, automatic backups are
not very useful.)

Added some missing keyboard shortcuts to the Main Menu (Help, Select
Provider).

Removed the About Access Anaesthetics button off the Main Menu.

Streamlined the About box and added a Version option to easily get main
version details.

Updated the HealthBase phone number in relevant forms and removed
outdated price information from the order form.

Added a 'Register' button to the About box to easily find the registration
number.

Removed the registered user name from the registration form since not
required.

Shortened the time that the 'Fee Changed' message appears from 3 sec to
1.5 sec.

Adjusted the background colour of some controls to the correct grey shade in
XP.

Adjusted lines on report headers so that width is greater and background is
transparent. This allows the text on either side to stretch across the middle of
the page if required.

Changed cursor to a hand icon for the Main Menu and File Management
Menu.

15.1.15 Bug Fixes

Fixed a problem where the first reminder didn't print it's message.

If sending a reminder to a fund for a part paid account, and the co-payment
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had been paid, and was greater than the amount owing from the fund, then
the amount owing was listed as an adjustment and the balance was zero.
This has been corrected.

If payments run over to a second page of an account/receipt, one payment
could be split across the two pages with part on each page. This has been
corrected.

Added missing scroll bar to the paid CoPayment setup message in the
Options form.

Modified the lines on all printouts to avoid crooked lines on screen previews.

If the patient age is edited (to < 1 or >70) on an account which already has a
DVA fee, the age modifier may be added inappropriately to the DVA list. The
modifier is now added to the MBS page. Also, if any other modifiers are
manually added to the DVA list, they will appear instead on the MBS list.
(Modifiers are not recognised by the DVA.)

Fixed problem where the time and destination of a multi-user backup was not
stored.

Tried to fix an intermittent error 'PatientsT.HealthFundFee can't be a zero
length string'.

Fixed a bug where the act of viewing an account caused the record to be
modified and saved. This left the multi-user version prone to write conflict
errors when one user opened the same data file that another user was
editing. Also, this meant that the LastUpdated field was effectively a last
'viewed' field. Now it is more reliably a last updated field. The problem was
that the discount information was being reset (to the same values)
unnecessarily.

Fixed a bug (created a bailout actually) if AA is opened with an attachment to
a data file which has been renamed or deleted. This gives a message then
clears the attachment reference so that the program can open successfully
the next time. This avoids having to start again with a freshly downloaded
program file.

Modified the behaviour of the control key on the Notes page so that the
copy/paste keys (CTRL C/V) do not cause the cursor to jump back to the
start of the field.

Modified batch payment function to correct a situation where the amount
owing may not be automatically inserted when an account number is inserted
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(added Nz function in Amount_AfterUpdate event). Also removed SendKeys
function which may fail in A2003.

Corrected a problem where a password had to be entered twice when
opening AA.

Added indexing functions to the 'update to V3.4 process' to replace missing
indexes. Table indexes may be missing from multi-user files created in earlier
versions.

Added indexing functions to the new multi-user file creation process.

15.1.16 Access 2003 Issues

Microsoft implemented a new security policy in Access 2003 which caused
some issues on opening any database.

Modified a recordsource security issue in the Letters form which caused
errors with the Access 2003 Sandbox.

Adjusted menu bar widths for List of Accounts and Payments so they would
stay same size in A2003.

Checked the function of all aspects of the system for any A2003 Sandbox
issues (with sandbox setting on 3).

Removed the automatic column width adjustment in the Payment Summary
report (query) since it didn't work properly in Access 2003 (dialog box stayed
on screen and prevented report dialog disappearing). This may be a
SendKeys issue.

Removed the SendKeys function from the batch payments subform - appears
not to work in A2003.

15.2 Older Versions

15.2.1 Summary

· Version 3.34 - 2003 July 22
· Version 3.33 - 2003 Mar 9
· Version 3.32 - 2003 Feb 28
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For information on older versions see www.healthbase.com.au

15.2.2 Version 3.34 - 2003 July 22

In the multi-user version it was not possible to create or modify a user-defined
health fund. This was fixed.

Showed the item description in the Health Fund Fees form for reference
when editing fund fees.

15.2.3 Version 3.33 - 2003 Mar 9

Changed the SelectProvider form to be NOT modal, to avoid crashing
problem in Win XP if user clicked outside Access window while AA was
reattaching tables.

Removed reference to table MBS-RVGT in multi-user data file splitting
procedure, to avoid object not found error during registration process.

Disabled table refreshing process during startup to try to reduce lengthy delay
in opening AA when used on a network.

15.2.4 Version 3.32 - 2003 Feb 28

Re-saved all reports with 6P printer as default so that printer setup would use
'First available tray' (ID7) as its paper source. This was to fix a problem where
accounts would print to the manual tray on multi-tray printers.
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